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Introduction
Thank you for purchasing the ASET analyzer server engineering terminal software.
The ASET analyzer server engineering terminal (hereafter called the “Engineering Terminal”) is 
software which is connected by a communication circuit via an analyzer server to a plurality of 
GC1000 analyzers and a personal computer, for the purpose of monitoring and maintaining the 
analyzers from the personal computer.
This manual describes the basic method of operating the Engineering Terminal.
For how to operate GC1000 Mark II and PCAS, refer to their corresponding user’s manuals.
Also refer to User’s Manual of GC8000 (IM 11B08A01-01E) or Password Manual (IM 11B03A03-
07E) when the user level is changed.

l Contents of this manual
The part of this manual immediately before Chapter 1 describes the method of installing the 
Engineering Terminal. Read Chapter 1 and subsequent chapters after you have installed the 
Engineering Terminal. The contents of each chapter are as follows.
l Chapter 1
 Describes an outline of the Engineering Terminal and also the basic operations for using the 

Engineering Terminal.
l Chapter 2
 Describes the method of operating the Ethernet LCD emulator.
l Chapter 3
 Describes the method of operating the Overview window.
l Chapter 4
 Describes the method of operating each window when GC8000 is connected to ASET.
l Chapter 5
 Describes the method of operating each window when the Engineering Terminal is 

connected to a GC1000 Mark II.
l Chapter 6
 Describes the method of operating each window when ASIU is connected to ASET.
l Chapter 7
 Describes the method of operating the alarm windows.
l Chapter 8
 Describes the method of installing the Engineering Terminal for ARCNET
l Appendix
 Gives an outline of the functions of the Engineering Terminal and also the message page. 

Refer to it when you do not know the meaning of a menu item or message.
l Applicable Readers

The description of the installation method assumes that the reader has a basic knowledge of 
hardware and software that is necessary for installing the Engineering Terminal. This also applies 
to Chapter 1 and subsequent chapters, and to Windows.

l Information Priority
The method of operating the Engineering Terminal and also the precautions for handling it 
are described in the help function (on-line manual) of the engineering terminal and also the 
README.TXT file which is registered at the time of installation, in addition to this manual.
The priority sequence of the sources of this information is as follows.

(1) README.TXT file
(2) Help function (on-line manual)
(3) Operation guide (this manual)
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Safety Precautions
• In order to protect the system controlled by the product and the product itself and ensure 

safe operation, observe the safety precautions described in this user’s manual. We assume 
no liability for safety if users fail to observe these instructions when operating the product.

• Modification of the product is strictly prohibited.

n Notes on Handling User’s Manuals
• Please hand over the user’s manuals to your end users so that they can keep the user’s 

manuals on hand for convenient reference.

• Please read the information thoroughly before using the product.

• The purpose of these user’s manuals is not to warrant that the product is well suited to any 
particular purpose but rather to describe the functional details of the product.

• No part of the user’s manuals may be transferred or reproduced without prior written 
consent from YOKOGAWA.

• YOKOGAWA reserves the right to make improvements in the user’s manuals and product at 
any time, without notice or obligation.

• If you have any questions, or you find mistakes or omissions in the user’s manuals, please 
contact our sales representative or your local distributor.

n Warning and Disclaimer
The product is provided on an “as is” basis. YOKOGAWA shall have neither liability nor 
responsibility to any person or entity with respect to any direct or indirect loss or damage arising 
from using the product or any defect of the product that YOKOGAWA can not predict in advance.

n Notes on Software
• YOKOGAWA makes no warranties, either expressed or implied, with respect to the 

software’s merchantability or suitability for any particular purpose, except as specified in the 
terms of warranty.

• This product may be used on a machine only. If you need to use the product on another 
machine, you must purchase another product.

• It is strictly prohibited to reproduce the product except for the purpose of backup.

• Store the CD-ROM (the original medium) in a safe place.

• It is strictly prohibited to perform any reverse-engineering operation, such as reverse 
compilation or reverse assembling on the product.

• No part of the product may be transferred, converted or sublet for use by any third party, 
without prior written consent from YOKOGAWA.
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Documentation Conventions

n Symbol Marks
Throughout this user’s manual, you will find several different types of symbols are used to identify 
different sections of text. This section describes these icons.

 CAUTION
 Identifies important information required to understand operations or functions.

 TIP
 Identifies additional information.

 SEE ALSO
 Identifies a source to be referred to.

HELP !

Indicates text describing the action to be taken when a message or indication is displayed 
during an operation.

n Keyboard Inscriptions
Keyboard operations are indicated in this manual as shown in the following example.

(Inscription example)

 [Shift] + [F1]

(Meaning)

 Indicates that the operator must press the [F1] key while pressing the [Shift] key.

n Menu Inscriptions
Menu operations are indicated in this manual as shown in the following example.

(Inscription example)

 Click on [Connect] in the [System] menu.

(Meaning)

 Click on the [System] menu, then click on the [Connect] command.

n Drawing Conventions
Some drawings may be partially emphasized, simplified, or omitted, for the convenience of 
description.
Some screen images depicted in the user’s manual may have different display positions or 
character types (e.g., the upper / lower case). Also note that some of the images contained in this 
user’s manual are display examples.
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Copyright and Trademark Notices

n All Rights Reserved
The copyrights of the programs and on-line manual contained in the CD-ROM are reserved.
The on-line manual is protected by the PDF security from modification, however, it can be output 
via a printer. Printing out the on-line manual is only allowed for the purpose of using the product. 
When using the printed information of the on-line manual, check if the version is the most recent 
one by referring to the CD-ROM’s version.
No part of the on-line manual may be transferred, sold, distributed (including delivery via a 
commercial PC network or the like), or registered or recorded on video tapes.

n Trademark Acknowledgments
• IBM is a registered trademark of International Business Machines Corporation.

• Microsoft and Windows are either registered trademarks or trademarks of Microsoft 
Corporation in the United States and/or other countries.

• Ethernet is a registered trademark of XEROX Corporation.

• All other company and product names mentioned in this user’s manual are trademarks or 
registered trademarks of their respective companies.

• We do not use TM or ® mark to indicate those trademarks or registered trademarks in this 
user’s manual.
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Installing the Engineering Terminal
This chapter describes the installation of the Engineering Terminal (ASET) in the personal 
computer system being used. Please read the chapter 8, when you use the PCAS for ARC-
NET (/ARC).

This installation assumes that your PC system is already in the ready state under the fol-
lowing conditions and also that you have some knowledge of how to use the system.

n	 System	Configuration
l Software conditions

Model Name Basic Code Option Code Specification
ASET •••••••••••••••••••• ••••••••••••••••• Analyzing Server Engineering Terminal Software
Function -A01

-S01
•••••••••••••••••
•••••••••••••••••

Standard
Signal analyzer mode

Language E
J

•••••••••••••••••
•••••••••••••••••

English
Japanese

— -N ••••••••••••••••• Always -N
— N ••••••••••••••••• Always N

Option /ARC
/UP

ARCNET supported version (Intended for GC1000 Mark II)
Version up

l Hardware conditions
Before installing ASET, check that the hardware meets the following conditions:

• OS:  Microsoft Windows 7 SP1 (32-bit version/64-bit version, /ARC is only supported 32-bit 
version), Windows Server 2008 SP2 (32-bit version only) 
English, Japanese, or Chinese (In case option /ARC is selected, Chinese is not available)

• CPU: 1 GHz or higher
• Memory: 32-bit - 1 GB or more, 64-bit - 2 GB or more
• Hard disk: At least 20 GB
• Display: SVGA (1024 x 768)
• Ethernet port: 1 (100BaseTX or 100BaseFX)
• Others: CD-ROM drive
• For the hard disk, a data storage capacity should be secured separately according to your 

PC system format, in addition to the capacity for the program.
• Communications function: Analyzers and analyzer server(s) must be connected via 

Ethernet communication. The analyzer server and your PC must also be connected via 
Ethernet communication.

F0101.ai

DCS DCS

DI/O

RS-232C

LAN (Ethernet)

PCPC STARDOM FCJ

STARDOM FCN

GC8000
Process Gas Chromatograph

Analyzer Server

Interface unit

Engineering Terminal Text in parentheses is a function.

GC8000 GC1000 MarkII

Gateway unit
[Exchange Data with 
Host System]

[Operation and display 
of Gas Chromatograph]

[Network monitoring, 
Automatic data 
storage]

[Analog Output from Field Equipment/
Interface to Contact In/Out Signals]
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n In case MacAfee is used.
In case MacAfee Virus Scan Enterprise is used. Please change the setting of McAfee, during 
install.
Start VirusScan of McAfee, select “Access Protection” to “Invalid”, by “stop” of “task” menu.
Install is completed, “Access protection” should be “Valid” as change back to original selection.

n Installing “Microsoft Visual C++ 2008SP1 Redistributable Package”
Install the “Microsoft Visual C++ 2008SP1 Redistributable Package” Before installing ASET.
The installer will be automatically shown up if in case this software package is needed. Please 
install it by following the steps on the screen.

n Installation Procedure of ASET
In the case of single analyzer mode (ASET-S01), please install ASET-S.

CAUTION
The user should log on with an administrator account in order to install and use ASET. Proper 
operation is not guaranteed when the user logs on with a limited user account.

l Installing ASET on Computers Running Windows 7
(1) Prepare a personal computer which fills the specification and turn on the power.
 Start Windows.
(2) Insert the installation disk into the CD-ROM drive.
(3) The install program is started automatically.
 The following dialog box appears. Click [Run Setup.exe].
 If it is not started automatically, run “setup.exe” file by double-clicking. The file is located 

under Disk1 directory.

9th Edition : Nov. 04, 2014-00
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(4) The “Welcome to the InstallShield Wizard for AS Engineering Terminal” dialog appears. 

Click [Next].

 
(5) Hereafter, install according to the displayed instruction.

CAUTION
Might be necessary to restart the personal computer at the end of installation.

n Installation Procedure of ASET-S

CAUTION
The user should log on with an administrator account in order to install and use ASET-S. Proper 
operation is not guaranteed when the user logs on with a limited user account.

l Installing ASET-S on Computers Running Windows 7
(1) Prepare a personal computer which fills the specification and turn on the power.
 Start Windows.
(2) Insert the installation disk into the CD-ROM drive.
(3) The install program is started automatically. The following dialog box appears.

9th Edition : Nov. 04, 2014-00
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 The installed requirements are not displayed anymore. Click [Install].

 
(4) The FileZilla Server beta 0.9.41 installation starts automatically after the Microsoft Visual 

C++2008 SP1 Redistributable Package(x86) installation ends.
 When the License Agreement dialog box of the FileZilla Server beta 0.9.41 setup appears, 

read the terms and click the “I Agree” button if you agree with the terms.

 
(5) If you agreed with the terms in Step (4), the Choose Components dialog box appears. 

By default, Standard is selected for the combo box and checkmarks are added to the 
FileZilla Server (Service), Administration interface, Start Menu Shortcuts and Desktop Icon 
checkboxes. PCAS will run normally if you leave the settings unchanged.

 Procedures described later in this user’s manual assume that these settings were left 
unchanged. Therefore, leave them unchanged and then click the Next button.

9th Edition : Nov. 04, 2014-00
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(6) The Choose Install Location dialog box appears. Directly enter the path in the input box 

of Destination Folder or click the Browse button and specify the installation location in the 
Choose Folder dialog box that appears.

 After you specify an installation location in Destination Folder, click the Next button.

 
(7) The Startup settings dialog box appears next. This dialog box is for configuring the FileZilla 

Server startup settings.
 The default settings for the combo boxes and input box are “Install as service, started 

with Windows (default),” and “14147.” These settings should be left set to their defaults 
and procedures described later in this user’s manual assume that these settings were left 
unchanged. Therefore, leave them unchanged.

 Furthermore, checkbox “Start Server after setup completes” have a checkmark added by 
default. This checkbox set whether to start FileZilla server after the installation is complete. 
Remove these checkmarks and then click the Install button because WinPcap will be 
installed after the FileZilla installation ends.
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(8) Next, “Startup setting” logout in shown. Combo box specify “Start user logs on, apply to all 

users (default)” as default setting. Please leave it. Procedures described later in this manual 
assume that the setting were left unchanged. Check column is selected as default. This 
means the selection of start after installation. Please release this check so that ASET install 
is continued after FileZilla installation is over.

 
(9) The installation screen appears and then the Installation Complete dialog box appears 

automatically after the installation completes. Click the Close button.
 The WinPcap installation starts automatically after the FileZilla Server beta 0.9.41 

installation ends. Hereafter, install according to the displayed instruction.

CAUTION
Might be necessary to restart the personal computer at the end of installation.
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(10) The ASET installation starts automatically after the WinPcap installation ends. Hereafter, 

install according to the displayed instruction.

 

n Changing User Account Control settings
UAC helps prevent unauthorized programs from being installed on the system silently by viruses 
or malicious software. This feature is normally preferable, but in some cases, it may interfere with 
system operation and settings, e.g., UAC may block installation of some applications.

UAC can be disabled at the user’s discretion. Yokogawa is not responsible for any problems that 
may result from disabling UAC.

The UAC setting is enabled by default. To disable the setting, you must log on using an 
administrator account. All the following steps should be done as an administrator account.

9th Edition : Nov. 04, 2014-00



  <Installing the Engineering Terminal> 8

IM 11B06C01-01E

(1) Open the Control Panel and then User Accounts.

 Click [Change User Account Control settings]. The [Change User Account Control settings] 
dialog appears.

(2) In the [Choose when to be notified about changes to your computer], side to “Never notify”, 
and then click [OK].

 
Changing UAC setting is now complete.
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n Installing ASET on Computers Running OSs Other Than Windows 7
(1) Prepare a personal computer which fills the specification and turn on the power.
 Start Windows.
(2) Insert the installation disk into the CD-ROM drive.
(3) The install program is started automatically.
 The steps after this are the same as those for installing on computers running Windows 7 

OS.

CAUTION
Might be necessary to restart the personal computer at the end of installation.

n	 PC	Configuration	for	Power	Management
It is recommended that the following items be set and confirmed after installation of ASET.

CAUTION
ASET may not function properly while the sleep, standby and hibernation settings are enabled. 
The settings above can be disabled in Windows. The setting procedure is as follows.

l for Windows 7
Log on as a user with administrator privileges, click the Start menu, select Control Panel, 
Hardware and Sound, double-click Power Options to display the Power Options Properties dialog 
box, and then make sure the following items are set as described below. Note that some of the 
items described below may not be displayed depending on the configuration of the PC. If an item 
is not displayed, the function is disabled.
•	 Choose	what	the	power	button	does.
 When I press the power button: Do nothing
 When I press the sleep button: Do nothing
 When I close the lid: Do nothing
•	 Choose	what	to	turn	off	the	display
 Turn off the display: Never

l for Windows Server 2008
Log on as a user with administrator privileges, click the Start menu, select Control Panel, double-
click Power Options to display the Power Options Properties dialog box, and then make sure the 
following items are set as described below. Note that some of the items described below may not 
be displayed depending on the configuration of the PC. If an item is not displayed, the function is 
disabled.
•	 System	Settings	window
 When I press the power button: Do nothing
 When I press the sleep button: Do nothing
 When I close the lid: Do nothing
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•	 Edit	Plan	Settings	window
 Put the computer to sleep: Never

n	 Communication	which	is	passing	though	the	fire	wall.
TCP port 34341 and 34342 in ASET and 34349 in EtherLCD are assigned. In this case special 
permit is required.
Please contact with authorized person for users Net work system.

n How to capture the screen.
(1) Press the Print Screen key on your keyboard to copy the bitmap on the clipboard. It may be 

labeled [PrtScn].
 When you want to capture an active window, press and hold down the “Alt” key, and press 

the “Print Screen” key on your keyboard to copy the bitmap on the clipboard.
(2) Open an image editing programme, such as Microsoft Paint.
 Start the Paint accessory (Start -> Program -> Accessories -> Paint).
(3) Select [PASTE] from the [Edit] menu.

n Changes in the Windows Environment
When you install ASET, the Windows environment will change as follows:

l “AS Engineering Terminal” group
When you install ASET, the “AS Engineering Terminal” group is newly registered. Five short-cut 
icons, namely “ASET”, “ASETAna”, “Chromatogram”, “EtherLCD” and “ReadMe” are registered 
in the “AS Engineering Terminal” group.
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l	 ASETCFG.INI	file	and	ASET.INI	file
When you install ASET, the initialization files “ASETCFG.INI” and “ASET.INI” are created in the 
directory located in the Windows execution files. However, in cases where ASETCFG.INI and 
ASET.INI already exist, such as when you are re-installing ASET, if you reply “No” to the question 
“Do you wish to copy the initialization files?” the current files will be saved.

TIP
About initialization files

• Do not directly edit an initialization file using a text editor, etc. unless Yokogawa specifically instructs you to 
do so. Otherwise, normal operation cannot be assured.

• If an initialization file has been directly edited according to Yokogawa's instructions, restart the application. 
The modified information will be only enables after restarting.
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1. Overview of the Engineering Terminal
This chapter gives an overview of the Engineering Terminal, as well as the basic facts that 
you need to know before operating the Engineering Terminal.

1.1 Engineering Terminal
Before operating the Engineering Terminal, take a look at what kind of software the Engineering 
Terminal contains.

n Engineering Terminal
The ASET Engineering Terminal is software that is intended for collectively maintaining and 
monitoring analyzers from a personal computer. It links an analyzer server connected to multiple 
units of GC1000 Mark II and ASIU’s (hereafter called “analyzers”) to a personal computer via a 
communication link (Ethernet). Moreover, ASET can also be run on a PC serving as the analyzer 
server.

An overview of the Engineering Terminal follows.

F1-1-1.ai
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[Field]
Analyzer

GC1000 markII
Analyzer
GC8000

[Instrument room/office]

Engineering Terminal

Hub

Maintenance and monitoring of analyzers

Disk Printer

• Saving and reading of 
chromatogram and the 
results of analysis

• Reading and writing of 
setting parameters

• Printing the 
chromatogram and 
results of analysis

n Engineering Terminal Features
The Engineering Terminal has the following features:

l Collective control of up to 64 analyzers
You can control up to 64 analyzers collectively from a single ASET via an analyzer server.
Moreover, up to 240 analyzers can be connected to the analyzer bus. By using multiple ASETs to 
control the analyzers in blocks, you can control all 240 analyzers.

l Continuous monitoring for extended periods
The analyzer server continuously saves data (chromatograms, analyzed values, and setting 
parameters) from the analyzers connected via the network. The ASET can call up continuous 
data stored in the analyzer server and display it, enabling you to perform continuous monitoring 
over extended periods.

l Data transfer using Ethernet communication
Using Ethernet, the large volumes of data stored in the analyzer server can be uploaded and 
downloaded, for each analyzer at a time, at the rate of 100 Mbps. ASET uses the standard file 
transfer protocol FTP, thus significantly improving the reliability of data transfer.
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l Remote operation of the LCD window
The analyzer’s LCD window is displayed as is on the PC monitor, enabling you to operate the 
LCD window for each analyzer from a remote location from the site.

l Analyzer Operation window allowing the operation status to be seen at a glance
The analyzer’s current operation mode, the operation status of the valves, detectors, etc. and a 
chromatogram are displayed in a single window (Analyzer Operation window); operation status 
can be checked at a glance. Moreover, you can change the operation mode, open and close 
valves, display a detailed chromatogram, and so on by simply clicking on the window.

l Displaying a detailed chromatogram and saving data
An overview of a chromatogram can be displayed in the Analyzer Operation window. In addition, 
you can display a detailed chromatogram in the Chromatogram Display window. Using this 
window, you can partially enlarge a chromatogram, change the scale, or save chromatogram 
data.

l Storing analysis data and creating graphs
The results of analysis using an analyzer are stored in the analyzer server. The analyzer server 
can store the peak names for up to 255 events and the analysis time for up to 250 events for 
each analyzer. Analysis data stored in the analyzer server can be read out and displayed on 
a graph at any time, and data can also be saved to a file and then opened in general-purpose 
software such as Excel for more sophisticated data processing.

n Single Analyzer Mode (ASET-S01)
Compared with the standard engineering terminal (ASET-A01), the following limitations exist.

• Only a single analyzer can be controlled at any given time.

• PC Analyzer Server Software (PCAS) is not required. 
Data is stored in the PC in which ASET-S01 is installed.

• In a system where PCAS is used to control redundant analyzers, ASET-S01 cannot be 
used. Use ASET-A01 (standard).

1.2 Engineering Terminal Group
Take a look at the types of software comprising the Engineering Terminal Group and the windows 
making up the Engineering Terminal.

n	 Software	Configuration
The Engineering Terminal consists of the following three types of software:

Software Type Function
Engineering Terminal
(ASET)

This is the main core of the Engineering Terminal.
It develops various windows based on the Overview window that displays 
the operation status of multiple analyzers, as well as the analysis results.

Analysis Results
window (ASETAna)

This window stores analysis results. It can be started independently if you 
wish to process analysis results saved in a file.

Ethernet LCD Emulator 
(EtherLCD)

This software runs independently of the Engineering Terminal. It can 
emulate an analyzer LCD panel (i.e. operate in the same way as on the 
analyzer), allowing you to operate the analyzer panel from the PC.
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n	 Engineering	Terminal	Window	Configuration
The Engineering Terminal consists of the following windows:

Window Type Function
Overview window This window is provided to monitor the status of each analyzer connected to 

PCAS. It appears when ASET starts.
Analyzer Overview 
window

The Analyzer Overview window displays the measurement status of each 
GC module (hereafter referred to as GCM) in GC8000. Select the GCM you 
want to view the details in this window.
From this window, open your desired subwindow (Analyzer Configuration, 
Analyzer Operation, Chromatogram, Analysis Results, or Alarm windows).

Analyzer Operation 
window

The Analyzer Operation window is provided to operate or monitor the 
operation status of an analyzer.
Switch the window for each GCM.

Chromatogram window The Chromatogram window is provided to monitor the current 
chromatogram or to display chromatograms stored in an analyzer 
server (hereafter referred to as PCAS). It is also used to reanalyze 
chromatograms.

Analysis Results 
windows

Displays the latest analysis results, concentration analysis history, retention 
time history or calibration coefficient history. Switch the window for each 
GCM or system (hereafter referred to as SYS).

Alarm windows Displays alarm status and history of an analyzer.
Switch the window for all analyzers or each GCM.

Analyzer Configuration 
window

The Analyzer Configuration window is provided to display the definitions 
of GCMs or SYSs in GC8000 or equipment configuration, such as oven, 
detectors, and valves.

n Precautions for Using the LCD Emulator and Engineering Terminal
Observe the following precautions when using the LCD Emulator or Engineering Terminal.

l Analyzer data is controlled by the analyzer server.
It is essential that the Analyzer Server (PCAS) software is running normally. For PCAS, refer to 
the PCAS User’s Manual (IM 11B06B01-01E).

l Use the LCD Emulator or Engineering Terminal with an analyzer unit in remote 
mode.
If the analyzer unit is not in remote mode, the command from LCD Emulator is not accepted. You 
can use the Engineering Terminal’s display function even when the analyzer is in Local mode, 
but if you attempt to perform operation, a message appears indicating the operation was not 
accepted.

l The LCD Emulator and Engineering Terminal can be run at the same time.
Settings can be changed using the LCD Emulator while observing the operation status of 
analyzers on the Engineering Terminal.
However, there are some items that disable setting changes depending on the operation status, 
or that cause changes to be reflected in measurement at different timing.
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2. Ethernet LCD Emulator Window
The Ethernet LCD Emulator is software that reproduces an analyzer LCD panel in Windows.
It directly simulates the window and buttons of an LCD panel in the field in a Windows’ window, 
providing both display and operations virtually identical to those of the LCD panel in the field. 
With the LCD Emulator, you can connect to all analyzers that are connected via the network.
This chapter gives an overview of the LCD Emulator window.
For more information, refer to User’s Manual of GC8000 (IM 11B08A01-01E) or GC1000 Mark II 
LCD Panel Operation Manual (IM 11B03A03-05E).

l Before Using the Ethernet LCD Emulator
Before starting the LCD Emulator, always check the following:

• Engineering Terminal is installed in the personal computer that is being used

• Analyzers and your PC are connected via the analyzer server

• Analyzer units are in Remote mode

2.1 Starting LCD Emulator, Changing Analyzer, 
and Exiting LCD Emulator

This section describes operations for starting an LCD Emulator, changing an analyzer, and 
exiting the LCD Emulator.

n Starting
The Ethernet LCD Emulator can be started while ASET or GCET is running. However, it cannot 
be started while ASMT, GCMT, ASLCD, or LCD is running.
A single analyzer can communicate with only one PC at a time using Ethernet LCD Emulator. If 
a specified analyzer is communicating with another PC, a message appears informing you that 
communication cannot be connected.
Note that the Ethernet LCD Emulator cannot be connected to ASIU.
You can start up to four Ethernet LCD Emulators simultaneously with a single PC. If you attempt 
to start a 5th Ethernet LCD Emulator, a message box appears informing you that more Ethernet 
LCD Emulators cannot be started.

l Operation procedure
(1) An Ethernet LCD Emulator can be started by clicking Windows’ Start button, selecting All 

Programs, and clicking on the EtherLCD item in the AS Engineering Terminal group. Or if an

  EtherLCD short-cut icon  
 is provided in the window, you can double click it instead.
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(2) If the number of analyzers registered is zero or two or more, the Select Analyzer dialog box 
appears. Select the analyzer you wish to connect.

 If the number of registered analyzers is one, the Ethernet LCD Emulator starts 
communication with that analyzer directly, without displaying the Select Analyzer dialog box.

 F0201.ai

(3) Choose the analyzer ID of the analyzer you wish to connect to from the list displayed.
(4) Click the Run button.
 The cursor changes to a sandglass icon and the Ethernet LCD Emulator waits for the result 

of the communication connection.
 When the communication connection becomes established, the Ethernet LCD Emulator’s 

CONNECT indicator is displayed in green, informing you that it has been connected to the 
analyzer concerned. After a while, the Initialize window (status window) of the analyzer 
appears. The selected analyzer ID will be indicated at the right of the caption in the form of 
“#XXX.”

 If communication connection fails to be established, a message box to that effect appears. 
The CONNECT indicator on the window remains blacked out.

 F0202.ai

HELP !
• If the message “Connection failed” is displayed, it is possibly due to one of the following seven causes:

(1) Wiring to the analyzer is incorrect.
 Countermeasure: Check the wiring between the analyzer and the analyzer server, and between the 

analyzer server and the PC.
(2) The Ethernet card is not functioning properly.
 Countermeasure: Confirm that the Ethernet card operates normally.
(3) No TCP/IP has been installed in the OS.
 Countermeasure: Install TCP/IP to the OS.
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(4) The analyzer server IP address is illegal.
 Countermeasure: Click on the Select Server command in the Connect menu to open the Select Server 

dialog box and re-enter the correct IP address.
(5) You have chosen the analyzer ID of an analyzer not connected to the analyzer server.
 Countermeasure: Choose the correct analyzer ID.
(6) The selected analyzer is in Local mode.
 Countermeasure: Change the mode of the analyzer unit’s LCD panel to Remote and try to make the 

communication connection again.
(7) Communication connection with the analyzer cannot be achieved temporarily due to causes such as 

noise.
 Countermeasure: Execute the Connect command from the Connect menu again.

(5) Click the OK button.
 The LCD Emulator window appears.

F0203.ai

HELP !
If the analyzer unit’s LCD panel is being operated while the LCD Emulator is being used, a message stating “Exit 
command has been received” appears and communication with the analyzer will be disconnected.

To reactivate the LCD Emulator window in this case, wait for panel operation of the analyzer unit to be finished, 
then re-execute the communication connection.
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n Changing Analyzers

l Operation procedure
(1) Click on the Select Analyzer command in the Connect menu.
 The dialog box for selecting the analyzer ID of a new analyzer to be connected appears.

 F0204.ai

(2) Choose the analyzer ID of the analyzer you wish to connect to from the list.
(3) Click the Run button.
 This connects communication with the selected analyzer.

n Editing the List of Analyzer IDs
The method of editing information in the List of Analyzer IDs in the Analyzer select dialog box is 
as follows:

l Registration
(1) Enter the analyzer ID, tag name (if necessary), and IP address into the respective fields.
 The available analyzer IDs are from 1 to 240.
(2) Click the Register button. The entered information is added to the List of Analyzer IDs.

l Editing
(1) Select the analyzer ID to be edited from the List of Analyzer IDs.
(2) Change the information in the Analyzer select dialog box.
(3) Click the Register button.

l Deletion
(1) Select the analyzer ID of the analyzers to be deleted from the analyzer list.
(2) Click the Delete button. This causes the selected analyzer ID to be deleted from the List of 

Analyzer IDs.
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n Exiting the LCD Emulator
l Operation procedure

(1) Click on the Exit command in the Connect menu.
 The dialog box asking if you wish to exit the LCD Emulator appears.

 F0205.ai

(2) Click the Yes button.
 This disconnects communication with the analyzer, exiting the LCD Emulator.

n Limitation on the Number of Users to be Connected Simultaneously
The analyzer cannot communicate with multiple LCD Emulators at the same time. If a user 
attempts to make a communication connection with a particular analyzer using an LCD Emulator 
while another user is already communicating with that analyzer using an LCD Emulator, the 
second connection cannot be established. In this case, a message box appears indicating the IP 
address of the currently connected PC.

F0207.ai

n Forced Connection
Forced connection is a connection means to establish a communication connection even if the 
analyzer concerned is communicating by Ethernet with the Ethernet LCD Emulator on another 
PC.
For example, assume that PC1 with the IP address XXX.XXX.XXX.100 has started an Ethernet 
LCD Emulator and has been communicating with an analyzer. In this case, if PC2 with the IP 
address XXX.XXX.XXX.101 starts an Ethernet LCD Emulator to make a forced connection 
with that analyzer, connection with PC1 is terminated and a dialog box stating “Communication 
is disconnected due to forced connection from XXX.XXX.XXX.101” appears on PC1. Then 
communication between PC2 and the analyzer concerned will be started. (Last priority)
Moreover, if another PC has started an LCD Emulator to make a serial connection and is 
conducting serial communication with an analyzer unit’s LCD, forced connection is still possible. 
(In this case, proceeding with serial communication will be interrupted.)

F0208.ai
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l Operation procedure
(1) Click on the Forced Connect command in the Connect menu.
 The dialog box for typing a password appears.
 About the password refer to User’s Manual of GC8000 (IM 11B08A01-01E) or Password 

Manual (IM 11B03A03-07E).
(2) Enter the password and click the Run button.
 When a user level C password is entered, in case  the number of analyzers registered is 0 

or 2 or more, the dialog box of Analyzer selection (Forced connect) appears.
 Here, select the analyzer to be forced-connected.
 When the number of analyzers registered is 0, the analyzer is added.
 When the number of analyzers registered is 1, the confirmation message (to be forced-

connected) comes up.

 F0210.ai

(3) When the analyzer requested the force connection is under the connection with the other 
Ethernet LCD emulator, the dialog box of the force connection appears. Confirming the IP 
address which is now connecting, enter a user level C password again, then click Force 
connect button. 

 F0211.ai

CAUTION
If another user performs forced connection during this establishment of forced connection, the 
original attempt at forced connection communication will be disconnected.
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2.2 Basic Operation
The LCD Emulator window is identical to the LCD panel for both display and operations. Buttons 
on the window can be operated using a mouse, and keyboard-based one-touch operation is also 
possible.

n	 Window	Configuration
The following shows an LCD Emulator window configuration.

l GC8000

AI Status
AO Status
DI Status
DO Status
Remote AO Status
Remote DO Status
Revision number
Ethernet Status
Alarm Status

Status Menu     (1/2)

l GC1000 MarkII

F0209.ai

Setting
entry keys

Function keys Window changing keys

LED indicator sectionLCD display
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n Window Operation
The Ethernet LCD Emulator can realize all the display and operation features of an analyzer’s 
LCD panel with the exception of the following:
 ALARM indicators
 DISPLAY RESET key

l Mouse operation
Move the mouse cursor over the key you wish to operate and then click the mouse’s left button. 
This activates the keys to be operated in the same way as those on the LCD panel.

l Keyboard operation
Keys on each panel correspond to the keys on the keyboard as follows:
Pressing any of these keys facilitates key operation in the same way as those on the LCD panel.

Panel display and keys on the keyboard

T0201.ai

Window Display Keys on Keyboard

[F1] to [F6]

GC1000 MarkII
[STATUS]
[RESULT]
[ALARM]
[TEMP]

[CHROM]

[OPERATION]
[TABLE]

Alphanumeric keys
[      ]    [      ]
[CANCEL]

[SET/ENT]
[               ]

[      ]    [      ]
[               ]

[PREV]
[NEXT]

[F1] to [F6]

[SHIFT] + [F1]
[SHIFT] + [F2]
[SHIFT] + [F3]
[SHIFT] + [F4]
[SHIFT] + [F5]

[SHIFT] + [F6]

[SHIFT] + [F7]
[SHIFT] + [F8]

Alphanumeric keys
[Page Down]    [Page Up]

[ESC]

[ENTER]

Cursor movement keys

[CTRL] + [P]
[CTRL] + [N]

BACK 
 SPACE

BACK 
 SPACE

LOCAL/
REMOTE

GC8000
[Status]

[Password]
[Operation]

[TEMP]

[SHIFT] + [F1]
[SHIFT] + [F6]
[SHIFT] + [F7]
[SHIFT] + [F8]

Window 
changing 
keys

Function 
keys

Setting 
entry keys
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3. Overview Window
The Overview window facilitates status display and the operation of two types of analyzers: 
GC1000 Mark II and ASIU. There are slight differences in window display and the available 
commands according to the analyzer type.
This chapter describes those areas both analyzer types have in common, such as how to start/
exit the Overview window, setting window displays, and reading and writing parameters.
For individual information pertaining to each analyzer type, see Chapter 4 for GC8000, Chapter 5 
for GC1000 Mark II and Chapter 6 for ASIU.

The following shows the relationship between the windows:

F0301.ai
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Analyzer 
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Analyzer 
Operation 
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Chromatogram 
window

Analysis Results 
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 not have “overview window” )

(Only for GC8000)

GC8000

GC1000 MarkII

GC8000

GC1000 MarkII

GC8000

GC1000 MarkII

GC8000
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ASIU

GC8000

ASIU
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l Before Using ASET
Before starting the Engineering Terminal, always check the following items:

• Engineering Terminal is installed in the personal computer that is being used

• Analyzers and your personal computer must be connected via an analyzer server
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3.1 Starting and Exiting the Engineering 
Terminal

This section describes how to start and exit the Engineering Terminal.

n Starting
The Engineering Terminal can operate just one window.

l Operation procedure
(1) Turn ON the personal computer’s power supply, start Windows, and display the Engineering 

Terminal Group window on the Desktop.

 F0302.ai

Engineering Terminal icon

(2) Double click on the Engineering Terminal icon.
 This establishes communication connection with the analyzer server, causing the Overview 

window to appear.

HELP !
If the Engineering Terminal fails to establish communication connection with the analyzer server, the message 
“Connection failed” appears. For possible causes of this and steps to be taken, see HELP in section 2.1, “Starting 
LCD Emulator, Changing Analyzer, and Exiting LCD Emulator.”
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 The Overview window is the base window for the Engineering Terminal. To use any function 
of the Engineering Terminal, this window must be started. It can be minimized to an icon 
using the Minimize button.

n Exiting
l Operation procedure

(1) With the Overview window displayed, click on the Exit command in the System menu.
 The dialog box asking whether you want to exit ASET appears.

 F0304.ai

(2) Click the Yes button.
 This disconnects communication with the analyzer server, exiting the Engineering Terminal.

TIP
How to use the Disconnect command

• If you wish to disconnect communication with an analyzer server without exiting the Engineering Terminal, 
use the Disconnect command in the System menu.

• For example, this feature is useful in using other software. Note that in this case, no measured values are 
sent from the analyzer.
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n Changing Analyzer Server
If multiple analyzer servers are connected to the network, the Engineering Terminal allows you to 
choose the analyzer server to be connected to.
The method of choosing an analyzer server and operation of the dialog box for selecting the 
analyzer server are the same as those for an LDC Emulator. See “Changing Analyzer Server” in 
section 2.1, “Starting LCD Emulator, Changing Analyzer, and Exiting LCD Emulator.”

n Limitation on the Number of Users to be Connected Simultaneously
An analyzer server can communicate with multiple Engineering Terminals up to 4 sets at the 
same time.
If a user attempts to make communication connection with an analyzer server using Engineering 
Terminal while other 4 users are communicating with that analyzer server using Engineering 
Terminal, this connection cannot be established. In this case, a message box appears indicating 
the currently connected PC’s IP address.

F0305.ai

n Forced Connection
Forced connection is a connection means to establish a communication connection even if the 
analyzer server to which you wish to connect is connected to four ASETs.
If the analyzer server you wish to connect to is connected to less than four ASETs, forced 
connection starts without interruption.
If you attempt to execute a new forced connection to an analyzer server that is already connected 
to four ASETs, the forced connection dialog box appears. In this dialog box, you can choose a 
connection to force to be disconnected, then click the Forced Connect button. This allows your 
forced connection to be made and established (last priority).
Note that forced connection requires password entry. Please refer to User’s Manual of GC8000 
(IM 11B08A01-01E) or Password Manual (IM 11B03A03-07E). When forced connection is 
executed, the following message box appears.

F0306.ai

l Operation procedure
(1) Click the Force Connect button on Connect menu, then a dialog box for typing the password 

appears.
(2) Entry the password and click Execute button.
 When a user level C password is entered, force connection takes place.
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 F0306-2.ai

CAUTION
If another user performs forced connection while forced connection is being made, the original 
attempt at forced connection communication will be disconnected.

3.2	 Configuration	of	the	Overview	Window
The Overview window is the base for the Engineering Terminal.
It collectively displays the operation statuses and latest analysis results of multiple analyzers. It 
also allows you to select the operation mode, etc.
It updates analyzer information every 1 second.

n Element Names
The following shows the names of the elements of the Overview window.

F0307.ai

Toolbar

Menu bar

Analyzer
Status
window

Title bar
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n Title Bar
The title bar indicates the window name.

n Toolbar
The toolbar consists of buttons that operate frequently used commands and text boxes that show 
the condition of the Engineering Terminal functions.

l	 Toolbar	configuration
Window Display buttons
 Analyzer Operation window
 Analysis Results window
 Chromatogram window
 Alarm window
 ASIU Operation window
 Analyzer Overview window

Change Analyzer ID button

Select Page tub Set Page button

Help button

Connection Status indicator

Analyzer ID display

User Level display

Change User Level button F0308.ai

l Functions and display of elements
The following shows the functions and display information of the elements.

Buttons/Display Function and Display Information

Change User Level 
button

Used to change the user level.

Window Display button Displays the relevant window.
Change Analyzer ID 
button

Used to change an analyzer ID.

Select Page button Selects the page to be displayed in the Analyzer Status window.
Set Page button Allows you to set an analyzer to be displayed in each page of the Analyzer 

Status window.
Help button Displays a Help window.
PCAS Alarm display Displays the alarm status of PCAS.

• Green: No alarm
• Yellow: Level-2 alarm has occurred.
• Red: Level-1 alarm has occurred.

Analyzer ID/Tag display Displays the ID and tag numbers of the analyzer selected as the object for 
operations. If no analyzer has been selected, the field is blank.

User Level display Displays the currently set user level.
Page Number display Displays the page number of the currently displayed Analyzer Status 

window.

n Analyzer Status Window
This is the main section of the Overview window, displaying the statuses of individual analyzers. 
It consists of eight pages, and a single page can display the statuses of up to 16 analyzers. 
Which analyzers to display can be freely set in each page. The data is up dated each 1 second 
automatically.
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l	 Configuration
The display of the Analyzer Status window differs depending on the analyzer type. See Chapter 4 
for GC8000. See Chapter 5 for GC1000 Mark II. See Chapter 6 for ASIU.

For GC8000

   

Analyzer ID/Tag name

Alarm Status Elapsed time bar graph Elapsed time/Analysis cycle

Status

Operation Mode 

Measurement status

Select GCM combo box

F0309.ai

For GC1000 Mark II

 

Analyzer ID/Tag name

Measurement status

Alarm Status Elapsed time bar graphh Elapsed time/Analysis cycleycle

Status

Change Operation Mode button

Display Analysis Result button

F0310.ai

Operation Mode

For ASIUs

       

Analyzer ID/Tag name

Alarm Status

Contact Input Status

Contact Output Status

F0311.ai

3.3 Changing User Level
There are three user levels for analyzers. As the default, user level “A” which only permits 
confirmation of the operation window(s) is set.
If you wish to change the user level to one allowing operation control, enter a password to 
change to the desired user level.
Please refer to User’s Manual of GC8000 (IM 11B08A01-01E) or Password Manual (IM 
11B03A03-07E).
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n Types of User Levels
There are three kinds of user levels: A, B, C and C+.
As the level rises from A to B to C to C+, the range of operations available for operation windows 
broadens. To obtain user level “B”, “C” or “C+,” you need to enter a password.
Only checking the conditions can be achieved using user level A; however, the following 
operations require user level “B”, “C” or “C+.”

Window Item User Level
GC8000 Overview window Forced Connect C or C+

Language C or C+
Alarm Popup C or C+

Analyzer Overview 
window

Operation mode Change B, C or C+
Reload Initial Database B, C or C+
Transferring parameters to/from analyzer C or C+
Upload User Script C or C+
Download User Scrip C+
Memory Dump C or C+

Analyzer Operation 
window

Changing GC state C or C+
Changing Operation mode B, C or C+
Change Measurement state B, C or C+
Valve operation (manual) of analyzer C or C+
Chanhge Set up C or C+

Chromatogram 
window

Backup Analysis Result C+
Restore Analysis Result C+
Re-integration C+

Analysis Results 
window

Setting the Number of History Data B, C or C+
Editing figures C+
Re-integration C+

Alarm window PCAS Alarm History B, C or C+
Clear alarm history C or C+

GC1000 
MarkII

Overview window Changing analyzer operation mode B, C or C+
Changing analyzer measurement state B, C or C+
Transferring parameters to/from analyzer C or C+

Analyzer Operation 
window

Changing analyzer operation mode B or C
Changing analyzer measurement state B or C
Valve operation (manual) of analyzer C
Transferring parameters to/from analyzer C *1
Resetting an analyzer C *1

Alarm window Clear alarm history C or C+

*1: In case of analyzer single mode.
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n Changing User Level
This paragraph describes the user level changing procedure, using the changing of the user level 
to “C” as an example.

l Operation procedure
(1) Click on the User Level command in the System menu.
 The User Level submenu appears.

 F0312.ai

Indicates the currently 
set user level.

• You can also conduct this operation by clicking the  button on the toolbar. In this case, a 
dialog box appears instead of the submenu.

(2) Click on Level (C).
 The Set Password dialog box appears.

 

(3) Enter the password.
 Example: Condition where a password has been entered:

  
****

• A password is a four-digit number. When you enter the password, asterisks (*) are 
displayed, letting you know only the number of digits entered.

(4) Click the Execute button.
 The Confirmation dialog box appears.

 
(5) Click the OK button.
 This causes user level “C” to be set.
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3.4 Displaying Analyzer Status
The Analyzer Status window consists of eight pages, and each page can display the statuses of 
up to 16 analyzers.

n Setting Analyzer(s) to be Displayed (Page Setting)
Set analyzer(s) to be displayed for each page.

l Operation procedure
(1) Click on the Set Page command in the Display Setting menu.

• You can also conduct this operation by clicking the  button on the toolbar.

 The dialog box for setting analyzer(s) to be displayed appears.

 
 The “Analyzers to be Displayed” section displays the ID numbers of the analyzers currently 

set for display on that page in green.
 A list of analyzers below this section shows the ID numbers of all the analyzers registered 

for the analyzer server, and the marks indicates whether the analyzer is set for display.
(2) Clicking the arrow to the right of the “Page No.” box causes a list of page numbers to 

appear. Click and choose the page number where you wish to make the setting(s).
 When the dialog box is displayed, the number of the page currently being displayed is the 

one that appears there.
(3) Set the analyzer to be displayed. Double clicking on the frame of an ID number in the list of 

analyzers allows switching between visible/invisible.
 Each frame of the analyzer list is organized as follows:

 F0316.ai

Set to visible: Green
Set to invisible: White

(4) If you wish to make settings on another page, repeat steps (2) and (3).
(5) After setting all desired analyzers, click the Set button and then the Exit button.
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 If you click the Exit button before clicking the Set button, a dialog box appears asking 
whether you want to save settings. Also, clicking the Cancel button causes the operation to 
be exited without saving the settings.

 This returns you to the Overview window, and the settings are reflected in the page being 
displayed.

TIP
• Page settings that have been newly made are saved in a file and are ready to be put into effect at a later 

time.

• If you change the page settings, the Latest Analysis Results window that was previously displayed will be 
closed.

n Selecting Page
Choose a page to be displayed.

l Operation procedure
(1) Click on the Select Page command in the Display Setting menu.

• You can also conduct this operation by clicking the  button on the toolbar.

 This causes the Select Page dialog box to appear.

 
 The pages to which analyzers have been set are displayed in black type; those to which no 

analyzer has been set are grayed out.
(2) Choose the page to be displayed and click the OK button.
 This returns you to the Overview window, and the selected page is displayed in the Analyzer 

Status window.

3.5 Displaying the Latest Analysis Results Window
The Latest Analysis Results window displays the latest analysis results (peak-basis 
concentration) for each analyzer. It facilitates the simultaneous display of the latest analysis 
results of multiple analyzers. Display data are updated at every analysis interval.
The portion of the analysis results not visible in a single window can be seen by scrolling with the 
scroll bar.
Note that if you switch the page to another while this window is displayed, the original window will 
be erased.
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l	 Configuration

l Functions and display information of elements
Display Item Function and Display Information

Title bar Shows the object analyzer ID number as well as the window name.
Analysis Start Time Indicates the time of day at which analysis of the displayed data was 

started.
Stream#-Peak#-Peak 
Name

Indicates the stream number, peak number, and peak name, delineated by 
“-”. For results obtained in Lab mode or Manual mode, the stream number 
indicated is “32.”

Concentration Value Indicates the concentration value in %, ppm or "No unit" as a peak-basis
analysis result.

CAUTION
If the peak setting is modified from the analyzer unit side while the Latest Analysis Results 
window is being displayed, exit the Engineering Terminal and then reboot it. Continuing to 
display the Latest Analysis Results window without a reboot may cause the analysis results to be 
incorrect.

n Display
l Operation procedure

Click the  button (Analyzer Status window) of the analyzer for which you wish to display the 
Latest Analysis Results window.
The Latest Analysis Results window appears.

n Exiting
l Operation procedure

Click on the Close command in the Control menu in the Latest Analysis Results window.
The Latest Analysis Results window is closed.
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3.6 Selecting Analyzer
To display any window other than the Overview window or perform operations for a specific 
analyzer, you need to first specify the ID number of that analyzer.
This section describes how to specify the analyzer ID.
There are two ways of specifying the analyzer ID: a method specifying it using a command or a 
button, and that of specifying it from the Analyzer Status window.

l Method of specifying analyzer ID using a command or a button
(1) Click on the Analyzer ID command in the Display Setting menu.

• You can also conduct this operation by clicking the  button on the toolbar.

 The following message appears asking whether you want to continue operation.

 
(2) Click the Yes button.
 A dialog box for entering an analyzer ID appears.

 
(3) Enter the analyzer ID number.
(4) Click the OK button.
 The specified analyzer ID is set and displayed in the analyzer ID display section on the 

toolbar.

l Method of specifying analyzer ID from the Analyzer Status window
On the Analyzer Status window, double click on the inside of the ID number frame of the analyzer 
you wish to specify.
The specified analyzer ID is set and displayed in the analyzer ID display section on the toolbar.

TIP
When the selected analyzer’s ID has been set, all windows other than the Overview window will be erased 
because the corresponding analyzer is changed. Also, the database of the newly set analyzer is uploaded to 
memory; this takes some time.
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3.7 Uploading and Downloading Analyzer 
Setting Parameters

When incorporating the settings specified in the Set Parameter List window of the LCD panel 
into another analyzer, or when creating a backup for re-setting, you upload and download the 
parameters.
Before transferring the parameters, you need to specify the ID number of the analyzer to operate.

SEE ALSO
For specifying the analyzer ID number, see section 3.6, “Selecting Analyzer.”

CAUTION
To upload and/or download setting parameters, user level change is required. Please refer to 
3.3 Changing User Level. Besides, upload and/or download setting parameters from overview-
screen is allowed only the case of GC1000 MarkII. Also, the operation status must be changed to 
“Stop.”

n Uploading
To upload the set parameters from the analyzer and save them to the Engineering Terminal disk, 
proceed as follows:

l Operation procedure
(1) Click on the Parameter Transfer command in the Option menu.
 The submenu for transferring parameters appears.

 F0321.ai

(2) Click on the Upload to PC command.
 The Save As dialog box for specifying a setting parameter file appears.

 F0322.aiEnter a file name.
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(3) Enter the file name for the setting parameters to be saved under, preceding the extension 
“.px1” (“.pr7”), and click on the “Data” directory which is preserved for saving.

 Example: Where “system01” is specified as the file name:

  
system01. pr7

(4) Click the OK button.
 The AS_MAIN dialog box appears, indicating that uploading the setting parameters from the 

analyzer is taking place.

 F0323.ai

 When all the setting parameters have been saved to the file, the FileMan dialog box 
appears.

 Note that uploading the parameters to the Engineering Terminal takes about 10 seconds.

 F0324.ai

(5) Click the OK button.
 This completes the uploading process.

HELP !
If you wish to interrupt the uploading of setting parameters,

• Click on the Interrupt command in the File menu.
     A Confirmation dialog box appears.
• Click the Yes button.

n Downloading
To download setting parameters from the Engineering Terminal to an analyzer, do the following:

CAUTION
• It is recommended that the work of download is done by Yokogawa service engineer.
• Please make the back up parameter file by uploading before download work start.
• Please use latest parameter (.px1) which is already upload. IP adress is stored in the 

parameter file and GC and HMI can not communicate if in case IP adress is changed.
• It is recommended that the GC is connected with PC which is installed Engineering Terminal 

only. It should be better to separate from other device on the network during download work.
• The downloaded parameter is valid after OFF/ON the GC power.
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• If the parameters have been written to an analyzer, exit the Engineering Terminal and then 
restart it. If you do not restart, data cannot be displayed properly.

• If in case  the GC can not be connected with the PC which is installed the Engineering 
Terminal after download work, please contact Yokogawa service engineer to recover the 
situation.

l Operation procedure
(1) Click on the Parameter Transfer command in the Option menu.
 The submenu for transferring parameters appears.

 F0325.ai

(2) Click on the Download to GC command.
 The Open dialog box for specifying the setting parameter file appears.

 F0326.aiClick here.

(3) Enter the file name and click the Open button.
 The AS_MAIN dialog box appears indicating that the setting parameters are being 

downloaded to the analyzer.

 F0327.ai

 When all the parameters have been transferred from the Engineering Terminal to the 
analyzer, the FileMan dialog box appears indicating the completion of the transfer.

 Note that downloading parameters to an analyzer takes about 30 seconds.
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 F0328 .ai

(4) Click the OK button.
 This completes the downloading process.

• If you wish to interrupt the downloading of setting parameters, click on the Interrupt 
command in the File menu. For the Interrupt command, see the previous HELP ! .

(5) Confirm new IP adress in the network setting screen of EtherLCD (refer to section 5.4.14).
(6) Turn the GC power OFF/ON. Then connect with the new IP adress of (5).

3.8 Resetting Analyzers
You can soft-reset an analyzer.
Before conducting a reset, you need to specify the ID number of the analyzer to reset.

CAUTION
To conduct a reset, user level change is required. Please refer to 3.3 Changing User Level. 
Besides, analyzer reset from overview-screen is allowed only the case of GC1000 MarkII. Also, 
the operation status must be changed to “Process/Lab - Stop.”
Performing this operation to reset an analyzer forces measurement to be interrupted. Only use 
this feature if absolutely necessary.

SEE ALSO
For specifying an analyzer ID number, see section 3.6.

l Operation procedure
(1) Click on the Reset Analyzer command in the Option menu.
 A dialog box appears asking whether you want to reset the analyzer.
 Example: For the analyzer with ID number 4

 F0329.ai

(2) Click the OK button.
 A dialog box appears indicating whether the reset command was accepted.
(3) Click the OK button.
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When the reset command has been accepted, individual communication with the analyzer is 
disconnected and the Analyzer Operation window, Chromatogram window, Alarm window, and 
Analysis Results window will automatically be closed. Communication with the Overview window 
is also disconnected, but will be automatically restored after the analyzer is reset.

CAUTION
The Analyzer Reset command can be selected from the menu only when the analyzer being 
connected is in Remote mode. If the analyzer is in Local mode, set the operation mode to 
Remote and then choose the Reset command from the menu.

3.9 Displaying Other Windows
The Overview window is the basic window of the Engineering Terminal. All windows other than 
the Overview window are displayed from the Overview window.
This section describes how to display windows other than the Overview window.

n Displaying Each Window
The following describes how to display each window.

CAUTION
Except for the Overview window, only windows associated with a specific analyzer can be 
displayed. If you wish to change to a window corresponding to another analyzer, exit the window 
you are currently in, change the analyzer ID, and then display the desired window.

TIP
• Generally, only one window can be displayed at a time; however, different types of windows, such as the 

Analyzer Operation window and the Analysis Results window, can be displayed simultaneously.

l Operation procedure
Click on the desired window command in the Window menu.

• You can also conduct this operation by clicking the relevant window display button on the 
toolbar.

 The specified window appears.

n Redisplaying a Window
As you use a number of windows or other applications, there are instances when the window you 
wish to view is hidden by other windows. The following describes how to bring a specific hidden 
window to the front from the Overview window.

TIP
The Change Application command in the Control menu only allows you to display the Overview window and the 
Analysis Results window.
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l Operation procedure
(1) Click on the Window menu.
 The windows already being displayed will have a check mark at the left of each window.
(2) Click on the command that displays the window you wish to redisplay.
 The hidden window is brought to the front.

TIP
Although you cannot see which windows are already opened, the window display buttons on the toolbar also 
allow you to bring a hidden window to the front.

3.10 Countermeasures for Alarms
If an alarm occurs on the analyzer side while the Engineering Terminal is being used, an alarm 
message box appears informing you of its occurrence.

n Alarm Message Box
If an alarm occurs, the following alarm message box appears.

l Functions and display information of elements
Analyzer ID:  Indicates the ID number of the analyzer in which the alarm occurred.

Occurrence Time: Indicates the time of day at which the alarm occurred.

ALM:  Indicates the alarm number.

Alarm Information: Indicates the details of the alarm that has occurred.

Alarm Status button: Calls up the Alarm Status window.

Alarm History button: Calls up the Alarm History window.

Alarm Detail button: Displays the Detailed Information window of the alarm that has been 
selected using the mouse (indicated in yellow). In this case, the selected 
alarm is deleted from the list.

All Clear button:  Closes the window (alarm message box) announcing that an alarm has 
occurred. If it is not necessary to check the details of individual alarms, 
click this button.

If all of the alarms are not visible in the window, you can scroll through the display using the scroll 
bar.

SEE ALSO
For the Alarm window, see Chapter 6, “Alarm Window.”
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4. Display and Operations while 
Connected to GC8000

This chapter describes the display and operations of the Overview window when the GC8000 is 
connected.
“ASET-S01 (Single analyzer mode)” does not have the overview window.

[Associated windows]

F4-0.ai

Overview 
window

Analyzer 
Overview 
window

Analyzer 
Operation 

window

Chromatogram 
window

Analysis Results 
windows

Alarm 
windows

Analyzer 
Configuration 

window

(Single analyzer mode does
 not have “overview window” )
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4.1 Overview Window
l	 Configuration

The Analyzer Status window is the main part of the Overview window. It displays the latest 
operation states of up to 16 analyzers that have been specified in advance, and updates display 
data automatically at 1-second intervals. You can click a button in the window to change the 
operation mode or to display the Latest Analysis Results window.

The analyzers displayed in the Analyzer Status window when the Overview window is displayed 
for the first time after installation are those automatically selected from the analyzers specified 
for the analyzer server. To switch to the desired analyzer display, execute the Display Setting and 
Set Page commands.

Operation Mode

Elapsed time bar graph Elapsed time/Analysis cycleAlarm Status

Status

Analyzer ID/Tag name
Measurement Status

Select GCM combo box

l Functions and Display Information of Elements
Button/Display Function and Display Information

Analyzer ID and Tag name Indicates “#xxx-tag name” (where, xxx is the analyzer ID and the tag name 
consists of up to 16 characters) after “ANA ID:” 

Alarm Status
 (No alarm),  (Level-2 alarm), or  (Level-1 alarm) is indicated.

The Alarm Status window appears when the button is double-clicked.
Status  (Process) or  (Manual) is indicated.

Operation Mode  (Run),  (Pause), or  (Stop) is indicated.

Measurement Status Indicates the “Stream sequence n”, “Stream (Continuous)”, “Calibration n”, 
“Validation n”, “Stream n”, “Method n” in this format. (“n” is a single digit.)

Elapsed time/Analysis 
cycle

Indicates the on-going analysis using a progress bar.
They are indicated in the 
“Elapsed time/Analysis cycle” format.

Select GCM combo box Indicates the currently selected GCM number.
All GCM numbers being set for the target analyzer are shown on the list.
“GCM1” is indicated when the Overview Window is opened.
When another page is displayed, the previously displayed GCM number is saved.

Disabled communication If communication is disabled, “Disable” is indicated at the right of the tag name.
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4.2 Analyzer Overview Window
The Analyzer Overview window monitors the status of up to 6 GCMs of the currently connected 
GC8000. The following shows an example of the window.

GCM Status 
Display area

Toolbar

Figure 4.1 Analyzer Overview window (for 6 GCMs)

Figure 4.2 Analyzer Overview window (for 1 GCMs and 1 systems)
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4.2.1 Toolbar 
The toolbar consists of the toolbar buttons and the text window to indicate the ASET status.

Window Display button
Analyzer Operation window
Analysis Results windows
Chromatogram window
Alarm windows
Analyzer Status window

Change GCM 
No. button

Change User 
Level button

GC8000 Alarm

GCM No.

User LevelChange All VGC 
Operation Mode button

Help button

Figure 4.3 Detailed explanation of toolbar

Table List of each element functions
Button/Display Function and Display Information

Change User Level button Displays the Change User Level dialog box.
Use this button to change the user level (A, B, C, or C+).

Window Display button Displays the relevant window. If a window cannot be displayed, its button is grayed 
out.

Change GCM No. button Displays the Change GCM Number dialog box. Use this button to change the 
active GCM.

Change All GCM 
Operation Mode button

Displays the Change All GCM Operation Mode dialog box.
This button changes the operation mode of all GCMs of the analyzer 
simultaneously.

Help button Displays a Help window.
GC8000 Alarm Displays the alarm status of the entire GC8000. The most serious alarm status 

level of each GCM is indicated. 
lGreen: No alarm 
lYellow: Level-2 alarm has occurred.
lRed: Level-1 alarm has occurred.
The alarms have the following severity levels. Level 1 is the highest level of 
severity. Level 1 → Level 2 → (Level 3) → No alarm

GCM# Indicates the active GCM number.
This is empty (deselected) when this window is opened.

User Level Displays the currently set user level.

4.2.2 GCM Status Display Area
The GCM Status Display area shows each GCM status of the GC8000. The number of display 
areas depends on the GCM count (1 to 6) held by the GC8000.

GCM Alarm Status

GCM No.
Operation 
Mode

Measurement Status System No. Elapsed time/System 
Analysis cycle

Elapsed time 
bar graphStream No.

Measurement status

Method No.

Changed Operation Mode Number

Display Analysis 
Result button

Figure 4.4 Detailed description of GCM Status Display area
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Table List of each element function
Display Function and Display Information

GCM No. Indicates the GCM number (1 to 6).
Operation Mode Indicates the GCM operation mode (Run, Pause, or Stop).
Status Indicates the GCM status (Process or Manual).
Stream No. Indicates a stream number (1 to 31) being measured by the GCM.

In the Process Stop status, the stream number is empty. 
In the Manual status, the item itself is hidden.

Measurement Status Indicates the current measurement status of GCM (such as stream sequence, 
stream specification, and calibration/validation).
If the stream specification is selected, the current number of measuring times and 
the number of times to measure are indicated. (Example: Stream specification 
(7/10))
Also, if the number of times to measure is zero (Continuous), “Stream specification 
(Continuous)” is displayed.
In the Manual status, this item itself is hidden.

Method No. Indicates the current method number (1 to 6) of the GCM.
In the Process Stop status, the stream number is empty. In the Manual status, the 
item itself is hidden.

GCM Alarm Status Displays the alarm status of GCM. 
lGreen: No alarm 
lYellow: Level-2 alarm has occurred.
lRed: Level-1 alarm has occurred.
When you double-click this indication, the Alarm Status window of the GCM 
appears.

System number Indicates a system number (1 to 6) of the GCM.
System Operation mode Indicates the system operation mode (Run, Pause, or Stop).
Elapsed time/System 
Analysis cycle

Indicates the time (in seconds) that has elapsed from the start of system analysis 
and the cycle (in seconds) of SYS analysis.
In the Stop operation mode, “ 0/ ---” is displayed. While in the Manual Run mode, 
“100/ ---” is displayed and only the elapsed time is updated.

Elapsed time bar graph Indicates the progress of measurement (in percentage) in a bar graph based on 
the elapsed time and the GCM analysis cycle. The green area increases when the 
measurement proceeds.
If the GCM analysis cycle is greater than the system analysis cycle, the odd-
numbered analysis is turned green and the even-numbered analysis is turned aqua.

Change Operation Mode 
button

Displays the dialog box used to change the operation mode. You can change the 
operation mode of the corresponding GCM. You cannot select this option in the 
Manual status. See Subsection 4.2.5 “Change Operation Mode.”

Display Analysis Result 
button

Displays the latest analysis result window of the corresponding GCM. The Latest 
Analysis Results window is displayed for each GCM. You can open a multiple 
number of Latest Analysis Results windows for GCM simultaneously. See 
Subsection 4.2.6 “Latest Analysis Results window.”

When you double-click any GCM display area, other than “GCM Alarm Status” area, the Change 
GCM Number dialog box opens. See Subsection 4.2.4 “Selecting GCM No.”
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4.2.3 User Level
In addition to the conventional user levels, level “C+” has been added for connection to the 
GC8000. User level A has the lowest privilege, and user level C+ has the highest privilege. The 
privileges assigned to each user level are summarized below.

Table Type of User Levels and Privileges
User Level Privilege Password

A Allows the user to check the operation status and analysis 
results only.
Does not allow the analyzer operation.

Not required (Default)

B Among the analyzer operations, this level allows the user 
to change the operation mode, change the measurement 
status (except for cancel specification), and to change the 
range.

1192

C Allows the user to check and set up all items of analyzer 
operation. However, re-integration of chromatogram and 
editing of analysis results are not allowed.

1603

C+ Allows re-integration of chromatogram and editing of 
analysis results.

1702

You can change the user level in the following procedure.

l Changing the user level using the Change User Level button on the toolbar
1) Click the Change User Level button on the toolbar, and the Set User Level dialog box 

appears.
2) From the Set User Level dialog box, select the desired user level. Then, click the OK button 

and the Set Password dialog box appears.
3) Enter the password and click the Execute button. When the password is correct, a message 

box showing “User level is set to xx” appears (where, “xx” is the new user level).

l When changing the user level using the User Level command of Connect 
menu
1) From the User Level command list of Connect menu, select the desired user level (A to C+).
2) The Password Input dialog box appears.
3) Enter the password and click the Execute button. When the password is correct, a message 

box showing “User level is set to xx” appears (where, “xx” is the new user level).
Note: No password input is requested when you change to user level A.

Figure 4.5 Set User Level dialog box
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Figure 4.6 Password Input dialog box

4.2.4 Selecting GCM No.
You can select the active GCM as follows.

• Select the GCM Number command from the Window menu.
• Click the Change GCM Number button on the toolbar.

The active GCM number is shown when the Select GCM Number dialog box is opened. If the 
active GCM is not selected, this field is blank.

 
Figure 4.7 Select GCM Number dialog box  

(If active GCM is selected (shown at left); if not selected (shown at right))

Select the GCM number and click the OK button, and the GCM having this number is selected. 
However, if an active GCM is already selected, the following confirmation message is displayed. 
If you respond with “Yes”, the select GCM Number dialog box is displayed.

Figure	4.8	 Confirmation	message	before	changing	the	GCM	number

You can select an active GCM directly by double-clicking the GCM display area. In this case, the 
GCM select dialog box is not displayed.
If an active GCM is already selected, the above confirmation box opened. If you respond with 
“Yes”, the active GCM is changed. If an active GCM is not selected yet, the GCM is selected 
immediately.
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4.2.5 Changing Operation Mode
You can change the GC8000 operation mode.

To change the operation mode of the entire GCM, call the Change All GCM Operation Mode 
dialog box in either of the following ways.

• Select the Change All GCM Operation Mode command from the Operation Mode menu.
• Click the Change All GCM Operation Mode button on the toolbar.

Figure 4.9 Change All GCM Operation Mode dialog box

From this dialog box (figure 4.9), you can select the Run, Pause, Stop, or Forced Stop mode. 
(Note that you can select the Forced Stop if you are at user level C+.)

To change the operation mode of each GCM, call the Change Each GCM Operation Mode dialog 
box in either of the following ways.

• From the Operation Mode menu, select the Change Operation Mode command.
• Click the Change Operation Mode button in each GCM display area.

Figure 4.10 Change Each GCM Operation Mode dialog box

From this dialog box (figure 4.10), you can select the Run, Pause, or Stop mode.
In both dialog boxes, you can change the operation mode as follows.
1) Select an operation mode you wish to change, and click the OK button. A confirmation 

message showing “The operation mode is changed to xx” appears (where, “xx” is the 
selected operation mode). If the GCM is not in the Process status, the “The request for 
change of GCMx operation mode was rejected” message is returned (where, “xx” is a GCM 
number).
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2) When you respond to the confirmation message with OK, the operation mode is changed 
for each GCM.

If the operation mode change request is rejected due to the operation conditions, a level-3 alarm 
is generated and its status information is given.
When you issue a Change All GCM Operation Mode request, multiple GCMs may not accept the 
specified operation mode. In such case, multiple sets of level-3 alarm are generated.

4.2.6 Latest Analysis Results Window
The Latest Analysis Results window lists the latest concentration of selected GCMs.

Figure 4.11 Latest Analysis Results window

The stream number and peak name are shown at left, and the concentration is shown at right. 
The concentration is shown as “???????” if it exceeds the upper or lower limit.
Up to 999 sets of peak concentration can be displayed. You can display a concentration outside 
of the window page by scrolling it.
The display of this window is refreshed when the latest analysis result of each GCM is obtained.
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4.3 Analyzer Operation Window
The Analyzer Operation window displays the analysis status of each GCM and system of the 
connected GC8000 and allows the user to control their operations.

4.3.1	 Configuration	of	Analyzer	Operation	Window
The following shows the element names of the Analyzer Operation window.

Caption

Valve display control section

Timing 
Display 
Section

Chromatogram 
Display 
Section

Operation 
Status 
Display 
Bar

Temperature/Pressure Display SectionData Display Section

Figure 4.12 Element names of Analyzer Operation window (System 1)

4.3.2 Operation Status Display Bar
The Operation Status Display bar is a tool for monitoring the current operation status of the 
analyzer and for operating it.

l Window elements
a b

f g h

c d i e

Figure 4.13 Operation Status Display bar
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l Window elements
a: Status buttons 
 These buttons display the GCM status and operate it. The “Process” status is shown at left, 

and “Manual” status is shown at right.
b: GCM Operation Mode buttons 
 These buttons display the GCM operation mode and operate it. They are “Run”, “Pause”, 

“Stop”, “Forced Stop”, and “Command Cancellation” shown from left to right. They indicate 
the current operation mode based on the button status.

(Example) In the case of "Run" mode

Button Status Description
"Run" mode is running.

A request for change of "Run" mode can be made.

"Run" mode is reserved.

A request for change to "Run" mode cannot be made.

c: Measurement status change buttons 
 These buttons change the GCM measurement status. They are “Stream Sequence”, 

“Stream specification”, “Cancel Setting”, “Start Calibration/Validation”, “Stop Calibration/
Validation”, “Calibration/Validation Method”, and “Start/Stop Auto Calibration” shown from 
left to right.

d: Various setup change buttons 
 These buttons call a dialog box to change various settings of GC8000. They are “Range 

Change”, “Set Valve ON/OFF time”, “Set Up”, and “Set Stream Sequence” shown from left 
to right.

e: Help button
f: System select buttons 
 These buttons call the Analyzer Operation window of the specified system. If the selected 

window is already called, it is displayed on the top layer.
 The system numbers used for GCMs are left-justified and displayed sequentially. The 

system number button is not displayed if its system is not used for the GCM.
g: System operation mode display buttons 
 These buttons indicate the operation mode of currently displayed system. They are “Run”, 

“Pause” and “Stop” shown from left to right.
h: Elapsed time display
 Indicates the elapsed time (in seconds) of the displayed system and the ratio of elapsed 

time (in percentage) based on the analysis cycle.
i: User level display 
 Indicates the currently set user level.
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In addition, the following information is shown by the operation mode display bar.

Table Information provided by the Operation Mode Display bar
Item Description

Method Indicates the current method number. It can be 1 to 6.
This is left blank if the Manual status or the Stop Process is set.

Stream under 
Measurement

Indicates the number of the stream currently being measured. It can be 1 to 31.
This is left blank if the Manual status and the Stop operation mode are set.

Stream to be 
Measured Next

Indicates the number of the stream scheduled to be measured next. It can be 1 to 31.
This is left blank if the Manual status and the Stop operation mode are set.

Measurement 
Status

Indicates the current measurement status.
For stream sequence: “Stream sequence 1” to “Stream sequence 8”
For stream specification: “Stream specification (xxx/yyy)” 
where, “xxx” is the current number of measuring times, and “yyy” is the number of times to 
measure. 
“xxx” can be 0 to 999, and “yyy” can be 1 to 999.
If the number of times to measure is set to zero (0) for “Stream specification (Continuous)”
For calibration: “Calibration 1” to “Calibration 6”
For validation: “Validation 1” to “Validation 6”
During Dummy Task (Stream 33) 
measurement: “Replacement available”
This is left blank if the Manual status is set.

Measurement 
status change 
queued

If the measurement status is specified to be changed, the measurement status change 
queue is displayed.
For stream sequence: “Stream sequence 1” to “Stream sequence 8”
For stream specification: “Stream specification”
For calibration: “Calibration 1” to “Calibration 6”
For validation: “Validation 1” to “Validation 6”
This is left blank if the Manual status is set.

4.3.3 Operations from Operation Window
The following describes the operations selectable from the Analyzer Operation window.

Operation 
involved 
in all GCMs

Operation per 
system

Operating Stream 
Valve
(Applicable only 
to Manual status)

Operating 
Atmospheric
-Pressure 
Balancing Valve
(Applicable only 
to Manual status)

Switching the 
display of 
valve/gate ON/
OFF time every 
time valve/gate 
is opened

ON/OFF Operation 
of Valves
(Applicable only 
to Manual status)

Left-click: ON/OFF 
operation of detectors
(Applicable only to Manual status)
Right-click: 
Displays the Detector Signal 
Display window.

ON/OFF Operation of 
Hydrogen Limiting Unit
(Applicable only to Manual status)

When displaying 
temperatures: 
Temperature 
Control Unit 
Operation window 
is displayed.
When displaying 
pressures: 
Press. Status 
window is 
displayed.

Switching the 
display of 
temperature/
pressure

Figure 4.14 Element names of Analyzer Operation window
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4.3.4 Changing Stream Sequence No.
To change a stream sequence number, select the Stream Sequence command from the 
Measurement Status menu. When the Stream Sequence dialog box appears, select a sequence 
number and click the Execute button. The measurement status is changed to the stream 
sequence of the specified number. (The sequence number can be 1 to 8.)

TIP
The stream sequence number will not be changed if any stream has not been allocated to the specified stream 
sequence number.

Figure 4.15 Stream Sequence dialog box 

4.3.5	 Changing	Stream	Specification
To change a stream specification, select the Stream Specification command from the 
Measurement Status menu. The Stream Specification dialog box appears.

     

Only stream numbers 
belonging to GCM 
can be selected.

Figure	4.16	 Stream	Specification	dialog	box	(The	box	when	opened	is	shown	at	left,	and	the	box	for	
stream number selection is shown at right.)

Select a stream number and the iteration count, and click the Execute button. The measurement 
status is changed to the stream specification and the stream is measured for the specified 
number of times. Then, the operation is stopped automatically.
If you set the iteration count to zero (0), the specified stream is measured continuously.
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4.3.6 Changing Calibration/Validation No.
To change a Calibration/Validation number, select the Calibration/Validation command from the 
Measurement Status menu. The Calibration/Validation dialog box appears.

List only those for which calibration 
settings have been specified.

Figure 4.17 Calibration/Validation dialog box 

From the Calibration/Validation dialog box, you can select any of Calibration 1 to Calibration 6, 
and any of Validation 1 to Validation 6.
If the stream number is not set, its option is not displayed. (If no stream number is set for 
Calibration/Validation, its button is grayed out and cannot be selected from the dialog box.)
When you specify a Calibration/Validation number and click the Execute button, the 
measurement status is changed to the Calibration/Validation of the selected calibration/validation 
number.
If you select a Dummy Task (Stream 33), the Stream under Measurement is changed to the 
“Replacement available.” In this case, the Dummy Task (Stream 33) is measured continuously 
until you select the Start Calibration/Validation command from the Measurement Status menu. 
(The chromatogram is not saved and the analysis result is not calculated.)

4.3.7 Changing Calibration/Validation Method
To change the Calibration/Validation Method, select the Calibration/Validation Method command 
from the Measurement Status menu. The Calibration/Validation Method dialog box appears.

Figure 4.18 Calibration/Validation Method dialog box

Select a Calibration/Validation Method of either Manual, Semi-automatic or Auto, and click the 
Execute button. The Calibration/Validation Method is changed. The current Calibration/Validation 
Method is selected in the dialog box if it is opened.
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If the initial analyzer database has been updated when you call this dialog box, the following 
message is displayed and you cannot start this dialog box. In such case, reload the initial 
database and recall this dialog box.

Figure 4.19 The message displayed if the initial analyzer database has been updated

4.3.8 Changing Auto Calibration Status
To change the Auto Calibration Status, select the Auto Calibration Status command from the 
Measurement Status menu, and click the Start button. The Auto Calibration function of active 
GCM is enabled. When you select “Stop” from the Auto Calibration Status command, the Auto 
Calibration function is stopped. You can also change the Auto Calibration Status of active GCM 
using the “Start/Stop Auto Calibration” button on the toolbar.
On the Start/Stop submenu, the currently selected option is checked.
If the Calibration/Validation Method is set to Semi-automatic or Manual, the Auto Calibration 
Status command is grayed out on the Measurement Status menu and it is inoperable. Also, the 
Start/Stop Auto Calibration button is grayed out on the toolbar.

4.3.9 Operating Stream Valve
To operate a stream valve, set the GCM to the Manual status and select the Manual or Stream 
VLV command from the Manual/Range menu. The Operating Stream Valve dialog box appears.

Figure 4.20 Operating Stream Valve dialog box

To turn the stream valve On, select ON. The stream number list of the GCM is displayed from the 
ON Stream Valve Number combo box. Then, click the Execute button.
To turn the stream valve Off, select OFF and click the Execute button.
You can also call this Operating Stream Valve dialog box by clicking the stream number display of 
the Analyzer Operation window.

9th Edition : Nov. 04, 2014-00



  <4.  Display and Operations while Connected to GC8000> 4-16

IM 11B06C01-01E

4.3.10 Operating Valves
Operate valves in the following procedure. You operate valve 1-1 in this example.
Ensure the GCM is in Manual status. From the Manual/Range menu, select “Oven1”, “VLV” and 
“VLV1-1” commands in this order. Now, you can turn valve 1-1 on or off.
When the valve is Off and when you select this command, a confirmation message showing 
“The valve is turned On” appears in the message box. When you respond with “Yes”, the valve is 
turned On.
Similarly, when the valve is On and when you select this command, a confirmation message 
showing “The valve is turned Off” appears in the message box. When you respond with “Yes”, the 
valve is turned Off.
Operate valves 1-1 to 1-6, 2-1 to 2-6, and 3-1 to 3-6 in the similar way. Note that valves not 
assigned to the system are grayed out and you cannot operate them.
You can also operate the valves by selecting the desired one from the valve status display of 
Analyzer Operation window.

4.3.11 Operating Atmospheric-Pressure Balancing Valve
Operate Atmospheric-Pressure Balancing Valves in the following procedure. You operate 
Atmospheric-Pressure Balancing Valve 1-1 in this example.
Ensure the GCM is in Manual status. From the Manual/Range menu, select “Atm” and “Atm1-
1” commands. Now, you can turn Atmospheric-Pressure Balancing Valve 1-1 on or off. The 
operations are the same as for Subsection 4.3.10 “Operating Valves.”
Note that the Atmospheric-Pressure Balancing Valves not assigned to the GCM are grayed out 
and you cannot operate them.
You can also operate the valves by selecting the Atmospheric-Pressure Balancing Valve display 
of Analyzer Operation window.

4.3.12 Operating Detectors
Operate detectors in the following procedure. You operate Detector 1-1 in this example.
Ensure the GCM is in Manual status. From the Manual/Range menu, select “Oven1”, “DET” and 
“DET1-1” commands in this order. Now, you can turn Detector 1-1 on or off. The operations are 
the same as for Subsection 4.3.10 “Operating Valves.”
Note that the detectors not assigned to the system are grayed out and you cannot operate them.
You can also operate the detectors by clicking the ON/OFF display of detector status in the 
display section of the Analyzer Operation window.

4.3.13 Operating Hydrogen Limiting Unit
Operate the Hydrogen Limiting Unit in the following procedure. You operate Hydrogen Limiting 
Unit 1 in this example.
Ensure the GCM is in Manual status. From the Manual/Range menu, select “Oven1”, “HL” and 
“HL1” commands in this order. Now, you can turn Hydrogen Limiting Unit 1 (HL1) on or off. The 
operations are the same as for Subsection 4.3.10 “Operating Valves.”
Note that the Hydrogen Limiting Units not assigned to the system are grayed out and you cannot 
operate them. You can also operate the units by clicking the ON/OFF display of HL status in the 
data display section of the Analyzer Operation window.
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4.3.14 Operating Temperature Controllers
To operate a temperature controller, first check the GCM is in the Manual status. From the 
Manual/Range menu, select the “Oven1” and “Heater1” commands. The Operate Temperature 
Controller dialog box for Oven 1 appears.

Figure 4.21 Operate Temperature Controller dialog box

The Operate Temperature Controller dialog box shows the SV value, PV value, On/Off status and 
temperature control status of Isothermal oven, LSV and FPD. The PV value, On/Off status, and 
temperature control status are refreshed in every second.
To turn the temperature controller Off, just click the ON display. When a confirmation message 
showing “The temperature controller is turned Off” appears in the message box, respond with 
“Yes” and the temperature controller turns Off.
Similarly, when you turn the temperature controller On, click the OFF display. As a confirmation 
message showing “The temperature controller is turned On” appears in the message box, 
respond with “Yes” and the temperature controller turns On.
You can also call the Operate Temperature Controller dialog box by clicking the temperature 
display of the oven.
The dialog box shows the temperature controller status as follows.
Isothermal oven: Under preparation, Constant temperature control
Programmed-temperature oven: Under preparation, Constant temperature control, Programmed 

temperature control, Cool down
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4.3.15 Pressure Display
Display the pressure of each EPC (Electric Pressure Controller) in the following procedure. You 
display the pressure of Oven 1 in this example.
From the Manual/Range menu, select “Oven1” and “Press1” commands. The Pressure Display 
dialog box for Oven 1 appears.

Figure 4.22 Pressure Display dialog box 

The Pressure Display dialog box shows the SV value, PV value, On/Off status and pressure 
status of Carriers n-1 and n-2 and Utilities n-1 to n-4.
The display is refreshed in every second. The pressure status is Under preparation, Constant 
pressure, or Pressure increasing.
You can also call the Pressure Display dialog box by clicking the pressure display of the oven.

You cannot start an operation from this dialog box. Also, carriers may not be used except for 
Carrier n-1. In such case, the corresponding items are left blank.

CAUTION
This pressure display is valid only when the EPC (Electric Pressure Controller) is used.
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4.3.16 Detector Signal Display
To display detector signals, right-click the detector. The Detector Signal dialog box appears.

      
Figure 4.23 Detector Signal dialog box (The TCD at left, FID-MC at center, and FPD (similar to FID) at 

right)

The display is refreshed in every second. The following items are displayed.

Table Detector signal display item
Item Description

Type Indicates the detector type. It is either “TCD”, “FID”, “FID-MC” (FID having methane 
converter), “FPD”, or “None”.

Input Signal The input signal is sampled every 20 msec, and this analog signal is converted into 
digital form, averaged at the sampling rate, and displayed. 

Filtered Signal The input signal is filtered using the filter constant of detector signal settings and 
displayed.

Standard Deviation Indicates the standard deviation of the past 20 input signals.
Voltage Indicates the TCD bridge voltage. (TCD only)
Current Indicates the TCD bridge current. (TCD only)
Flame Level Indicates the preset Flame Detection Level. (FID, FID-MC, FPD)
Therm. Signal Displays the thermocouple signals. (FID, FID-MC, FPD)
Flame Status Indicates the Flame Detection status (Flame On or Flame Out). (FID, FID-MC, FPD)
Voltage of MC Indicates the converter voltage. (FID-MC only)
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4.3.17 Changing Range
To change the Range, select the Change Range command from the Manual/Range menu. The 
Range Change dialog box appears.

Figure 4.24 Range Change dialog box 

From this dialog box, you can change the Stream/Peak measuring range to the specified range 
number. After selecting the stream of the range, peak of the range, and the range number, click 
the Execute button. A confirmation message asking “Are you sure you want to send the data?” 
appears. If you respond with “Yes”, the current range is changed to the specified range number.
You can select stream numbers and system numbers of the current GCM only.
Also, you can select only the peak number assigned to the detector of the selected system 
number.
The range number can be any of 1 to 31.
The following items are displayed.
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Table Display of Range Change dialog box for each process setting (details)
Process setting 

(Details)
Result unit Measuring 

range
Reference peak 

No. 1
Reference peak 

No. 2
Remarks

External third Displayed Displayed Displayed
Negative (-) sign 
is shown if the 
reference stream 
and peak are “0, 
0”.

Negative (-) sign is 
shown.

For Calibration 
Stream, the 
reference stream 
and peak are “0, 
0”.

External linear Displayed Displayed Displayed Displayed For Calibration 
Stream, the 
reference stream 
and peak (for both 
1 and 2) are “0, 0”.

Indirect method 
Deviation 
calculation 
Linear 1 to 5

Displayed Displayed Negative (-) sign is 
shown.

Negative (-) sign is 
shown.

AI1 to 16 Negative (-) 
sign is shown.

Displayed 0% value 100% value

Others 
(such as ratio)

Negative (-) 
sign is shown.

Displayed Negative (-) sign is 
shown.

Negative (-) sign is 
shown.

4.3.18 Stream Valve ON/OFF Setting
To set a turn-On/Off time of stream valves, select the Stream Valve command from the Setup 
menu. The Stream Valve ON/OFF Setting dialog box appears.

Figure 4.25 Stream Valve ON/OFF Setting dialog box

If no stream valve is used for the active GCM, the Stream Valve command is grayed out on the 
Setup menu and you cannot select it.
In this dialog box, you can change the ON and OFF time for each method number of stream 
valve of the active GCM. First, select a method number. A pair of ON and OFF time of the stream 
valve of this method is displayed. Change the ON and OFF times and click the Change button. 
A confirmation message asking “Are you sure you want to send the data?” is displayed in the 
message box. When you respond with “Yes”, the settings are changed.
Each item can be selected in the following range.
Method number: 1 to 6
Valve ON time: “- Preparation time to System analysis cycle - 2 sec”
Valve OFF time: “ON time to System analysis cycle - 2 sec”
However, if it is set to “********”, both ON and OFF times are made invalid.
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4.3.19 Valve ON/OFF Setting
To set the On/Off time of valves, select the Valve command from the Setup menu. The Valve 
ON/OFF Setting dialog box appears.

Figure 4.26 Valve ON/OFF Setting dialog box

In this dialog box, you can change the ON and OFF time for each method number of the valve of 
the specified system number.
First, select a system number, method number, and valve number. Three pairs of ON and OFF 
times of the valve are displayed. Change the ON and OFF times and click the Change button. 
A confirmation message asking “Are you sure you want to send the data?” is displayed in the 
message box. When you respond with “Yes”, the settings are changed.

Each item can be selected in the following range.
System number: A number belonging to the current GCM 
Method number: 1 to 6 
Valve number: The number selected as the system number and assigned
Valve ON time: “0 to System analysis cycle - 2 sec”
Valve OFF time: “ON time to System analysis cycle - 2 sec”
However, if it is set to “********”, both ON and OFF times are made invalid.
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4.3.20 Atmospheric-Pressure Balancing Valve ON/OFF 
Setting

To set the On/Off time of atmospheric-pressure balancing valves, select the Atmospheric-
Pressure Balancing Valve command from the Setup menu. The Atmospheric-Pressure Balancing 
Valve ON/OFF Setting dialog box appears.

Figure 4.27 Atmospheric-Pressure Balancing Valve Setting dialog box

If atmospheric-pressure balancing valve is not used for the active GCM, the Atmospheric-
Pressure Balancing Valve command is grayed out on the Setup menu and you cannot select it.

In this dialog box, you can change the ON and OFF time for each method number of the 
atmospheric-pressure balancing valve of the specified system number.
First, select a system number, method number, and valve number. Three pairs of ON and OFF 
times of the valve are displayed. Change the ON and OFF times and click the Change button. 
A confirmation message asking “Are you sure you want to send the data?” is displayed in the 
message box. When you respond with “Yes”, the settings are changed.

Each item can be selected in the following range.
System number: A number belonging to the current GCM 
Method number: 1 to 6 
ATM number: The atmospheric-pressure balancing valve number of the GCM is displayed. This 
cannot be selected.
Valve ON time: “- Preparation time to System analysis cycle - 2 sec”
Valve OFF time: “ON time to System analysis cycle - 2 sec”
However, if it is set to “********”, both ON and OFF times are made invalid.
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4.3.21 Peak Setup Dialog Box
To set peaks, select the Peak submenu from the Setup menu. The Set Peak dialog box appears.

Figure 4.28 Set Peak dialog box

In this dialog box, you can set a stream number, system number, and peak number options.
After you have changed the settings, click the Change button. A confirmation message asking 
“Are you sure to change the settings?” is displayed in the message box. When you respond with 
“Yes”, the settings are changed.
You can select stream numbers and system numbers of the current GCM only.
Also, you can select only the peak number assigned to the detector of the selected system 
number.

l Peak Info.
You can set the specified stream number, system number, and peak name of the peak number.
The peak name can be up to eight characters, consisting of alphanumeric characters and 
symbols *, (, ), +, #, $, ;, <, >, %, and /.
After you have changed the settings, click the Change button. A confirmation message asking 
“Are you sure you want to send the data?” is displayed in the message box. When you respond 
with “Yes”, the settings are changed.

l Gate Time
You can set the peak reference time, gate ON time, and gate OFF time for the specified stream 
number, system number, and peak number.
After you have changed the settings, click the Change button. A confirmation message asking 
“Are you sure you want to send the data?” is displayed in the message box. When you respond 
with “Yes”, the settings are changed.

Note that you can edit the peak reference time only when the following two conditions are 
satisfied. Otherwise, the time is shown as “********” and you cannot edit it.
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1) If the Auto Tracking is set to “Track Standard”
2) If the Distillation Analysis is set to “No”

If the Process Setting is set to “Calculation” or “Caloric processing”, all of Peak Reference Time, 
Gate ON Time, and Gate OFF time are grayed out and you cannot change them.

l Result Unit/Measuring Range
You can set the measuring unit and range for the specified stream number, system number, and 
peak number.
After you have changed the settings, click the Change button. A confirmation message asking 
“Are you sure you want to send the data?” is displayed in the message box. When you respond 
with “Yes”, the settings are changed.

l Ref Stream/Ref Peak
You can set a reference stream number and a reference peak number (for the specified stream 
number, system number, and peak number).
After you have changed the settings, click the Change button. A confirmation message asking 
“Are you sure you want to send the data?” is displayed in the message box. When you respond 
with “Yes”, the settings are changed.

l Gate Cut Method/Integ Method
You can set a Gate Cut Method and an Integration Method for the specified stream number, 
system number, and peak number.
After you have changed the settings, click the Change button. A confirmation message asking 
“Are you sure you want to send the data?” is displayed in the message box. When you respond 
with “Yes”, the settings are changed.

l Calib. Settings
You can set the Standard Concentration, Standard Area, and Calibration Coefficient for the 
specified stream number, system number, and peak number. Note that the information about a 
stream not being set as the Calibration Stream is grayed out and you cannot change it.
After you have changed the settings, click the Change button. A confirmation message asking 
“Are you sure you want to send the data?” is displayed in the message box. When you respond 
with “Yes”, the settings are changed.
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4.3.22 Gate Tracking
To set the gate tracking, select the Gate Tracking command from the Setup menu. The Set Gate 
Tracking dialog box appears.

Figure 4.29 Set Gate Tracking dialog box

In this dialog box, you can enable or disable the Gate Tracking of the system assigned to the 
active GCM. The window displays the gate tracking setup of all systems being assigned to the 
active GCM.
After you have changed the settings, click the Change button. A confirmation message asking 
“Are you sure you want to send the data?” is displayed in the message box. When you respond 
with “Yes”, the settings are changed.
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4.3.23 Stream Sequence
To set a stream sequence, select the Stream Sequence command from the Setup menu. The Set 
Stream Sequence dialog box appears.

Figure 4.30 Set Stream Sequence dialog box

In this dialog box, you can assign streams of active GCM stream sequence, and enable or 
disable the sequence as follows.
(1) Select a stream sequence number (1 to 8) to set the stream sequence. The corresponding 

stream sequence settings are displayed.
(2) Enable or disable the sequence. (Select the box to enable, and deselect the box to disable.)
 If you deselect a box, the stream number is indicated as “****” automatically and the stream 

number is no longer selectable.
(3) From the stream number combo box, you can select up to 31 stream numbers that are 

being assigned to the GCM.
(4) After you have changed the settings, click the Change button. A confirmation message 

asking “Are you sure you want to send the data?” is displayed in the message box. When 
you respond with “Yes”, the settings are changed.

4.4 Chromatogram Window
The Chromatogram window displays chromatograms of GCM currently connected and 
chromatograms stored in PCAS. It also re-integrates chromatograms.
One “online startup” Chromatogram window can be displayed and up to four “off-line startup” 
Chromatogram widows can be displayed.
“Online startup”
A startup procedure in which communication with the analyzer or PCAS is possible. 
Chromatograms can be acquired from the analyzer or PCAS, and re-integration results can be 
transferred.
“Off-line startup”
A startup procedure in which communication with the analyzer or PCAS is not established. 
Activate with clicking the icon “Chromatogram” on ASET. Only file chromatograms can be 
displayed.
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4.4.1 Overview of Chromatogram Window
Caption

Legend

Enlarge/
Reduce 
buttons

X-axis scale

Y-axis 
scroll bar

Y-axis scale

Mouse position 
display

Overall 
display area

Upper display 
ON/OFF button 
(new)

Temperature/
Pressure 
scales

Temperature/
Pressure 
scroll bars

X-axis scroll bar Re-integration invoking 
button

Enlargement 
display area

Figure 4.31 Chromatogram window

The following explains the elements of the Chromatogram window.
1) Caption
 Displays “#Analyzer ID-GCM number (window startup status)” after a window name.
 As the window startup status, “Online” or “Off-line” is displayed.
2) Legend
 Displays the correspondence between pen colors and the chromatogram names 

currently displayed. A chromatogram can be shown or hidden, or deleted, and the active 
chromatogram can be selected in this area.

3) Enlarge/Reduce button
 Use this button to enlarge or reduce X-axis scale, Y-axis scale, temperature axis, or 

pressure axis.
4) Overall display area
 An area displays the whole chromatogram. The portion displayed in the enlarged display 

area is indicated in cyan.
5) Mouse position indication
 When the mouse cursor is in the overall display area or enlargement display area, the 

coordinates that the current mouse cursor indicates is displayed by “elapsed time (sec.) and 
detector electromotive force (mV)”.

6) Enlargement display area
 An area where a chromatogram is displayed. The selected portion of a chromatogram can 

be enlarged. On a chromatogram, the gate mark, peak mark, and peak number can be 
displayed.

 It can also display the peak information, gate information, temperature data, and pressure 
data corresponding to the chromatogram.

7) X-axis scale
 Indicates the elapsed time (in sec.) of chromatogram.
8) X-axis scroll bar
 Scrolls chromatogram in the X-axis direction.
9) Y-axis scale
 Indicates the electromotive force (in mV) of chromatogram.
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10) Y-axis scroll bar
 Scrolls the Enlargement Display window in the Y-axis direction.
11) Temperature/Pressure scale
 Indicates temperature data or pressure data. Temperature scale (in deg C) and pressure 

scale (in kPa) can be switched (cannot be displayed at the same time). The scales can be 
switched by double-clicking on the scale.

12) Temperature/Pressure scale scroll bar
 Scrolls temperature data or pressure data displayed in the Enlargement Display window.
13) Upper section display ON/OFF button
 Use this button to display or hide legend, the enlarge/reduce button, and the overall display 

area.
14) Re-integration invoking button
 Use this button to invoke the chromatogram re-integration function.

4.4.2 Toolbar
The toolbar consists of the following buttons.

Saving 
chromatograms

Save/Delete 
Chromatogram

Auto Gain

From left to right
Enlargement

Reduction
Partial Enlargement

Overall Display
Auto Scale

Reintegrate Multiple 
Chromatograms Help Mouse Position Display

From left to right
Set Pen
Set Mark

Temp/Pressure Display

From left to right
Show Multiple 

Chromatograms 
(Tile Horizontally)
Show a Shift (ON)

From left to right
Snap Shot 1
Snap Shot 2

Figure 4.32 Toolbar of Chromatogram window

4.4.3 Chromatogram Types
The following types of chromatograms are provided.
1) Latest chromatogram
 This is the chromatogram currently being measured. One latest chromatogram is provided 

for each detector (latest chromatogram 1-1 to 3-2), and the update cycle is 1 second.
2) Previous chromatogram
 This is the chromatogram measured the last. One previous chromatogram is provided for 

each detector (previous chromatogram 1-1 to 3-2).
3) Saved chromatogram
 This chromatogram is saved by the user to the GC8000 main body. A maximum of 20 

chromatograms per system can be saved as “saved chromatogram”. If the analysis cycle is 
30 minutes or more, the number of chromatograms that can be saved decreases.

4) Baseline chromatogram
 This chromatogram is saved by the user to the GC8000 main body as “baseline 

chromatogram”. One chromatogram per system can be saved as “baseline chromatogram”.
5) History chromatogram
 This chromatogram is automatically saved to the GC8000 main body or PCAS. Saved to 

the GC8000 main body is the “history chromatogram” for the past one week for six detectors 
(for the past six weeks if there is only one detector). To PCAS, all the chromatograms in the 
past two months can be saved. This denotes that, if saved once per ten analyses, all the 
chromatograms in the past one year can be saved.
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6) File chromatogram
 This chromatogram is automatically saved on ASET or manually saved by the user.
7) Differential chromatogram
 This chromatogram is the result of difference determined by comparing two chromatograms.
 The difference of shifted chromatograms are determined as they are in the shifted status.
 If chromatograms are shifted after their difference was displayed as a differential 

chromatogram, the differential chromatogram is not updated automatically. In that case, 
display the differential chromatogram again.

4.4.4 Active Chromatogram
The “active chromatogram” is the target for shifting, re-integrating, and other operation intended 
for chromatogram. In legend display, the current active chromatogram is highlighted in mazarine.
To select the active chromatogram, manually click a chromatogram displayed in the legend area.
A temperature graph or pressure graph can also be set as active. The active graph can be 
shifted. However, re-integration operation is not available while the graph is active.

4.4.5 Legend display

Figure 4.33 Example of legend display

This area displays the correspondence between the pen colors and the names of 
chromatograms, temperature graphs, and pressure graphs currently displayed.
By selecting or deselecting the check box of each graph name, corresponding graph can be 
displayed in the Enlargement Display window.
If a check box is cleared, the corresponding chromatogram name is highlighted in gray, and the 
chromatogram is hidden in the Enlargement Display window.
By clicking the DEL button of a graph, the corresponding graph can be deleted completely.

4.4.6 Auto Gain Mode of Chromatogram
• If auto gain mode is selected in the enlargement display area, the voltage value of 

chromatogram is enlarged based on the gain setting for each peak.
• If auto gain mode is enabled, the Y-axis scale is displayed according to the gain setting. If 

auto gain mode is disabled, the Y-axis scale is displayed in mV.
• For auto gain mode, the gain setting for each peak must be configured. Therefore, a 

chromatogram without gain setting capability does not support auto gain mode.
• An unevenness may occur on the portion of chromatogram where the gain level changes.
• In auto gain mode, the Y-axis scale is displayed according to the gain in the most left portion 

where chromatogram is displayed. Also in an enlargement, the gained chromatogram is 
displayed.

For auto gain mode, select the auto gain mode in the scale menu.
The following shows an example of display in auto gain mode.
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Figure 4.34 Example of display in auto gain

4.4.7 Gate Mark, Peak Mark, and Start Mark
In mark settings, if you select gate mark, peak mark, and start mark to be displayed, they are 
displayed in chromatogram in the enlargement display area.

Gate OFF

Peak OFF

Start mark
Gate ON

Peak ON

Figure 4.35 Example of displaying gate mark, peak mark, and start mark

4.4.8 Additional Information (Peak No., Peak Name, etc.)
Among the following data items, up to two items can be displayed in the Enlargement Display 
window.

- Relative peak number, - Peak name (up to 8 characters), - Gain (multiplying factor is 
displayed in “G:n” where n = 0 to 15), - Range (displayed in “Rng: XX.XX unit”), - Standard 
concentration (displayed in “S.Cnc:XX.XX unit”).

Click on the Set Mark command in the Graph menu to display the Set Mark dialog box. Select 
data from the additional information 1/additional information 2 lists. If you want to hide data, 
select “None”. In case of off-line, peak number is only indicated.

The following shows examples of displaying additional information.

Range and 
standard concentration

Peak name 
and gain

Figure 4.36 Examples of displaying gate mark and peak mark
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4.4.9 Shifting Chromatogram
A selected chromatogram can be shifted in the desired X-axis or Y-axis direction by dragging.
The shift function can be enabled or disabled using the menu command or toolbar button. If it is 
disabled, the normal state is displayed. If it is enabled, the previous shift status is displayed.
If clearing shift information is selected from the menu command, the stored shift information is 
cleared.

4.4.10 Re-integration of Chromatogram
The re-integration function can re-integrate chromatograms stored in a file and recalculate the 
concentration values. It can also transfer the re-integration results to ASET and reflect them on 
subsequent measurements.

CAUTION
• This function is enabled for level C+ users.
• A peak can be re-integrated when “external third”, “external linear”, or “indirect method” 

processing is specified for the peak.

Chromatogram 
re-integration area

Figure 4.37 Chromatogram re-integration function (for external third)
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l Chromatogram re-integration area

Re-integration button

Individual peak data areaAnalysis result list Chromatogram information

Figure 4.38 Chromatogram re-integration area (external third)

1) Chromatogram information
 Displays the analysis start time, stream number, and detector number of chromatogram to 

be re-integrated.
 The location of the parameter file can also be specified. If it is acquired from GC8000 while it 

is currently communicating, “Online” is displayed.
2) Analysis result list
 Displays the list of analysis results corresponding to chromatogram to be re-integrated. 

Displayed in the list are relative peak number, peak name (unit), concentration, and 
retention time.

 By clicking a peak in the list, you can select the peak to be re-integrated. The peak 
information currently selected is highlighted in cyan.

3) Individual peak data area
 Displays the current analysis results of the selected peak. Information required for re-

integration can be edited in this area.
 Items to be displayed vary depending on the combination of the processing setting and the 

concentration calculation setting.
4) Re-integration buttons
 Re-integration button: Use this button to perform re-integration.
 Update button: Use this button to apply the re-integration results. (The results are not saved 

to a file)
 Peak processing/transfer button: Use this button to transfer gate time and other data edited 

in re-integration to the initial GC8000 database.
 Result transfer button: Use this button to save the re-integration results to the chromatogram 

file or analysis result file, and transfer them to PCAS or GC8000. However, the results 
cannot be transferred unless you click the update button previously.

 Cancel button: Use this button to discard the re-integration results and restore the status 
before re-integration. If the update button was clicked previously, however, the status before 
re-integration cannot be restored .
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l Re-integration procedure for chromatogram
Prerequisites:

• To re-integrate chromatogram, a chromatogram file and the corresponding analysis result 
file is required. (The latest chromatogram for which analysis is not completed cannot be re-
integrated as well as differential chromatograms.)

Procedure:
1) Select a chromatogram you want to re-integrate and specify it as the active chromatogram.
2) Click the re-integration invoking button to display the chromatogram re-integration area. In 

the enlargement display area, the active chromatogram is only displayed then.
3) In the off-line mode, click Ref. button and select a parameter file to be used in re-integration 

(in the online mode, this step can be omitted).
4) In the analysis result list in the chromatogram re-integration area, click the data row of the 

peak to be re-integrated. Then, the data row of the selected peak is displayed in color, and 
the corresponding data is displayed in the individual peak information area.

5) Edit the data in the individual peak data area.
 By dragging ▼ of X-axis scale, the gate ON time and gate OFF time can be changed 

graphically.
6) After editing the data, click the re-integration button. Then, the chromatogram is re-

integrated according the edited data.
 At this time, values after re-integration are displayed for concentration and the retention time 

in the analysis result list and concentration and the retention time in the individual data area.
 If peak detection failed during re-integration, or a re-integration result does not fall within the 

range of the upper and lower limit, “???????” is displayed for the corresponding item.
7) If you want to cancel the re-integration results, click the cancel button. This returns the 

current peak data to the status before re-integration. If the update button was clicked 
previously, however, the status before re-integration cannot be restored.

8) Click the Update button. Then, the re-integration results are applied in the window, and 
concentration and the retention time in the individual data area are transferred into the 
analysis result list. The result transfer button will then be available.

9) Click the result transfer button. Then, the re-integration results are saved to the 
chromatogram file and analysis result file. Furthermore, these files are transferred to 
GC8000.

10) Click the peak processing and transfer button. Then, data units (Gate ON, gate OFF, 
detection slope, gate processing, detection level, area/height, integral processing, 
etc.) are transferred to the database in GC8000 to reflect the re-integration results on 
measurements.

11) Click the re-integration invoking button again to terminate the re-integration process. If the 
re-integration results have not been applied, a message appears asking the user to confirm 
whether they want to apply the results.

TIP
On clicking the re-integration button, consistency between parameters (the initial database in the online mode, 
or a parameter file in the off-line mode) and analysis results is checked. Target parameters are the assignment 
number of peaks on stream, peak name, unit, and relative peak number. If any of them is inconsistent, the 
message “Cannot perform re-integration because of inconsistent parameters” appears.

l Re-integration procedure for multiple chromatograms
1) Select a chromatogram to be used as a reference for re-integration, specify it as the active 

chromatogram, and click the re-integration invoking button. At this time, check the analysis 
results in the chromatogram re-integration area in advance and, if necessary, perform and 
complete the re-integration process and apply the results.

2) Select the Re-integrate Multiple Chromatogram command in the Re-integration menu. 
Then, the Re-integrate Multiple Chromatogram dialog appears.
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3) Specify the stream number, analysis start time, and the number of re-integrating 
processes. Subsequently, clicking the “Execute” button performs re-integration of multiple 
chromatograms. At this time, re-integration is performed for the analysis results of the 
analysis count tracked back from the analysis start time.

4) When re-integration has been completed, the execution result (success or fail) of the 
individual chromatogram re-integration is displayed in the dialog box. Failed re-integration 
results are not updated.

5) To exit, click the “Close” button. Then, the Re-integrate Multiple Chromatogram dialog box 
closes.

Multiple chromatogram re-integration is determined to fail in the following cases:
• The number of peak assignments is different from that in the re-integration reference 

chromatogram.
• Peak detection failed.
• The concentration value after re-integration falls out of the range.

CAUTION
“Distillation = Yes” is set in the analyzer currently connected or loaded parameter file, re-
integration cannot be performed.

4.4.11 Pen Setting
Select the Set Pen command in the Graph menu to display the Set Pen dialog box.

 
Figure 4.39 Set Pen dialog box (Example in the right shows a combo box is selected)

From this dialog box, different types of chromatograms to be displayed with pen 1 to 8 can be 
selected.
From a combo box for each pen color, select a chromatogram you want to display. Depending on 
the type of selected chromatogram, a different dialog box may be invoked.
The following shows the graph names that can be selected from the combo box.
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Table Chromatograms selectable from the Set Pen dialog box
Graph name Description of chromatogram to be displayed

None Hides the chromatogram corresponding to the pen color.
Latest chromatogram 1-1 to 3-2. Displays the latest chromatograms of the detector belonging to GCM 

currently connected. The detector number belonging to GCM is only 
registered in the combo box.
It is not registered in off-line mode.

Previous chromatogram 1-1 to 
3-2.

Displays the previous chromatograms of the detector belonging to GCM 
currently connected. 
The detector number belonging to GCM is only registered in the combo 
box.
It is not registered in off-line mode.

Saved chromatogram 1-1 to 3-2. Displays the saved chromatograms (a maximum of 20 per detector) of 
the detector belonging to GCM currently connected. The detector number 
belonging to GCM is only registered in the combo box.
It is not registered in off-line mode.
If the “Saved chromatogram” is selected from the combo box, a dialog box 
appears to enable the user to select the analysis start date and time of the 
saved chromatogram.

History chromatogram 1-1 to 3-2. Displays the history chromatograms of the detector belonging to GCM 
currently connected. The detector number belonging to GCM is only 
registered in the combo box. 
It is not registered in off-line mode.
If the “History chromatogram” is selected from the combo box, a dialog box 
appears to enable the user to select the analysis start date and time of the 
history chromatogram.

Baseline chromatogram 1-1 to 
3-2.

Displays the baseline chromatograms (one per detector) of the detector 
belonging to GCM currently connected. The detector number belonging 
to GCM is only registered in the combo box. It is not registered in off-line 
mode.
If the “Baseline chromatogram” is selected from the combo box, a dialog 
box appears to enable the user to select the analysis start date and time of 
the baseline chromatogram.

File chromatogram Displays the file chromatograms stored in the PC in the specified pen 
color. 
File chromatograms of GCM currently not connected can also be 
displayed.
If the “File chromatogram” is selected from the combo box, a file dialog box 
appears to enable the user to select a file chromatogram to be displayed. 
If the selected chromatogram file includes chromatograms of multiple 
detectors, a dialog box appears to enable the user to select a detector 
number.

Differential chromatogram 1 to 2 Select two currently displayed chromatograms to obtain the difference. 
Up to two differential chromatograms can be displayed. If the “Differential 
chromatogram” is selected from the combo box, a dialog box appears to 
enable the user to select two chromatograms for which the difference will 
be determined.
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4.4.12 Selecting Saved Chromatogram
1) From the Set Pen dialog box, select “Saved chromatogram” (“n-m” indicate a detector 

number from which to obtain saved chromatograms).
2) A dialog box for selecting a saved chromatogram appears. In the dialog box, the list of the 

analysis start time and date of the saved chromatograms (up to 20) is displayed.

Figure 4.40 Saved chromatogram setting dialog box

3) Select the analysis start date and time, click the OK button.
 The display format is “Analysis start date and time (YYYY/MM/DD hh:mm:ss) S detector 

number”.
 For example, if the analysis start date and time is 2009/1/15 15:30:00, and the detector 

number is 2-1, “2009/01/15 15:30:00S2-1” is displayed.
4) Click the OK button then, the saved chromatogram is displayed..

4.4.13 Selecting History Chromatogram
1) From the Set Pen dialog box, select “History chromatogram n-m” (where “n-m” represents a 

detector number from which to obtain history chromatograms).
2) A dialog box for selecting year/month/day appears.
3) Select the year/month/day then, a dialog box for selecting the analysis start date and time 

appears.

     
Figure 4.41 History chromatogram setting dialog box (Left: Selecting year/month/day, Right: 

Selecting analysis result date and time)

4) Select the analysis start date and time, click the OK button.
 The display format is “Analysis start date and time (YYYY/MM/DD hh:mm:ss) H detector 

number”.
 For example, if the analysis start date and time is 2008/09/16 12:00:00, and the detector 

number is 2-1, “2008/09/16 12:00:00H2-1” is displayed.
5) Click the OK button then, the history chromatogram is displayed.
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4.4.14 Selecting Baseline Chromatogram
1) From the Set Pen dialog box, select “Baseline chromatogram” (where “n-m” indicate a 

detector number from which to obtain baseline chromatograms).
2) A dialog box for selecting baseline chromatogram appears.

Figure 4.42 Baseline chromatogram setting dialog box

3) Select the analysis start date and time click the OK button.
 The display format is “Analysis start date and time (YYYY/MM/DD hh:mm:ss) B detector 

number”.
 For example, if the analysis start date and time is 2009/2/15 10:30:00 AM, and the detector 

number is 2-1, “2009/02/15 10:30:00B2-1” is displayed.
4) Click the OK button then, the baseline chromatogram is displayed.

4.4.15 Selecting File Chromatogram
1) From the Set Pen dialog box, select “File chromatogram”.
2) The “Open File” dialog box appears.

Figure 4.43 Open File dialog box

3) Select the file to be displayed click the OK button.
 The display format is “File name F detector number”.
 For example, if the file name is 20071218113220.chr, and the detector number is 2-1, 

“20071218113220.chrF2-1” is displayed.
4) Click the OK button then, the file chromatogram is displayed.
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4.4.16 Selecting Differential Chromatogram
1) From the Set Pen dialog box, select “Differential chromatogram”.
2) The “Set Differential Chromatogram” dialog box appears.

Figure 4.44 Set Differential Chromatogram dialog box

3) From the combo box, select graph names for which to determine difference. 
Chromatograms currently registered in pens 1 to 8 are displayed in the combo box 
(differential chromatograms are excluded).

 Chromatograms shown in selective graph 1 are those to be used as reference, and 
chromatograms shown in selective graph 2 are to be used to compare differences with the 
reference.

4) Click the OK button.
5) The obtained differential chromatogram name is displayed in the appropriate combo box of 

the Set Pen dialog box. The display format is “n-m”, where “n” represents the pen number 
of chromatogram selected in selective graph 1, and “m” represents the pen number of 
chromatogram selected in selective graph 2.

4.4.17 Displaying Chromatogram File by Drag & Drop
1) When you have dragged and dropped a chromatogram file on to a chromatogram, the file 

chromatogram is displayed. The pen displayed at this time is the one that has the smallest 
pin number among unused ones. Temperature data and pressure data are not displayed 
automatically.

2) If chromatograms of multiple detectors are stored in a single file, unused pens are 
automatically assigned to the detectors in ascending order of detector number.

3) From the combo box in the Set Pen (file chromatogram) dialog box, you can select a 
graph name currently displayed and a chromatogram name for each detector stored in the 
dragged-and-dropped file. From this dialog box, select a chromatogram for overwriting.

Figure	4.45	 Set	Pen	dialog	box	(file	chromatogram)
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4.4.18 Set Mark Dialog Box
Select the Set Mark command in the Graph menu to display the Set Mark dialog box.
From this dialog box, you can turn display of gate marks, peak marks, and start marks on or off, 
set whether to display or hide additional information, and select the information.

Figure 4.46 Set Mark dialog box

• If the “Peak ON/OFF” check box is selected, the peak ON/OFF information of the 
corresponding chromatogram is displayed.

• If the “Gate ON/OFF” check box is selected, the gate ON/OFF information of the 
corresponding chromatogram is displayed.

• With additional information 1 and 2, you can select two items to be displayed on the 
Chromatogram window for each peak. Select from peak number, component name, gain, 
range, and standard concentration. The display position is the highest point between the 
gate ON time and the gate OFF time.

• Additional information 2 is displayed on the top of additional information 1.
• If you have selected the same item in additional information 1 and 2, the same information is 

displayed twice.
• If the smart mark check box is selected, the smart mark appears, in tandem display mode, 

at the separator section in system analysis cycles. The smart mark check box is not 
displayed in single display mode.

CAUTION
• The peak ON/OFF information, gate ON/OFF information, and additional information are 

not provided for a differential chromatogram, and therefore the relevant check boxes and 
combo boxes are not displayed.

• When the GC1000 MarkII chromatogram file is displayed, combo boxes for additional 
information 1 and 2 are not displayed because it does not have additional information.

• In a file chromatogram not intended for tandem display, a saved chromatogram, a baseline 
chromatogram, and a differential chromatogram, the smart mark check box is not displayed.
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4.4.19 Temperature/Pressure Dialog Box
Select the Temperature/Pressure command in the Graph menu to display the Temperature/
Pressure dialog box.
From this dialog, temperature data and pressure data can be selected to be displayed with pens 
1 to 8.

   
Figure 4.47 Temperature/Pressure dialog box (Example in the right shows a combo box is selected)

1) From a combo box for each pen color, select a temperature or pressure graph you want to 
display.

2) Click the OK button to display the selected temperature or pressure data by dotted line in 
the specified pen color in the enlargement display area. If you have selected “None”, the 
pen is not displayed.

 The update cycle of the temperature data and pressure data for the latest chromatogram is 
1 second.

The following explains what (TempX), (PressX-1), and (PressX-2) represent in the combo box. (X 
= 1 to 3)
TempX: Temperature data for oven X
PressX-1: Pressure data 1 for oven X
PressX-2: Pressure data 2 for oven X

All oven temperatures and EPC pressures of the system belonging to the detector can be 
displayed. One chromatogram has a maximum of three units of temperature data (Temp1 to 
Temp3) and six units of pressure data (Press1-1 to Press3-2) as well as one unit of temperature 
data.
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4.4.20 Save Chromatogram Dialog Box
Select the Save Chromatogram command in the File menu to display the Save Chromatogram 
dialog box.
From this dialog box, you can select a chromatogram currently displayed, and save it as a file on 
the PC.

Figure 4.48 Save Chromatogram dialog box

1) From the dialog box, select one chromatogram to be saved and click the OK button.
2) The “Save As” dialog box appears. Specify a file name and click the save button to save the 

chromatogram to a file. Then, the specified chromatogram and corresponding temperature 
data, pressure data 1, pressure data 2, peak number, and analysis results are saved to the 
file.

Figure 4.49 Save As dialog box
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4.4.21 Saving and Deleting Chromatogram
Select the Save Saved Chromatogram command in the File menu to display the Save 
Chromatogram dialog box. The dialog box consists of three tabs, “Save”, “Delete”, and 
“Baseline”.

CAUTION
“Save” is enabled for user level A or higher, and “Delete” and “Baseline” are enabled for user level 
C or higher.

        
Figure 4.50 Save Saved Chromatogram dialog box (left)  Save dialog box in tandem display mode (right)

l Saving a saved chromatogram
1) In the Save Saved Chromatogram dialog box, select a chromatogram to be saved as 

a saved chromatogram from currently displayed chromatograms in the Chromatogram 
window.

2) Click the “Save” button. This causes the “Do you want to save?” confirmation message to 
appear.

3) Clicking “OK” saves the chromatogram into GC8000.
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l Deleting a saved chromatogram

Figure 4.51 Delete Saved Chromatogram dialog box

1) From the list of saved currently displayed chromatograms in the Chromatogram window, 
select a saved chromatogram to be deleted.

2) After selecting a saved chromatogram you want to delete, click the “Delete” button. This 
causes the “Do you want to delete?” confirmation message to appear.

3) Clicking “OK” deletes the appropriate chromatogram in GC8000.

l Saving a baseline chromatogram

        
Figure 4.52 Save Baseline Chromatogram dialog box (left)  Dialog box in tandem display mode (right)
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1) In the Save Baseline Chromatogram dialog box, select a chromatogram to be saved as 
a baseline chromatogram from currently displayed chromatograms in the Chromatogram 
window.

2) Click the “Save” button. This causes the “Do you want to save?” confirmation message to 
appear.

3) Clicking “OK” saves the baseline chromatogram into GC8000.

4.4.22 Snap Shot
The snap shot function memorizes the coordinates and enlargement factor in the Enlargement 
Display window, and reproduces the status just by a single click.

  
Figure 4.53 Snap shot examples (left: snap 1, right: snap 2)

Above examples show that the left figure is displayed when snap 1 is called and the right figure is 
displayed when snap 2 is called.
The following shows statuses of toolbar buttons and snap shots.

 : A status where snap 1 is not stored. Clicking this button in this state stores the current 
coordinates and enlargement factor.

 : A status where snap 2 is not stored. Clicking this button in this state stores the current 
coordinates and enlargement factor.

 : A status where snap 1 is stored. Clicking this button in this state reproduces the stored 
coordinates and enlargement factor in the enlargement display area.

: A status where snap 2 is stored. Clicking this button in this state reproduces the stored 
coordinates and enlargement factor in the enlargement display area.

4.5 Analysis Results Windows
The analysis results windows display data that has been analyzed by the analyzer. They consist 
of the following windows.

Latest Analysis Results, Concentration Analysis History, Retention Time History, Peak Relating 
Data History, Calibration Coefficient History, File Analysis Results, File Concentration Analysis 
History, File Peak Relating Data History, File Retention Time History, File Calibration Coefficient 
History.

The Latest Analysis Results window appears upon the start-up of the latest analysis results 
windows.
To switch the window, select a window in the Window menu of the Analysis Results window or 
select a tab.
Latest Analysis Results, Concentration Analysis History, Retention Time History, Peak Relating 
Data History, and Calibration Coefficient History must be used in online mode. In off-line mode, 
those items are grayed out and cannot be selected. This also applies to tab selection.
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The average values of File Analysis Results, File Concentration Analysis History, File Retention 
Time History, File Peak Relating Data History, and File Calibration Coefficient History can also be 
displayed in off-line mode.

4.5.1 Latest Analysis Results
When the Latest Analysis Results window starts up, the latest analysis results are displayed for 
each system. The head system number belonging to GCM is displayed for the system.

Figure 4.54 Latest Analysis Results window

l Display contents
The following list the display contents for each item.

Item Description
Concentration Indicates concentration for each peak.
Retention Time Indicates retention time (second) for each peak.
Det.# Indicates detector number (1 to 6) for each peak.
Peak
start/Retention/end

Indicates peak processing start time/retention time/end time (second) for 
each peak.

Gate start/end Indicates gate start time/end time (second) for each peak.
Tracking Indicates the peak pursuing status for each peak as “standard”, “pursuit”, or 

“none”.
Peak Level start/height/end Indicates the peak start level/height level/end level (mV) for each peak.
Area Indicates the integral value of the peak level (mV second) for each peak.
Shape Indicates the peak data processing status for each peak. It displays “P” for 

tangent correction resetting or “H” for the perpendicular method.
Half-value Width Indicates half-value width (second) for each peak.
Tailing Coefficient Indicates tailing constant for each peak.
Variation Coefficient Indicates concentration variation coefficient for each peak.
Method Indicates concentration computation method for each peak.
Separation Degree Indicates peak separation degree from behind peak.
Base Level at Gate ON Time Indicates base level of each peak at gate on time.
Noise Level at Gate ON Time Indicates noise level of each peak at gate on time.
Base Level at Peak ON Time Indicates base level of each peak at peak on time.
S/N Indicates S/N of each peak.

l Displaying the Latest Analysis Results
1) Select Latest Analysis Results in the Window menu, or the Latest Analysis Results tab to 

display the Latest Analysis window.
2) Select SYS Select in the Display Item menu, or the SYS number of the analysis result you 

want to display from the SYS number select combo box on the toolbar. 
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3) Select Display Item Select in the Display Item menu, and open the Display Item Setting 
window.

Figure 4.55 Display Item Setting window

4) In the Display Item Setting window, add a check mark () to the item you want to display. If 
you want to display all items, click the Select All button. Click the OK button.

5) Select Auto Update from the File menu, or enable or disable automatic update using the 
auto update button on the toolbar. When automatic update is enabled, a check mark is 
added to Auto Update in the menu, causing the auto update button to be depressed. Then, 
the “being updated automatically” message appears on the title bar.

6) If automatic update is enabled and when analysis by the analyzer is complete, the analysis 
results are automatically updated in the Latest Analysis Results window. If automatic update 
is disabled, the Analysis Results window is not updated even when the analysis is complete.

l Displaying stored past analysis results (history)
1) Select Latest Analysis Results in the Window menu, or the Latest Analysis Results tab to 

display the Latest Analysis Results window.
2) Select SYS Select in the Display Item menu, or the SYS number of the analysis result you 

want to display from the SYS number select combo box on the toolbar. 
3) Select Open History in the File menu, or the Open History command button on the toolbar to 

open the analysis result file setting dialog box.
4) Displayed is the analysis start date and time of the history file stored in the combo box. 

Select the desired year and month, then apply it by pressing the OK button.

Figure 4.56 Year and month setting dialog box
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5) Select a desired date from the analysis date setting dialog box, then apply it by pressing the 
OK button.

Figure 4.57 Date setting dialog box

6) Select a desired time from the analysis time setting dialog box, then apply it by pressing the 
OK button.

Figure 4.58 Time setting dialog box

7) The selected analysis results are displayed in the window.
8) Items you want to display can be selected from the Display Item Setting window.

4.5.2 Concentration Analysis History
The window displays the analysis results for all systems included in the selected GCM or for each 
system belonging to that GCM.

l Displaying from the latest concentration analysis results
1) Select Concentration Analysis History Window in the Window menu, or the Concentration 

Analysis History Window tab to display the Concentration Analysis History window.
2) Select SYS Select in the Display Item menu, or the SYS number or GCM of the 

concentration analysis result you want to display from the SYS number select combo box on 
the toolbar.

3) Select Open History in the File menu, or the Open History command button on the toolbar to 
open the history file setting dialog box.

4) From the radio button selecting Display from Latest or Display from History, select Display 
from Latest, then apply it by pressing the OK button.

5) The concentration analysis results are displayed for the latest and for up to 5,000 past 
analyses tracing back from the latest. Each time the latest analysis result is obtained, the 
results are automatically updated in the window. Then, the “being updated automatically” 
message appears on the title bar.
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l Displaying concentration analysis (history) results from the past
1) Select Concentration Analysis History Window in the Window menu, or the Concentration 

Analysis History Window tab to display the Concentration Analysis History window.
2) Select SYS Select in the Display Item menu, or the SYS number or GCM of the 

concentration analysis result you want to display from the SYS number select combo box on 
the toolbar.

3) Select Open History in the File menu, or the Open History command button on the toolbar to 
open the history file setting dialog box.

4) From the radio button selecting Display from Latest or Display from History, select Display 
from History, then apply it by pressing the OK button.

5) From the Display from History combo box, select the desired year and month, and apply it 
using the OK button.

Figure 4.59 Year and month setting dialog box

6) Select a desired date from the analysis date setting dialog box, then apply it by pressing the 
OK button.

Figure 4.60 Date setting dialog box

7) Select a desired time from the analysis time setting dialog box, then apply it by pressing the 
OK button.

Figure 4.61 Time setting dialog box

9th Edition : Nov. 04, 2014-00



  <4.  Display and Operations while Connected to GC8000> 4-50

IM 11B06C01-01E

8) The concentration analysis results are displayed for up to 5,000 past analyses tracing back 
from the specified file. The analysis results are then not automatically updated.

l Setting the Number of History Data
It can be set the obtained historical data number from PCAS or GC8000.
It is applied to concentration analysis history, Retention time history, and Cal. coefficient history.

Figure 4.62 Setting the Number of History Data

4.5.3 Retention Time History
The window displays the analysis results for all systems included in the selected GCM or for each 
system belonging to that GCM.

l Displaying from the latest retention time
1) Select Retention Time History in the Window menu, or the Retention Time History tab to 

display the Retention Time History window.
2) Select SYS Select in the Display Item menu, or the SYS number or GCM of the retention 

time result you want to display from the SYS number select combo box on the toolbar.
3) Select Open History in the File menu, or the Open History command button on the toolbar to 

open the history file setting dialog box.
4) From the radio button selecting Display from Latest or Display from History, select Display 

from Latest, then apply it by pressing the OK button.
5) The retention time results are displayed for the latest and past up to 5,000 analyses 

tracing back from the latest. Each time the latest analysis result is obtained, the results are 
automatically updated in the window. Then, the “being updated automatically” message 
appears on the title bar.

l Displaying retention time (history) results from the past
1) Select Retention Time History Window in the Window menu, or the Retention Time History 

Window tab to display the Retention Time History window.
2) Select SYS Select in the Display Item menu, or the SYS number or GCM of the retention 

time result you want to display from the SYS number select combo box on the toolbar.
3) Select Open History in the File menu, or the Open History command button on the toolbar to 

open the history file setting dialog box.
4) From the radio button selecting Display from Latest or Display from History, select Display 

from History, then apply it by pressing the OK button.
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5) From the Display from History combo box, select the desired year and month, and apply it 
using the OK button.

Figure 4.63 Year and month setting dialog box

6) Select a desired date from the analysis date setting dialog box, then apply it by pressing the 
OK button.

Figure 4.64 Date setting dialog box

7) Select a desired time from the analysis time setting dialog box, then apply it by pressing the 
OK button.

Figure 4.65 Time setting dialog box

8) The retention time results are displayed for up to 5,000 past analyses tracing back from the 
specified file. The analysis results are then not automatically updated.

4.5.4 Peak Relating Data History
Peak Relating Data (Variation coefficient, tailing coefficient, base level on gate-on timing, noise 
level on gate-on timing, base level on peak-on timing, and S/N) can be shown, by selected GCM 
including all SYS or showed by SYS under the selected GCM.
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l Displaying from the latest peak relating data results
1) Select Peak Relating Data History Window in the Window menu, or the Peak Relating Data 

History Window tab to display the Peak Relating Data History window.
2) Select SYS Select in the Display Item menu, or the SYS number or GCM of the peak 

relating data result you want to display from the SYS number select combo box on the 
toolbar.

3) Select Open History in the File menu, or the Open History command button on the toolbar to 
open the history file setting dialog box.

4) From the radio button selecting Display from Latest or Display from History, select Display 
from Latest, then apply it by pressing the OK button.

5) The peak relating data results are displayed for the latest and for up to 5,000 past analyses 
tracing back from the latest. Each time the latest analysis result is obtained, the results are 
automatically updated in the window. Then, the “being updated automatically” message 
appears on the title bar.

l Displaying peak relating data (history) results from the past
1) Select Peak Relating Data History Window in the Window menu, or the Peak Relating Data 

History Window tab to display the Peak Relating Data History window.
2) Select SYS Select in the Display Item menu, or the SYS number or GCM of the peak 

relating data result you want to display from the SYS number select combo box on the 
toolbar.

3) Select Open History in the File menu, or the Open History command button on the toolbar to 
open the history file setting dialog box.

4) From the radio button selecting Display from Latest or Display from History, select Display 
from History, then apply it by pressing the OK button.

5) From the Display from History combo box, select the desired year and month, and apply it 
using the OK button.

Figure 4.66 Year and month setting dialog box

6) Select a desired date from the analysis date setting dialog box, then apply it by pressing the 
OK button.

Figure 4.67 Date setting dialog box
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7) Select a desired time from the analysis time setting dialog box, then apply it by pressing the 
OK button.

Figure 4.68 Time setting dialog box

8) The peak relating data results are displayed for up to 5,000 past analyses tracing back from 
the specified file. The analysis results are then not automatically updated.

4.5.5	 Calibration	Coefficient	History	Window
The window displays the analysis results for all systems included in the selected GCM or for each 
system belonging to that GCM.

l	 Displaying	from	the	latest	calibration	coefficient
1) Select Calibration Coefficient History Window in the Window menu, or the Calibration 

Coefficient History Window tab to display the Calibration Coefficient History window.
2) Select SYS Select in the Display Item menu, or the SYS number or GCM of the retention 

time result you want to display from the SYS number select combo box on the toolbar.
3) Select Open History in the File menu, or the Open History command button on the toolbar to 

open the history file setting dialog box.
4) From the radio button selecting Display from Latest or Display from History, select Display 

from Latest, then apply it by pressing the OK button.
5) The calibration coefficients are displayed for the latest and past up to 5,000 analyses 

tracing back from the latest. Each time the latest analysis result is obtained, the results are 
automatically updated in the window. Then, the “being updated automatically” message 
appears on the title bar.

l Displaying retention time (history) results from the past
1) Select Calibration Coefficient History Window in the Window menu, or the Calibration 

Coefficient History Window command button on the toolbar to display the Calibration 
Coefficient History window.

2) Select SYS Select in the Display Item menu, or the SYS number or GCM of the retention 
time result you want to display from the SYS number select combo box on the toolbar.

3) Select Open History in the File menu, or the Open History command button on the toolbar to 
open the history file setting dialog box.

4) From the radio button selecting Display from Latest or Display from History, select Display 
from History, then apply it by pressing the OK button.

5) From the Display from History combo box, select the desired year, month and day, and 
apply it using the OK button.
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Figure 4.69 Year and month setting dialog box

6) The calibration coefficient results are displayed for up to 5,000 past analyses tracing back 
from the specified file. The analysis results are then not automatically updated.

4.5.6 Plotting History Data on Graph
The Concentration Analysis History, Retention Time History, Peak Relating Data History, and 
Calibration Coefficient History data can be displayed on a graph.

l Drawing a graph
1) From Concentration Analysis History, Retention Time History, Peak Relating Data History, 

and Calibration Coefficient History, select data you want to display on a graph and display it 
in either of the windows.

2) Select Graph A, Graph B, or Graph C in the Graph menu, or Graph A, Graph B, or Graph C 
on the toolbar to open the Graph Setting window.

Figure 4.70 Graph Setting window
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3) From the setting window, select peak names for which you want to create a graph. Up to six 
peak names can be selected at a time.

4) Set up the time axis range. The following shows the setup conditions:
• If “Auto Setup” is selected, the graph displays results for 5,000 analyses tracing back from 

the latest. Each time the latest analysis result is obtained, the graph window is automatically 
updated.

• If “Manual Setup” is selected and when “From the latest analysis time” is selected for the 
end time, the graph window is automatically updated each time the latest analysis result is 
obtained.

• If “Manual Setup” is selected, the setup range of tracing back is 1 to 72 hours and 1 to 5,000 
analyses.

5) Set up the scale for the ordinate. The following shows the setup conditions:
• Set the ordinate scale to either “Linear” or “Logarithmic”.
• For the ordinate scale display range, select one of “Auto”, “Manual”, and “Manual (Center 

value)”. (If the ordinate scale is set to “Logarithmic”, “Manual (Center value)” cannot be 
selected.)

• If “Manual” is selected, enter the “Maximum value” and “Minimum value” accordingly.
• If “Manual (Center value)” is selected, enter the “Center value”, “Range”, and “+-(%)” 

accordingly.
• If necessary, set “Display or hide the upper and lower limits”. Add a check mark and enter 

the value to display a horizontal line indicating the upper limit or lower limit on the graph. The 
limits only indicate the data range and, even if a analysis result falls out of the range, other 
operation (such as alarm) will not occur.

6) Click “OK” to display the graph. If the time axis range is set to “Auto Setup”. then the “being 
updated automatically” message appears on the title bar.

Figure 4.71 Graph window
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l Partial enlargement of graph
1) Click on Part Enlargement in the Graph menu.
2) The range can be specified by dragging a part you want to enlarge in the graph window.
3) The specified area is enlarged.
4)  Select Undo in the Graph menu to restore the status before enlargement.

4.5.7 Calling up Re-integration Window from Analysis 
Results Window

l Re-integration from the Concentration Analysis Results window and Retention 
Time History window
The Chromatogram Re-integration window can be called from the Analysis Results window by 
performing the following operations at user level C+.
(1) While the Concentration Analysis Results window and Retention Time History window 

appear, left double-click “Peak concentration” or “Peak retention time” you want to re-
integrate, or select “Re-integration” in the menu at right.

 In the Chromatogram Re-integration window started up then, the selected “Peak” has 
already been selected as the re-integration target.

(2) While the Concentration Analysis Results window and Retention Time History window 
appear, left double-click “Analysis start date and time” including the peak concentration or 
retention time you want to re-integrate, or select “Re-integration” in the menu at right.

 In the Chromatogram Re-integration window started up then, all peaks in “Analysis start 
date and time” have already been selected as the re-integration target.

CAUTION
If the Concentration Analysis Results window and Retention Time History window display GCM, 
and the Chromatogram Re-integration window is called from “Analysis start date and time”, the 
system select box appears. Select and determined the SYS number. If only a single target GCM 
is in the system, the system select box does not appear.

Figure 4.72 System select box
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Re-integration on Individual Peaks 
(select it from a menu that opens with a 
double click on the left mouse button or a 
click on the right mouse button)

Re-integration on Analysis Start Date and Time 
(select it from a menu that opens with a double 
click on the left mouse button or a click on the 
right mouse button)

The re-integrated results are updated in all of the Concentration Analysis, Retention Time, and 
Analysis Results windows. However, if GCM is displayed, only the peak value of the selected 
SYS number is updated.
When the history chromatogram is not saved yet, the re-integration cannot be performed.

l Re-integration from File Concentration Analysis History and File Retention 
Time History
In online mode, the operation is the same as that for “Re-integration from the Concentration 
Analysis History and Retention Time Analysis History”
However, the analysis results only update the called display window.
Example: If re-integration is performed from the File Concentration Analysis History window, 
only the File Concentration Analysis History window is updated and other windows (such as File 
Retention Time window) are not updated.

In off-line mode, Re-integration (Off-line) is displayed in the right-click menu. When executed, the 
re-integration file select window opens, where you can select the file required for re-integration.
The re-integration results only update the called display window.

Figure	4.73	 Re-integration	file	select	window
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4.6	 Analyzer	Configuration	Window
The Analyzer Configuration Window is a window displaying the GCM or SYS configuration of the 
connected GC8000, the equipment configuration of streams, valves, detectors, etc., and a list of 
equipment statuses.
This window is for display only. It is not possible to operate any equipment from this window.
The Analyzer Configuration Window consists of two windows: the GCM Map and Stream Map 
Windows. The display can be switched by selecting the corresponding tab.

l GCM Map Window
The GCM Map Window shows the following information:

• Number of GCMs set to the GC8000
• SYS numbers set to THE GCM
• Number of isothermal ovens in the GC8000 and their ON/OFF statuses
• Valve settings and their ON/OFF statuses
• Types of detectors (TCD/FID/FID-MC/FPD)
• Presence/absence of EPCs (Carrier n-1 to n-2 and Utility n-1 to n-4; “n” stands for an oven 

number)
• Presence/absence of a hydrogen limiter and its ON/OFF status
• Presence/absence of stream valves and their statuses (stream 1 to 31 or OFF)
• Presence/absence of ATM balanced valves and their ON/OFF statuses
• Stream valves and ATM balanced valves set to THE GCM
• Valves and detectors set to SYS

The following shows an example display of the GCM Map Window:

Figure 4.74 GCM: 6, SYS: 6, detector: 6
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l Stream Map Window
The Stream Map Window displays a list of GCM numbers assigned to streams (1 to 31).

Figure 4.75 Stream Map Window
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5. Display and Operations while 
Connected to GC1000 Mark II

This chapter describes the display and operations of the Overview window, Analyzer 
Operation window, Chromatogram window, and Analysis Results window when the 
Engineering Terminal is connected to a GC1000 Mark II on the Overview window.

Display and operations of the Alarm window are common, regardless of the analyzer type. 
See Chapter 7.

F5-0.ai
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5.1 Overview Window
5.1.1 Analyzer Status Window for GC1000 Mark II

l	 Configuration
The Analyzer Status window is the main part of the Overview window. It displays the latest 
operation statuses of up to 16 analyzers that have been specified in advance, and updates 
display data automatically at 1-second intervals. You can click a button in the window to change 
the operation mode or to display the Latest Analysis Results window.

• The analyzers displayed in the Analyzer Status window when the Overview window is 
displayed for the first time after installation are those automatically selected from the 
analyzers specified for the analyzer server. To change this to display the required analyzers, 
execute the Set Page command in the Display Setting menu.

F5-1-1. ai

Analyzer ID/tag
Operation
Mode

Alarm Status
Elapsed time/Analysis cycle

Elapsed time bar graph

Method No.

Display Analysis Result button

Change Operation Mode button
Measurement Status

Stream No.

Status

l Functions and Display Information of Elements
Button/Display Function and Display Information

Analyzer ID Indicates the ID number of the displayed analyzer.
Status Indicates the current status of the displayed analyzer ID.
Measurement Status Indicates the current measurement status of the displayed analyzer ID.
Operation Mode Indicates the current operation mode of the displayed analyzer ID.
Stream No. Indicates the current stream number of the displayed analyzer ID.
Method No. Indicates the current method number of the displayed analyzer ID.
Change Operation 
Mode button

Displays the dialog box for changing the operation mode of the displayed 
analyzer. Only level-B or -C users can use this button.

Display Analysis Result 
button

Displays the Latest Analysis Results window. The Latest Analysis Results 
window can display the results of multiple analyzers simultaneously.

Alarm Status Displays the current alarm status as follows. Moreover, double clicking the 
alarm status causes the Alarm Status window of that analyzer to appear.
Illuminated in green: No alarm
Illuminated in yellow: Level-2 alarm occurred.
Illuminated in red: Level-1 alarm occurred.

Elapsed time Indicates the current elapsed time in seconds.
Analysis cycle Indicates the analysis cycle of the current analysis. This is indicated only 

when the information can be obtained in Process mode.
Elapsed time bar graph When the analysis cycle is obtained, this displays the current analysis 

progress condition of the displayed analyzer in a bar graph.
(Enable)/Disable Indicates the current connection status of the displayed analyzer with 

respect to the analyzer server. “Disable” is indicated if connection is not 
possible; otherwise, the field remains blank.
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5.1.2 Changing the Operation Mode and/or Measurement 
Status

You can change the GC1000 Mark II operation mode and/or measurement status.
Before changing the operation mode or measurement status, GC1000 Mark II must be selected.

CAUTION
Only level-B or -C users can change the operation mode or operation pattern.

n Changing the Operation Mode
l Operation procedure

(1) Click on the Change Mode command in the Mode menu.
• Clicking the-  button of the target analyzer in the Analyzer Status window allows you to 

simultaneously specify the analyzer ID and mode change.
 The dialog box for changing the operation mode of the specified analyzer appears.

 F5-1-2.ai

(2) Choose a new operation mode and click the OK button.
 A dialog box appears confirming whether you want to change the operation mode.

 F5-1-3.ai

(3) Click the Yes button.
 A dialog box appears indicating whether the change was accepted.

 F5-1-4.ai

(4) Click the OK button.
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n Changing Measurement Status
You can change the measurement status using a command in the Measurement Status menu in 
the Overview window. For more information, see subsection 4.2.4, “Changing Status/Operation 
Mode/ Measurement Status,” in section 4.2, “Analyzer Operation Window.”

5.2 Analyzer Operation Window
The Analyzer Operation window displays the analyzer status of the pertinent analyzer ID. It 
visually displays the latest operation status of the analyzer with the specified ID and allows you to 
operate that analyzer. The data updating cycle is 1 second.

[Associated windows]

F5-2-1.ai

Overview window

Analyzer
Operation
window

Analyzer Operation
command

Close
command

5.2.1 Displaying and Exiting the Analyzer Operation 
Window

This section describes how to display and exit the Analyzer Operation window.

CAUTION
You cannot start multiple Analyzer Operation windows. If you attempt to display the Analyzer 
Operation window of a different-ID analyzer, the display shown so far will be erased.

n Display
Specify an analyzer ID in the Overview window to display the Analyzer Operation window.

SEE ALSO
For specifying an analyzer ID, see section 3.6, “Selecting Analyzer.”

l Operation procedure
Click on the Analyzer Operation command in the window menu.

• You can also conduct this operation by clicking the-  button on the toolbar.

 The Analyzer Operation window appears.
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n Exiting
l Operation procedure

Click on the Close command in the Control menu while the Analyzer Operation window is in an 
active state.
The Analyzer Operation window is closed.

5.2.2	 Configuration	of	the	Analyzer	Operation	Window
The Analyzer Operation window is intended for monitoring analyzer status in detail and for 
analyzer operations. It displays the latest operation status of the analyzer and enables operation 
of the analyzer. The data updating cycle is 1 second.

• During individual connection to ASIU, the Analyzer Operation window cannot be displayed.

n Element Names
The following shows the element names of the Analyzer Operation window.

F5-2-2.ai

Operation
Status
Display
bar

Valve display control section Data display section

Chromatogram
display section

Timing display
section

Title bar
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n Operation Status Display Bar
The Operation Status Display bar is a tool for monitoring the current operation status of the 
analyzer and for operating it.

l Window elements

F5-2-3.ai

Measurement status

edcba

Measurement status change queued Method

a: Status (change command) buttons
 “Process” status
 “Manual” status
 “Lab” status
b: Operation Mode (change command) buttons
 “Run” mode
 “Pause” mode
 “Stop” mode
 “Cancel Command
 (dedicated for commanding)

c: Measurement Status Change specifying buttons
 “Stream Sequence”
 “Stream (Continuous)”
 “Stream (Once)”
 “Calibration (Verification)”
 “Start Calibration (Verification)”
 “End Calibration (Verification)”
 “Cancel Setting”
 “Calibration (Verification) Method”
d: Change Range command button
e: Help Display button

l Button functions and display information
The following table lists the button/display functions and display information.

Button/Display Function and Display Information

Status (change 
command) buttons

These buttons display the current analyzer status. They also enable you 
to conduct status change by clicking the status button that you want to 
change.

Operation Mode 
(change command) 
buttons

These buttons display the current analyzer operation mode and the status 
in which operation mode change has been commanded and reserved.
They also enable you to change the command mode by clicking the 
operation mode button that you want to change. The “Cancel Command” 
button is used to cancel queued operation mode changes.

Measurement Status 
Change setting buttons

These are setting dedicated buttons used to specify measurement status 
by clicking the button of the measurement status you wish to change to.
The “Start Calibration (Verification)” and “End Calibration (Verification)” 
buttons are used to start/end calibration (verification) manually. The “Cancel 
Setting” button is used to cancel queued measurement status changes. The 
“Calibration (Verification) Method” button is used to change the calibration 
(verification) method.

Range Change 
command button

Commands a range change.
If a database-related setting change is made on the analyzer unit side, a 
message appears, disabling command issuance. This button requires user 
level B.

Help Display button Displays the Help mode of the Analyzer Operation window.
Measurement status Indicates the current measurement status.
Measurement status 
change queued

When a measurement status change has been made, this box indicates 
the currently specified measurement status until the measurement status 
changes to the specified one.

Method Indicates the current method number.

HELP !
To operate the Operation Status Display bar, user level “B” or “C” is required.

SEE ALSO
For how to change the user level, see section 3.4.
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n Chromatogram Display Section
The chromatogram display section is a part of the Analyzer Operation window that displays the 
latest chromatogram for every analysis cycle.
It displays one chromatogram if there is one detector or two chromatograms if there are two 
detectors. It also displays the temperature pattern of the programmed temperature oven or 
isothermal oven. In addition, this section displays one pressure graph for one EPC or two 
pressure graphs for two EPCs.
Because the current elapsed time is indicated by dotted lines, which timing and where the current 
location is in the analysis cycle is recognizable at a glance.

SEE ALSO
For the Chromatogram Display window, see Chapter 5.

l Window elements

F5-2-4.ai

Chromatogram Temperature Pressure

Indicates the current elapsed time in dotted lines.

l Contents of display
The scales are displayed as follows:

Scales/Item Description

Horizontal Scale The analysis cycle set for each stream is regarded as a full scale. In Manual 
mode, when you issue the measurement start command from the window, 
chromatogram display starts and continues until the measurement end 
command is issued.
During this period, each time a chromatogram exceeds the horizontal axis, 
the time scale is automatically extended and adjusted so that the entire 
chromatogram is displayed.

Vertical Scale The vertical scale is displayed in auto scale and is automatically adjusted so 
that data deflection up to that time is about 80% of the range. Auto scaling is 
independently achieved for both chromatograms and temperature.

Stream under 
Measurement

Indicates the number of the stream currently being measured.
In conditions where sample replacement is possible (calibration 
(verification) method can be done in manual only), “Replacement available” 
is displayed.

Stream to be Measured 
Next

Indicates the number of the stream scheduled to be measured next.
If the stream concerned is under preparation, a “P” indication is added.

n Timing Display Section
The timing display section is the part of the Analyzer Operation window that displays the ON/OFF 
status of the valves for each analysis cycle and the ON/OFF timing of the gate(s).
The current elapsed time is indicated by dotted lines; which timing and where the current location 
is in the analysis cycle is recognizable at a glance.
If there are two detectors, the gate ON/OFF timing is displayed on a detector basis.
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l Window elements

F5-2-5.ai

Indicates the elapsed time.

Indicates that the valves and gate(s) are ON.

Gate
(one detector)
or
Gat1/Gat2
(two detectors)

V1 to 8

l Contents of display
The following table lists the contents of the display:

Scale/Item Description
Horizontal Scale The horizontal scale is displayed in the analysis cycle set for each stream.
V1 to 8 Displays the ON/OFF status of valves 1 to 8 in bar graphs.
Gate or Gat1/Gat2 Displays the ON/OFF status of gate(s) in bar graph(s).

n Valve Display Control Section
The valve display control section displays the status of the analyzer stream-switching valve 
(current number or OFF), the ON/OFF status of valves in the analyzer, the ON/OFF status of the 
detector(s), and the temperature controller status. It also allows you to perform status change.

TIP
User level “C” is required to operate the valve display control section and the system must be in Manual mode.

l Window elements

F5-2-6.ai

Stream-switching
valve

Valves 1 to 8 Detectors Temperature
controllers
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l Contents of display
The following table lists the contents of the display:

Display Item Description
Stream Valve Indicates the stream-switching valve status by number. If all the valves are 

OFF, this section is grayed out.
V1 to 8 Indicates the ON/OFF status of valves 1 to 8.
Det1/Det2 Indicates the ON/OFF status of the detectors. When the status is in Manual 

mode, moving the mouse cursor over this section and clicking the right 
button causes the Detector Signal Display window to appear.

HEAT/PRESS/AI Displays one of the following: temperature controller status, EPC status, or 
AI value. Which value to display can be selected using the List Button box.
When the status is in Manual mode and either HEAT or PRESS is 
displayed, moving the mouse cursor over this section and clicking the left 
button causes the Temperature Control Unit Operation window or Pressure 
window to appear respectively.

SEE ALSO
For detector signals and temperature controller status display, see section 3.3.

n Data Display Section
The data display section is the part of the Analyzer Operation window that displays the elapsed 
time, peak number, peak name, and detector signal. The data updating cycle is 1 second. If there 
are two detectors, data is displayed on a detector basis.

l Window elements

F5-2-7.ai

Common data section

Detector 1
data

Detector 2
data

l Contents of display
The following table lists the contents of the display:

Display Item Description
Elapsed Time Indicates the time (second) that has elapsed from the start of analysis.

This section also shows the ratio of the elapsed time to the analysis cycle 
in %. In the Manual mode, because the time axis is automatically adjusted, 
the ratio of the elapsed time to the full scale is indicated in %. In cases of 
being prepared, this part indicates the elapsed time in minus value.

Peak Number Indicates the number of the peak currently being detected.
Peak Name Displays the name of the peak currently being detected. Moving the mouse 

cursor over the peak name causes the peak name to appear as a tool hint.
Detector Output Displays a detector signal in mV. The chromatogram displayed in the 

chromatogram display section represents the pattern of this signal
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5.2.3 Displaying Detector Status
Right clicking on the detector area of the valve display control section, or left clicking the 
temperature controller display causes a detector signal or temperature controller status to be 
displayed respectively. The updating cycle of these displays is 3 seconds.

SEE ALSO
For changing the operation of the valve display control section, see section 3.6.

n Detailed Display of Detector Signal(s)

l Display procedure
If there are two detectors, you can select one of them in the valve display control section.
(1) Move the mouse cursor over the desired detector area of the valve display control section 

and right click.
 The Detector Signal Display window appears.

 Valve display control section

 F5-2-8.ai

Detector Signal
Display window

Right clickClose command

(2) To exit the Detector Signal Display window, click on the Close command in the Control 
menu.

l Window elements (Detector Signal Display window)

 F5-2-9.ai
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l Contents of display
The following table lists the contents of the display:

Display Item Description
Type Displays one of the following detector types: TCD, FID, FID-CONV (FID 

with a meta-converter), FPD, or “none”.
Input Signal Displays a value obtained by averaging the detector’s analog signal 

sampled every 20 msec. that is then A/D converted, using a value that is set 
to the sampling rate.

Post-filtering Signal Displays the value obtained by filtering out an input signal using the value 
that has been set to the filter constant of the detector signal settings.

Standard Signal 
Deviation

Indicates the standard deviation of the past 20 input signals.

Applied Voltage Value Indicates TCD bridge voltage (TCD only).
Current Value Indicates TCD bridge current (TCD only).
Flame detection level Displays the setpoint for the flame detection level. (FID, FID-CONV, FPD)

Thermocouple Signal Displays a thermocouple signal. (FID, FID-CONV, FPD)

Flame Detection Status Displays the flame detection status (burning/burning stopped). (FID, FID-
CONV, FPD)

Converter Voltage Value Displays a converter voltage value. (FID-CONV only)

5.2.4 Temperature Control Unit Operation Window
The Temperature Control Unit Operation window displays the statuses of temperature controllers 
at every section of the analyzer. Display information differs depending on the GC1000 type. 
The updating cycle for data other than isothermal oven temperature (for GC1000S/E/E) or 
programmed temperature oven temperature (GC1000D/T/W) is 1 second.
Moreover, this window allows you to change the ON/OFF statuses of the temperature controller 
at each section.

n Detailed Display of Temperature Controllers

l Display procedure
(1)  Move the mouse cursor over the temperature controller area of the valve display control 

section and click.
 The Temperature Control Unit Operation window appears.

 Valve display control section

 F5-2-10.ai

Temperature
Control Unit

Operation window

Click

Close
command

(2) To exit the Temperature Control Unit Operation window, click on the Close command in the 
Control menu.
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l Window elements (Temperature Control Unit Operation window)

F5-2-11.ai

l Contents of display
The following table lists the contents of the display. The display items differ depending on the 
configuration of the temperature controllers.

Display Item Description

SV Displays the temperature controller setpoint.
PV Displays the temperature controller measured value (current temperature).
State/Remark Displays the temperature controller status and comment.
Programmed 
Temperature Oven*

Displays the temperature of a dual oven type programmed temperature 
oven.

Isothermal oven* Displays the temperature of a dual oven type or single oven type isothermal 
oven.

LSV 1, LSV 2 * Displays a sample valve temperature.
FPD Displays FPD detector temperature for single oven type.

*: The high limit of the set temperature differs for the explosionproof type.

5.2.5 Pressure Display Window
The Pressure Display window displays EPC statuses. The data updating cycle is 1 second.

l Display procedure
(1) Move the mouse cursor over the pressure indicator area of the valve display control section 

and click.
 The Press. Status window appears.

 Valve display control section

 F5-2-12.ai

Press. 
Status window

Click

Close
command

(2) To exit the Press. Status window, click on the Close command in the Control menu.

l Window elements (Press. Status window)

F5-2-13.ai
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l Contents of Display
The following table lists the contents of display:

Display Item Description
SV Displays the EPC setpoint.
PV Displays the measured value (current pressure) of EPC.
State/Remark Displays EPC status and comment.
Carrier 1/2 Displays carrier gas 1/2 pressure.
Combustion Hydrogen 
1/2

Displays combustion hydrogen 1/2 pressure.

Combustion Air 1/2 Displays combustion air 1/2 pressure.

5.2.6 Changing Status/Operation Mode/Measurement 
Status

The Operation Status Display bar on the Analyzer Operation window allows you to change the 
status, operation mode, and/or measurement status.

CAUTION
To change the status, operation mode, and/or measurement status, user level “B” or “C” is 
required. This is specified according to the change details.
Also, the analyzer must be in Remote mode.

n Types of Statuses and Change

l Types of statuses
There are three status types as follows, and the current status is indicated by a depressed button.

Status Button Description

Process Allows automatic operations. Also, it enables you to specify the 
measurement status.

Manual Allows manual analysis. Also, valves, detector(s), and/or 
temperature controller status can only be changed in this status.

Lab Allows lab analysis.

l Changing the status
To change the status, click the button of the status you wish to change to. The operable button(s) 
differs depending on current conditions. The operable button(s) is displayed in black; any 
status(es) not acceptable is grayed out.
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n Types of Operation Mode and Changing Procedure

l Operation mode types and current status display
There are three types of operation modes as follows:

Status Button Description

Run Runs operation.

Pause Pauses operation.

Stop Activates the queued operation status.

The condition of each button indicates the current status of the operation mode.

(Example) In the case of "Run" mode

Button Status Description
"Run" mode is running.

A request for change of "Run" mode can be made.

"Run" mode is reserved.

A request for change to "Run" mode cannot be made.

l Changing the operation mode
To change the operation mode, click the button of the operation mode you wish to change to. The 
operable button(s) differs depending on current conditions. The operable button(s) is displayed in 
black; any status(es) not acceptable is grayed out.

There is also a “Cancel Command” button . This is a command-dedicated button that cancels 
the queued operation mode.

n Types of Measurement Statuses and Changing Procedure

l Types of measurement statuses
There are four types of measurement statuses as follows:

Measurement Status Button Description
Stream Sequence Runs a stream sequence.

Stream (Continuous) Measures a specified steam continuously.

Stream (One) Measures a specified steam only once.

Calibration/Validation Enables calibration or verification.

The current condition of the measurement status is displayed in the lower half of the Operation 
Status Display bar, and each button is command dedicated.
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l Changing the measurement status
To change the measurement status, click the button of the measurement status you wish 
to change to. The operable button(s) differs depending on current conditions. The operable 
button(s) is displayed in black; any status(es) not acceptable is grayed out.

There is also a “Cancel Setting” button . This is a designation-dedicated button that cancels 
the queued measurement status change.

l Calibration (validation) methods
There are three types of calibration (validation) methods as follows:

Calibration (Validation) Method Description
Automatic Automatically conducts calibration (validation) according to the start time 

and the analyzer’s pre-set time period.
Semi-automatic Click the Calibration (Validation) button, specify the execution number, 

and touch the Run button to perform calibration (validation).
Manual After clicking the Calibration (Validation) button, make preparations, then 

using the Start Calibration (Validation) button  and the End Calibration 

(Validation) button  conduct calibration (validation) manually.

Selection of a calibration (validation) method is made as follows:
(1) Click the Calibration (Validation) Method button .
 The Calibration (Validation) Method dialog box appears.

 F5--2-14.ai

(2) Check the radio button of the calibration (validation) method you wish to specify, then click 
the Execute button. A change confirmation dialog box appears.

 F5-2-15.ai

(3) Click the Yes button.
(4) A message appears informing you that data transmission is complete.

 F5-2-16.ai

(5) Click the OK button. This completes the selection of the calibration (validation) method.
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5.2.7 Changing Valve/Detector/Temperature Controller Status
Moving the mouse cursor over Stream Valve, V1-8, Det/Det2, or to an area inside the 
Temperature Control Unit Operation window and clicking the left button allows you to change the 
ON/OFF status of the valves, detectors, and/or temperature controllers.

CAUTION
Only level-C users can change the ON/OFF status of the valves, detectors, and/or temperature 
controllers. The status also needs to be in Manual.
Moreover, the analyzer must be in Remote mode or it will not be possible to make changes.

n Changing a Stream-switching Valve
(1) Click on the stream-switching valve indication.
 The Stream Switching dialog box appears.

 

Click

F5-2-17.ai

(2) To turn ON the stream valve, select the ON radio button and choose the desired stream 
valve’s number; to turn it OFF, select the OFF radio button and click the Execute button.

(3) The Stream Valve indication changes to the specified stream valve status.

n ON/OFF Operation of Valves 1 to 8
(1) Click on one of the Valve V1 to V8 indications.
 A dialog box appears confirming that you want to change the ON/OFF setting.
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Click

F5-2-18.ai

(2) Click the Yes button
 The valve status changes to ON or OFF.

n ON/OFF Operation of Detectors
(1) Click on one of the detector indications.
 A dialog box appears confirming that you want to change the ON/OFF setting.

 

Click

F5-2-19.ai

(2) Click the Yes button.
 The detector status changes to ON or OFF.

n ON/OFF Operation of Temperature Controllers
(1) Click on the temperature controller indication.
 The Temperature Control Unit Operation window appears.

 
Click

F5-2-20.ai

(2) Click the entry corresponding to the temperature controller you want to change in the State/
Remark column.
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 A dialog box appears confirming that you want to change the ON/OFF setting.

 

F5-2-21.ai

(3) Click the Yes button
 The relevant State/Remark entry changes to ON or OFF.

5.2.8 Changing Range
The range of each peak can be changed using the range table that has been set to the analyzer.
This section describes how to change the range.

CAUTION
Only level B or C users can change the range.
The analyzer must also be in Remote mode.

n Changing Range
(1) Click the Range Change Command button .
(2) The Range Change dialog box appears.

 F5-2-22.ai

 Specifying the stream number, peak number, and range number you wish to change causes 
the current information of each item to appear.

(3) Click the Execute button. This causes a confirmation message to appear.
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 F5-2-23.ai

(4) Click the Yes button.
(5) A message box appears informing you of the completion of data transmission.

 F5-2-24.ai

(6) Click the OK button. This completes the range change.

5.2.9 Changing Valve and Peak Information
The ON/OFF timing of valves that has been set to the analyzer can be changed. Individual 
information (peak name, gate time, etc.) set for each peak can also be changed.
This section describes how to change these items.

CAUTION
Only level-C users can change the valve and/or peak information.
The analyzer must also be in Remote mode.

n Changing Valve ON/OFF Setting
(1) Click on the Valve command in the Set menu.
(2) The Valve ON/OFF Setting dialog box appears.

 
F5-2-25.ai
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 Specifying the valve number of the valve whose ON/OFF setting you wish to change causes 
the current information to appear.

(3) Change the valve’s set ON/OFF time and click the Send button. Then, a confirmation 
message appears.

 F5-2-26.ai

(4) Click the Yes button.
(5) A message box informing you of the completion of data transmission appears.

 F5-2-27.ai

(6) Click the OK button. This completes the valve ON/OFF setting change.

n Changing Individual Peak Setting
(1) Click on the Peak command in the Set menu and then click on the command corresponding 

to the information (such as Peak Name or Gate Time) you wish to change.
(2) The relevant dialog box appears. (The following shows an example of the Set Peak Name 

dialog box.)

 F5-2-28.ai

 Specifying the stream number and peak number you wish to change causes the current 
information to appear.

(3) Change the peak name and click the Send button. A confirmation message appears.
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 F5-2-29.ai

(4) Click the Yes button.
(5) A message box appears informing you of the completion of data transmission.

 F5-2-30.ai

(6) Click the OK button. This completes the peak name change.

5.3 Chromatogram Window
The Chromatogram window displays the analyzer’s chromatograms in detail. You can load 
chromatograms that have been saved to a file into ASET for display in this window in addition to 
the latest chromatograms.
This section describes how to display and exit the Chromatogram window, window configuration, 
scale change and partial enlargement, and the saving and loading of chromatograms.

Exit commandChromatogram
command

Related windows

F5--3-1.ai

Chromatogram 
window

Overview
window

5.3.1 Displaying and Exiting the Chromatogram Window
This section describes how to display and exit the Chromatogram window.

n Display
There are two ways to display the Chromatogram window from the Analyzer Operation window: 
a method of displaying it from the menu, and that of displaying it from the chromatogram display 
section.
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CAUTION
Only one Chromatogram window can be displayed at a time.

l Operation procedure
Click on the Chromatogram command in the Window menu or double click on the chromatogram 
display section in the Analyzer Operation window.
The Chromatogram window appears.

 

Toolbar
Legend display

Enlarge/Reduce button
Overall display area

Enlargement Display area

Mouse position indication

F5-3-2.ai

l Window size and position upon opening
The window display position and window size upon opening the Chromatogram window are the 
same as those that had been in effect when it was last closed.

l Resizing the window size
Dragging a frame border of the Chromatogram window using the mouse allows you to enlarge or 
reduce the window size. Note that it is not possible to reduce it smaller than 647 × 448 mm.

n Exiting
l Operation procedure

Click on the Exit command in the File menu with the Chromatogram window activated.
The Chromatogram window closes.

5.3.2	 Window	Configuration
The Chromatogram window displays chromatograms that are sent from the analyzer in detail.
It allows display of the latest chromatogram, previous chromatograms, chromatograms stored in 
the analyzer server, and/or chromatograms that have been saved to a file.
It can also display the peak information, gate information, temperature data, and pressure data 
corresponding to each chromatogram.
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In addition, it allows you to save the currently displayed chromatogram in a file.
Dragging a frame border of the Chromatogram window using the mouse allows you to enlarge 
or reduce the window size. Note that the window cannot be reduced to a size smaller than 647 × 
448 mm.
The window display position and window size upon opening the Chromatogram window are the 
same as those that had been in effect when it was last closed.

n Toolbar
The toolbar has had frequently used commands registered as buttons.

l Window elements
The toolbar consists of the following buttons:

F5-3-3.ai

Save
Chromatogram
button

Enlarge
button

Reduce
button Partial

Enlargement
button

Auto Scale button
Overall Display button

Set Pen
button

Set Mark
button Temperature

Display
button

Snap 1 Mouse Position Display button

Snap 2 Help
button

n Enlargement Display Area
This area of the Chromatogram window displays chromatogram and temperature.

l Window elements

F5-3-4.ai

X-axis scale Temperature scale

The vertical scale can be switched from 
temperature to pressure by double clicking.

Pressure scale

Scroll barsY-axis scale Grid

l Contents of display
Item Function

X-axis scale Represents elapsed time (second).
Y-axis scale Represents voltage value (mV).
Temperature scale Represents temperature (°C).
Pressure scale Represents pressure (kPa).
Scroll bar Moves chromatogram up and down or sideways to show hidden portions.
Grid Grid-like auxiliary lines linked with the X-axis and Y-axis scale graduations.

The grid can be made visible or invisible by setting its ON/OFF status using 
the Grid command in the Option menu.
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5.3.3 Displaying Chromatogram and Temperature Data
The Chromatogram window can display eight chromatograms and two temperature data.

n Displaying Chromatograms
The following chromatograms can be displayed:

Chromatogram Type Description
Latest chromatogram This is the chromatogram currently being measured, which is updated per 

1 second. Latest Chromatogram 1 and Latest Chromatogram 2 represent 
the most recent chromatograms of detectors 1 and 2. The sampling rate is 
80 ms.

Previous chromatogram This is the chromatogram measured previously, which is updated 
periodically.
Previous Chromatogram 1 and Previous Chromatogram 2 represent the 
previous chromatograms of detectors 1 and 2. The sampling rate is 80 ms.

File chromatogram This is chromatogram that has been saved to a file.
Differential 
chromatogram

This is the result of differences determined by comparing two 
chromatograms that are displayed. Up to two differential chromatograms 
can be displayed.

History chromatogram This is a previous chromatogram that has been stored in the analyzer 
server.
The sampling rate is the same as that of the analyzer. History 
chromatograms for GC1000 Mark II are opened from the server by 
specifying the analysis start date and time. History Chromatogram 1 and 
History Chromatogram 2 represent history chromatograms of detectors 
1 and 2 respectively. History chromatograms allows acquisition of 
temperature data and pressure data (the sampling rate is 1 s).

When displaying two differential chromatograms, specify two different chromatograms such as 
“Differential Chromatogram 1” and “Differential Chromatogram 2.” You cannot specify the same 
chromatograms, for example, “Differential Chromatogram 1” twice.

l For the latest chromatograms and previous chromatograms
(1) Click on the Set Pen command in the Graph menu or click the  button on the toolbar.
 The Set Pen dialog box appears.

 F5-3-5.ai

(2) Choose one of Latest Chromatogram 1, Latest Chromatogram 2, Previous Chromatogram 
1, or Previous Chromatogram 2 from the combo box corresponding to the display color used 
for display, and click the OK button.

 The specified chromatogram appears.
 The legend display area shows the name of the specified chromatogram.
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l	 For	file	chromatograms
(1) Click on the Set Pen command in the Graph menu or click the  button on the toolbar.
 The Set Pen dialog box appears.
(2) Choose File Chromatogram from the combo box corresponding to the display color used for 

display.
 A dialog box for specifying the file to display appears.
 The extensions of chromatogram files are .chr.

 F5-3-6.ai

(3) Specify the file to display and click the OK button.
 This returns you to the dialog box in step (1).
(4) Click the OK button.
 The chromatogram in the specified file appears.
 The legend display area shows the file name.

l For differential chromatograms
(1) Click on the Set Pen command in the Graph menu or click the  button on the toolbar.
 The Set Pen dialog box appears.
(2) Choose Differential Chromatogram 1 or Differential Chromatogram 2 from the combo box 

corresponding to the display color used for display.
 A dialog box for specifying two chromatograms from which differences are to be obtained 

appears.

 F5-3-7.ai

(3) Choose graphs (selective graph 1, selective graph 2) from which differences are to be 
obtained from the list box, and then click the OK button.

 This returns you to the dialog box in step (1).
 The list box displays the names of the chromatograms specified for display; however, 

they are not shown as “differential chromatogram 1” and “differential chromatogram 2”. 
Differences are obtained from “selected graph 1” - “selected graph 2.”
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(4) Click the OK button.
 The specified differential chromatogram is displayed.
 The legend display area shows the graph numbers of chromatograms from which 

differences are obtained in the form of, for example, “1 - 2”.

TIP
If differences are obtained from two chromatograms with different analysis cycles, the differential chromatogram 
is displayed according to the shorter analysis cycle.

Even if the latest chromatograms or previous chromatograms are specified for the targets for obtaining 
differences, the obtained differential chromatogram cannot be updated at periodic intervals. Differences are 
obtained from the chromatograms at the instant the OK button is clicked in step (3).

l To erase the chromatogram being displayed
(1) Click on the Set Pen command in the Graph menu or click the  button on the toolbar.
 The Set Pen dialog box appears.
(2) Choose “None” from the combo box corresponding to the display color to be erased, and 

click the OK button.
 The specified chromatogram will be erased.

l For history chromatograms
(1) Click on the Set Pen command in the Graph menu or click the  button on the toolbar.
 The Set Pen dialog box appears.
(2) Choose History Chromatogram 1 or History Chromatogram 2 from the combo box 

corresponding to the display color used for display, and click the OK button.
 A dialog box for specifying the time frame in which the history chromatogram to display is 

included appears.

 F5-3-8.ai
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(3) Choose the time frame in which the history chromatogram to display is included and click 
the OK button.

 A list of all chromatograms contained in the selected time frame appears.

 F5-3-9.ai

(4) Choose the time frame in which the history chromatogram to display is included and click 
the OK button.

 A list of all chromatograms contained in the selected time frame appears.

 F5-3-10.ai

(5) Choose the chromatogram to be displayed and click the OK button.
 This returns you to the dialog box in step (1).
(6) Click the OK button. The specified chromatogram is displayed.
 The legend display area shows the following detector number and measurement date and 

time.

  

08/10 16:09 H1

H1: history chromatogram 1

H2: history chromatogram 2Month Day  Hour  Minute

TIP
If a time earlier than 24 hours prior is specified in step (3), processing may take some time, depending on the 
amount of data.
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n Setting Marks

l Types of mark information
You can set whether to display the following mark information for each chromatogram.

Mark Information Description

Peak No. Displays a peak number at the peak location in the chromatogram. The 
Peak Display Position command in the Option menu allows you to specify 
whether to display the number above or below the chromatogram.

Peak ON/OFF Indicates the start and end positions of a peak as follows:
Start position: A long line facing down
End position: A long line facing up

Gate ON/OFF Indicates the gate ON and OFF positions as follows:
ON position: A short line facing down
OFF position: A short line facing up

All mark information is indicated in the display color of the target chromatogram.

F5-3-11.ai

Example of Gate Peak Display

Even though mark information has been set for display, its actual display is as shown below, 
depending on the chromatogram type:

Peak No. Peak ON/OFF Gate ON/OFF
Latest chromatogram A A A

Previous chromatogram A A A

File chromatogram B B B

History chromatogram C A A

Differential chromatogram C C C

Legend A: displayable, C: not displayed, B: dependent on whether information exists in a file.

l Operation procedure
(1) Click on the Set Mark command in the Graph menu or click the  button on the toolbar.
 The Set Mark dialog box appears.
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 F5-3-12.ai

(2) Set the provision of mark information display for each chromatogram as follows:
 Checked:  Displayed
 Unchecked: Not displayed
(3) Click the OK button.
 The set mark information is displayed.

l Setting peak number position
(1) Click on the Peak Display Position command in the Option menu.
 The submenus of the Peak Display Position command appear.

 

Indicates the current setting.

F5-3-13.ai

(2) Click the Above Graph or Below Graph.
 This causes the peak display position to be defined.

n Displaying Temperature/Pressure Data
Temperature data corresponding to the specified chromatogram can be displayed in the 
Enlargement Display area. Temperature data is displayed by dotted lines in the same color as 
the target chromatogram. Pressure graph 1 is displayed by dashed lines in the same color as the 
corresponding chromatogram. Pressure graph 2 is displayed by alternate long and short dashed 
lines in the same color as the corresponding chromatogram. Up to two pressure graphs can be 
displayed.

TIP
The types of chromatograms that can be displayed together with temperature data are the latest chromatograms, 
previous chromatograms, and file chromatograms containing either the latest or previous chromatograms.

If a chromatogram displaying temperature data is erased, the corresponding temperature data is also erased 
automatically.
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l Operation procedure
(1) Click on the Temperature/Pressure Display command in the Graph menu or click the  

button on the toolbar.
 The Temperature Display dialog box appears.

 F5-3-14.ai

(2) Choose the chromatogram corresponding to the temperature data to be displayed, from the 
combo box.

 The combo box contains the latest chromatograms being displayed, previous 
chromatograms, and file chromatograms.

 To erase temperature data display, choose “None” in the combo box.
(3) Select the Temperature checkbox.
(4) Click the OK button.
 The temperature data corresponding to the specified chromatogram is displayed. If “None” 

is selected the temperature data will be erased.

5.3.4 Changing Scales and Scrolling Window
The chromatogram scales consist of three items: X axis (second), Y axis (mV), and temperature 
(°C). The scales can be adjusted to any size using the menus or the Enlarge/Reduce buttons.

n Cancelling and Setting Auto-scale
In the Chromatogram window, the scales are automatically adjusted and set so that the entire 
chromatogram can always be displayed. (This function is called “auto-scale”.)

TIP
If you change a scale, the auto-scale function will automatically be deactivated.

The following describes how to change the ON/OFF status of the auto-scale function.

l Operation procedure
(1) To cancel the auto-scale function, click on the Auto-scale command in the Scale menu or 

click the Auto-scale button on the toolbar.
 This deactivates Auto-scale, causing the checkmark to be removed from next to the Auto-

scale command and the Auto-scale button to be released.
(2) To set the auto-scale function, click on the Auto-scale command in the Scale menu or click 

the Auto-scale button on the toolbar again.
 This activates Auto-scale, causing the checkmark to be restored next to the Auto-scale 

command and the Auto-scale button to be depressed.
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n Changing Scale

l Enlarge/Reduce buttons
The scales change as shown below if the Enlarge/Reduce buttons are clicked.

•  : Reduce the scale.

•  : Enlarge the scale.

Scales Scale Change

X axis (second) 0.2→0.5→1→2→5→10→20→50→100→200→500→┐
50000←20000←10000←5000←2000←1000←────┘

Y axis (mV) 0.1→0.2→0.5→1→2→5→10→20→50→100→200→500→1000

Temperature (°C) 10→50→100→200

The chromatograms and temperature data use the scales in common.

n Scrolling through Window
If part of a chromatogram cannot be displayed in the window due to enlargement, etc., you can 
scroll through the window to view hidden portions.

l Method 1
Click the , , , and/or  buttons on the scroll bars.
The chromatogram moves one division in the direction of the arrow.

l Method 2
Drag the  button on a scroll bar.
The chromatogram moves proportionately in the direction the button is dragged.

n Making Grid Visible/Invisible in the Chromatogram Window
You can select whether to make the grid (grid lines) visible/invisible in the Enlargement Display 
area on the Chromatogram window.
The grid is displayed if you choose Visible or is hidden if you choose Erase.

 Note:
By default, “Visible” is selected for the grid.

5.3.5 Enlarging/Reducing and Temporarily Saving 
Chromatograms

The Enlargement Display area can enlarge part of a chromatogram to display that area in detail. 
Saving an enlarged portion temporarily allows you to recall and view it after updating the window.
This section describes how to do this using the buttons on the toolbar. The same result can be 
achieved using the corresponding commands in the menu.
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n Enlargement

l Operation procedure
Click on the Zoom in button (  ) on the toolbar.
The scales for the x and y axes are enlarged by one division respectively based on the center of 
the Enlargement Display area.

• You can also achieve the same results using the Zoom in command in the Scale menu.

n Reduction

l Operation procedure
Click on the Zoom out button (  ) on the toolbar.
The scales for the x and y axes are reduced by one division respectively based on the center of 
the Enlargement Display area.

• You can also achieve the same results using the Zoom out command in the Scale menu.

n Partial Enlargement

l Operation procedure
(1) Click on the Partial Zoom button (  ) on the toolbar.
(2) Drag the start and end points of the area you wish to enlarge on the Overall Display area or 

the Enlargement Display area.

 

Start points

End points
F5-3-15.ai
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 The specified area is enlarged and fills the window.

 F5-3-16.ai

• Selecting the Partial Zoom in button automatically deactivates the auto-scale function.

• You can also achieve the same results using the Partial Enlargement command in the 
[Scale] menu.

• The enlargement display range specified using the partial enlargement feature and the 
range actually displayed in the Enlargement Display area may differ from each other due to 
limitations of the program.

n Temporary Saving (Snapshot)
Temporarily saving the enlarged window

l Operation procedure
(1) Click on the Snap 1 button (  ) on the toolbar.
 The Snap 1 button lights up in red, and the chromatogram being display is temporarily 

saved to memory.
(2) If you want to see the detailed display again after returning to the original display, click the 

Snap 1 button with its red lamp lit.
 The chromatogram saved in Snap 1 is redisplayed.
(3) To erase the temporarily saved chromatogram, click on the Clear command in the Option 

menu.
 The chromatogram is erased and the red lamp of the Snap 1 button goes off.

• Two types of chromatograms can temporarily be saved in Snap 1 and Snap 2.

• You can also achieve the same result using the Snapshot command in the Option menu.

• Snap-1 and Snap-2 data are automatically erased with every analysis cycle.

n Overall display

l Operation procedure
Click on the Full Display button (  ) on the toolbar.
The position and scales of the chromatogram are recalculated, and you are returned to the 
original window.

• You can also achieve the same results using the Overall Display command in the Scale 
menu.
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5.3.6 Saving Chromatogram
The Chromatogram window allows you to save a currently displayed chromatogram in a file.

n Saving

l Saving chromatograms
In saving chromatograms, the currently displayed chromatogram is saved to the hard disk on the 
PC.
(1) Click on the Save Chromatogram button (  ) on the toolbar. A dialog box for selecting the 

chromatogram to save appears.

 F5-3-17.ai

(2) Select the chromatogram to save and click the OK button.

 F5-3-18.ai

(3) Enter a file name in front of the file extension “.chr” in the File Name field in the displayed 
dialog box, and click the OK button. The selected chromatogram data is saved to the 
specified file.

5.3.7 The off-line chromatogram display window
When double-clicking the chromatogram icon in the icon folder of the Engineering Terminal on 
the desk top, the chromatogram display window only can be started. This function is for indicating 
the chromatogram at off-line.
The chromatograms to be indicated are File chromatogram and Differential chromatogram.

CAUTION
• In case ASET is operated, this function can not be used.

• The multiple chromatogram displays can not be started.
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5.4 Analysis Results Windows
The analysis results windows display data that has been analyzed by the analyzer. There are ten 
windows: five analysis results acquisition windows in which the analysis results are accumulated, 
and five file reference windows in which reference is made by opening related files. A graph 
window can also be merged into windows that display histories.
This chapter describes how to display and exit the analysis results windows, the types and 
configuration of the windows, switching of window display, data saving and reading, data 
modification and re-saving, conversion of history data to a graph, and resetting history data.

Related windows

Latest Analysis 
Results window

Concentration Analysis 
History window

Retention Time 
History window

Laboratory Analysis 
Results window

Calibration coefficient 
History window

File Analysis Results window

File Concentration Analysis 
History window

File Retention Time History 
window

File Laboratory Analysis 
Results window

File Calibration coefficient
History window History windows 

with a graph window

Analysis results
acquisition windows

File reference
windows

<Analysis results window> *1

History windows

Analysis Results command
Analysis Results Window Display command

Exit command
in File menu

Plot Graph button

Create command
in Graph menu *2

F5-4-1.ai

Overview window

*1: Each window is switched 
using the Window menu.

*2: The Graph menu is available 
on the history windows.

5.4.1 Displaying and Exiting the Analysis Results Windows
When you open the analysis results window, the Latest Analysis Results window appears.

CAUTION
Only one analysis results window can be displayed at a time.
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n Displaying (the Latest Analysis Results Window)
Specify an analyzer ID in the Overview window, and then command the analysis results window 
to be displayed. When an analysis results window is opened from the Overview window, the 
Latest Analysis Results window appears.

SEE ALSO
Section 3.6, “Selecting Analyzer” for specifying an analyzer ID

l Operation procedure
Click on the Analysis Results command in the Window menu.

• This operation can also be conducted by clicking the Analysis Results Window Display 
button (  ) on the toolbar.

 The Latest Analysis Results window is then displayed.

TIP
If the analysis results windows are reduced to icons and registered for the ASET group, they can be opened 
separately. However, it should be noted that the displayable analysis results when a registered analysis results 
window is opened without activating the Overview window are limited to the range of data stored in the PC.

F5-4-2.ai

n Exiting

l Operation procedure
Click on the Exit command in the File menu.
The Analysis Results window is then closed.
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5.4.2	 Window	Types	and	Configuration
The analysis results windows consist of analysis results acquisition windows (Latest Analysis 
Results, Concentration Analysis History, Retention Time History, Laboratory Analysis Results 
and Calibration coefficient History) and file reference windows (File Analysis Results, File 
Concentration Analysis History, File Retention Time History, File Laboratory Analysis Results and 
File Calibration coefficient History).
This section outlines the configuration and display contents of each of these windows.

n Latest Analysis Results Window
The Latest Analysis Results window displays the latest analysis results that have been obtained 
in Process mode by the analyzer, focusing on the stream for which analysis was made. The latest 
analysis results are updated each time analysis by the analyzer is complete. If you wish to retain 
current data, save the window display so that you can refer to it freely later.

SEE ALSO
• Display contents below for display data

l	 	Window	configuration
The following shows the configuration of the Latest Analysis Results window.

F5-4-3.ai

The remaining portions can be brought into view by using the scroll bar.

CAUTION
When an operation pattern or peak value setting is changed while an analysis results window is 
being displayed:
(First close the analysis results window by executing the Exit command in the File menu, and 
exit the Engineering Terminals. Then restart the Engineering Terminals and re-open the analysis 
results window. Continuing operations without restarting all the Engineering Terminals may result 
in incorrect data display.
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l Display contents
The following lists the display contents for each item.

Item Display Contents

Analysis Start Time Displays the date and time at which analysis of display data was started.
# Indicates the absolute numbers of peaks (serial numbers for all peaks of all 

tasks): 1 to 255.
Stream# - Peak# - Peak 
Name

Indicates the peaks of a stream for which the latest analysis has been made, in 
the ascending order of peak numbers (order of assignment).
A stream number, peak number, and peak name are connected and indicated in 
this order using “-”, and the concentration unit (%, ppm, or no unit) of that peak is 
indicated in parentheses at the end.

Concentration Indicates concentration for each peak (with the unit indicated after the peak 
name).

Retention Time Indicates Retention time (second) for each peak.
Det. # Indicates detector number (1 or 2) for each peak.
Peak
Peak start/Retention/
Peak end

Indicates peak process start time/Retention time/end time (second) for each 
peak.

Gate
Gate start/Gate end

Indicates gate start time/end time (second) for each peak.

Pursuit Indicates the peak pursuing status for each peak as “standard”, “pursuit”, or 
“none”.

Peak Level
Start/Height/End

Displays the peak start level/top level/end level (mV) for each peak.

Area Indicates the integral value of the peak level (mV second) for each peak.
Shape Indicates the peak data process status in two-digit letters for each peak. It 

displays “P” for tangent correction re-setting or “H” for the perpendicular method.
Half-value Width Indicates a half-value width (second) for each peak.
Tailing Constant Indicates a tailing constant for each peak.
Variation Coefficient Indicates a concentration variation coefficient for each peak.
Method Indicates a concentration computation method for each peak, selecting 

the applicable concentration computation method from “corrected area,” 
“calibration,” “external third,” “external linear,” “indirect method.”
(If no applicable method is found, “????????” is indicated.)

* Note: If commas (,) are used in stream names or peak names, the features of the analysis results windows may not function properly.

n Concentration Analysis History Window
The Concentration Analysis History window is provided to observe temporal changes in 
concentration analysis data analyzed in the Process mode by the analyzer up to the current 
instant. It can recall data for 250 instances in a maximum of one year that has been stored in the 
analyzer server.
It displays all the peaks, each of which has been assigned a number upon the analysis results 
window being opened, and columns in which no peak concentration was measured at the time 
concerned are left blank.
Portions of data hidden from view in the window can be seen by using the scroll bar.
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l	 Window	configuration
The following shows the configuration of the Concentration Analysis History window.

F5-4-4.ai

l Display contents
The following lists the display contents for each item.

Item Display Contents

Analysis Start Time Displays the date and time at which analysis of the display data was started
# Indicates the absolute numbers of peaks (serial numbers for all peaks of all 

tasks): 1 to 255.
Stream# - Peak# - Peak 
Name

Indicates peaks of a stream for which the latest analysis has been made, in an 
ascending order of stream numbers and of peak numbers (order of assignment).
A stream number, peak number, and peak name are connected and indicated in 
this order using “-”, and the concentration unit (%, ppm, or no unit) of that peak is 
indicated in parentheses at the end.

Date/Time Indicates the date (year/month/day) and time (hour: minute) at which analysis 
was started, for each analysis cycle (250 times maximum). If time data exceeds 
250, the oldest data is discarded, allowing the entry of new data.

Concentration Indicates concentration for each peak (with the unit indicated after the peak 
name).

*Note: If commas (,) are used in stream names or peak names, the features of the analysis results windows may not function properly.

n Retention Time History Window
The Retention Time History window is intended to observe temporal changes in Retention-time 
data analyzed in the Process mode by the analyzer up to the current instant. It can recall data for 
a maximum of one year or that of 250 instances that has been stored in the analyzer server.
It displays all peaks, each of which has been assigned a number upon the analysis results 
window being opened, and columns in which no peak concentration was measured at the time 
concerned are left blank.
Portions of data hidden from view in the window can be seen using the scroll bar.
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l	 Window	configuration
The following shows the configuration of the Retention Time History window.

F5-4-5.ai

l Display contents
The following lists the display contents for each item.

Item Display Contents

# Indicates the absolute numbers of peaks (serial numbers for all peaks of all 
tasks): 1 to 255.

Stream# - Peak# - Peak 
Name

Indicates peaks of a stream for which the latest analysis has been made, in an 
ascending order of stream numbers and of peak numbers (order of assignment).
A stream number, peak number, and peak name are connected and indicated in 
this order using “-”, and the concentration unit (%, ppm, or no unit) of that peak is 
indicated in parentheses at the end.

Date/Time Indicates the date (year/month/day) and time (hour: minute) at which analysis 
was started, for each analysis cycle (250 times maximum). If time data exceeds 
250, the oldest data is discarded, allowing the entry of new data.

Retention Time Indicates Retention time (second) for each peak.

n Laboratory Analysis Results Window
The Laboratory Analysis Results window displays the latest laboratory analysis results obtained 
in the Lab (laboratory) mode by the analyzer in the order in which the peaks have been detected.
The laboratory analysis results are updated each time analysis by the analyzer is finished. If you 
wish to retain current data, save the window display so that you can freely refer to it later.

SEE ALSO
• Display contents below for display data
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l	 Window	configuration
The following shows the configuration of the Laboratory Analysis Results window.

F5-4-6.ai

Portions of data hidden from view in the window can be seen using the scroll bar.

l Display contents
The following lists the display contents for each item.

Item Display Contents

Analysis Start Time Displays the date and time at which analysis of the display data was started.
# Indicates the numbers of the order in which the peaks have been detected: 1 to 

255.
Concentration Indicates concentration for each peak (with the unit indicated after the peak 

name).
Retention Time Indicates Retention time (second) for each peak.
Det. # Indicates detector number (1 or 2) for each peak.
Peak
Peak start/ Retention/
Peak end

Indicates peak process start time/Retention time/end time (second) for each 
peak.

Peak Level
Start/Height/End

Displays the peak start level/top level/end level (mV) for each peak.

Area Indicates the integral value of the peak level (mV second) for each peak.
Shape Indicates the peak data process status in two-digit letters for each peak. It 

displays “P” for tangent correction re-setting or “H” for the perpendicular method.
Half-value Width Indicates a half-value width (second) for each peak.
Tailing Constant Indicates a tailing constant for each peak.

n	 Calibration	Coefficient	History	Window
The Calibration Coefficient History window is intended to reference temporal changes in 
calibration coefficient data analyzed by the analyzer up to the current instant. It can recall past 
data stored in the analyzer server at any time using the Open History command in the File menu. 
Moreover, you can select past calibration coefficient data that the analyzer server has and 
display it from the time concerned.
A maximum of 250 instances of calibration coefficient data that has been acquired up to 
the current instant can be displayed at once as to all streams. (Columns in which no peak 
concentration was measured at the time concerned are left blank).
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 CAUTION
If peak configuration or the total number of peak number assignments is modified while the 
analysis results window is activated, re-establish individual connection with the analyzer to re-
acquire the database from the analyzer. Continuing to perform operations without re-establishing 
individual connection with the analyzer may cause added or modified data to be improperly 
displayed in the window.

• Data in the window can be converted to a graph using the Create command in the Graph 
menu. (Only calibration coefficient data can be turned into a graph; no standard area data 
can be made into a graph.)

l	 Window	configuration
The following shows the configuration of the Calibration Coefficient History window.

F5-4-7.ai

l Display contents
The following lists the display contents for each item.

Item Display Contents

# Indicates the absolute numbers of peaks (serial numbers for all peaks of all 
tasks): 1 to 255.

Stream # - Peak # 
- Peak Name

Indicates all peaks that have been assigned numbers in the analyzer, in an 
ascending order of stream numbers and of peak numbers (order of assignment).
A stream number, peak number, and peak name are connected and indicated in 
this order using “-”, and the concentration unit (%, ppm, or no unit) of that peak is 
indicated in parentheses at the end.

Date/Time Indicates the date (year/month/day) and time (hour:minute) at which analysis 
was started, for each analysis cycle (250 times maximum).

Calibration Coefficient Indicates the calibration coefficient for each peak in the upper part of the Data 
Display area.

Standard Area Indicates the standard area for each peak in the lower part of the Data Display 
area.
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n File Analysis Results Window
The File Analysis Results window is a window in which data of the Latest Analysis Results 
window that has been saved to a file is recalled for reference. It also allows you to select and 
display the past analysis results stored in the analyzer server.
The opened file name is indicated in the title bar (see the window classification and window title 
display).
The contents displayed in the window are identical to those of the Latest Analysis Results 
window.

SEE ALSO
• Latest Analysis Results Window for the display contents

n File Concentration Analysis History Window
The File Concentration Analysis History window is a window in which data of the Concentration 
Analysis History window that has been saved to a file is recalled for reference. It also allows you 
to select and display the past analysis results stored in the analyzer server.
The opened file name is indicated in the title bar (see the window classification and window title 
display).
The contents displayed in the window are identical to those of the Concentration Analysis History 
window.

SEE ALSO
• Concentration Analysis History Window for the display contents

n File Retention Time History Window
The File Retention Time History window is a window in which data of the Retention Time History 
window that has been saved to a file is recalled for reference. It also allows you to select and 
display the past analysis results stored in the analyzer server.
The opened file name is indicated in the title bar (see the window classification and window title 
display).
The contents displayed in the window are identical to those of the Retention Time History 
window.

SEE ALSO
• Retention Time History Window for the display contents

n File Laboratory Analysis Results Window
The File Laboratory Analysis Results window is a window in which data of the Laboratory 
Analysis Results window that has been saved to a file is recalled for reference. (You cannot recall 
other analysis results acquisition windows.)
The contents displayed in the window are identical to those of the Laboratory Analysis Results 
window.

SEE ALSO
• Laboratory Analysis Results Window for the display contents
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n	 File	Calibration	Coefficient	History	Window
The File Calibration Coefficient History window is a window in which data of the Calibration 
Coefficient History window that has been saved to a file is recalled for reference. (You cannot 
recall other analysis results acquisition windows.)
The contents displayed in the window are identical to those of the Calibration Coefficient History 
window.

SEE ALSO
• Calibration Coefficient History Window for the display contents

5.4.3 Switching Window Display
In the analysis results window, only one window can be displayed at a time. If you wish to 
display another window, switch the current window to the desired one. Note that only a graph 
window that has been produced in a history window (Concentration Analysis History, Calibration 
coefficient History, Retention Time History, File Concentration Analysis History, or File Retention 
Time History or File Calibration coefficient History) can be displayed simultaneously with the 
history window, or the data source of the graph window.

TIP
Display of a graph window

• A graph window, produced by executing the Create command in the Graph menu while a history window is 
being displayed, is displayed concurrently with the history window, or the data source of the graph window. 
If the history window is switched to another, the graph window that was displayed in the same frame will 
also be hidden accordingly. However, when the history window concerned is re-displayed, the graph 
window is also brought back to display.

n Window Menu
The Window menu is used to switch to a window to display. Choosing the window name you wish 
to display in this menu allows that window to appear.
Note that the currently displayed window(s) has a checkmark ( ) added to the front of its name 
in the menu.

5.4.4 Saving and Reading Data
Data of the analysis results acquisition windows (Latest Analysis Results, Concentration Analysis 
History, Retention Time History, Laboratory Analysis Results and Calibration coefficient History) 
are updated each time an analysis is completed. If these data are saved to a file, data up to when 
it was saved can be freely referred to later by recalling it in the relevant file reference window (File 
Analysis Results, File Concentration Analysis History, File Retention Time History, File Laboratory 
Analysis Results or File Calibration coefficient History).
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n Saving (an Analysis Result Acquisition Window)

l Operation procedure
(1) Display an analysis results acquisition window that you wish to save and click the Save 

command in the File menu.
• This operation can also be conducted by clicking the  button on the toolbar.

 A dialog box for entering the storage destination appears.

 F5-4-8.ai

(2) Select the drive name and directory name, enter the file name in front of the extension, and 
then click the OK button.

 The data in the window will be written to and saved to the file.

TIP
Extension

• An extension affixed to a file name when it is saved is classified according to the window type as shown 
below. The window types can be identified by these extensions.

  Latest analysis results: .ana
  Concentration analysis history: .cnc
  Retention time history: .rtm
  Laboratory analysis results: .lab
  Calibration coefficient History: .cef

Saving format
• A file to be saved is in the text format (separated by commas (,)). Files in this format can be read by general 

applications as well as being read in a file reference window within the analysis results windows.
• Saved files cannot be displayed. If you wish to reference a saved file, navigate to the relevant file reference 

window and then read it.

n Reading (Opening History Data)
In the Concentration Analysis History window, Retention Time History window or Calibration 
coefficient History window, you can read and display history data for 250 instrances in a 
maximum of one past year that has been stored in the analyzer server.

CAUTION
History data is shared among the Concentration Analysis History window, the Retention Time 
History window and Calibration coefficient History window; if history data is read in either window, 
the data contents in the other window also change accordingly.
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l Operation procedure
(1) Open the Concentration Analysis History window, Retention Time History window or 

Calibration coefficient History window and click on the Open History command in the File 
menu.

• This operation can also be conducted by clicking the  button on the toolbar.

 A dialog box for specifying the latest history date among the history data to read appears.

 F5-4-9.ai

Clicking the arrow 
button causes the 
latest to oldest 
file-saving dates 
stored in the analyzer 
server to appear in 
descending order, 
allowing you to choose 
the desired date. The 
default displays the 
previously specified 
date.

(2) Specify the latest date of history data you wish to read and click the OK button.
 If you select the “Display from Latest Data” radio button, the relevant history data is 

immediately read and displayed.
 If you specify the date of history data to read, a dialog box to further specify the time of day 

appears.

 F5-4-10.ai

Clicking the arrow 
button causes the 
time-of-day data 
stored in the specified 
day or month file to 
appear in descending 
order, allowing you to 
choose the desired 
time of day.

(3) Specify the latest time-of-day of the history data you wish to read and click the OK button.
 The history data existing up until the specified date and time of day is then read and 

displayed.

 F5-4-11.ai
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n Closing History Data
If history data read into the Concentration Analysis History window or Retention Time History 
window or Calibration coefficient History window is no longer required, proceed as follows to 
close it.

CAUTION
History data is shared between the Concentration Analysis History window and the  
Retention Time History window; if history data in either window is cleared, the other window is 
also cleared accordingly.

l Operation procedure
Open the Concentration Analysis History window or Retention Time History window or Calibration 
coefficient History window and click on the Close History command in the File menu.
History data is then closed, clearing the display.

TIP
Only one series of history data can be read at a time. Reading new history data causes the previous history data 
to be closed automatically.

n Reading (Opening a File)
A saved file can be read in a file reference window using the following procedure:

l Operation procedure
(1) Select the file reference window you wish to read and click on the Open command in the 

File menu.
• This operation can also be conducted by clicking the  button on the toolbar.

 A dialog box for specifying the file to read appears.

 F5-4-12.ai

(2) Specify the file name to read and click the OK button.
 The specified file is then read, displaying the saved data.

TIP
• Data in an opened file can be modified.
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SEE ALSO
Subsection 5.5.5 for data modification

n Closing a File (on a File Reference Window)
If a file read in a file reference window is no longer required, close it using the following 
procedure:

l Operation procedure
Display the file reference window you wish to close and click on the Close command in the File 
menu.
The specified file is then closed.

TIP
• If the file has been modified, a dialog box asking if you want to save the changes appears. Click the Yes 

button and enter the file name in the displayed dialog box to save the data as a new file. Note that if you 
click the Cancel button in the displayed dialog box, the file will be closed without saving the modified data.

 F5-4-13.ai

• Only one file can be displayed in a single file reference window. Opening the next file causes the previous 
file to be closed automatically.

5.4.5 Modifying and Re-saving Data
Data read in a file reference window (File Analysis Results, File Concentration Analysis History, 
File Retention Time History, Laboratory Analysis Results or Calibration coefficient History 
window) can also be modified. Further, modified data can be re-saved (overwritten) or saved to a 
file under a different name (new save).

n Modifying Data (in a File Reference Window)

l Operation procedure
(1) Choose the cell you wish to modify in the file reference window and double click it (or press 

the F2 key).
 The data of the selected cell is displayed in the cell contents change window on the toolbar.

 F5-4-14.ai

Cell contents
change window
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(2) Edit the data in the cell contents change window and press the Return key.
 The edited results will be displayed in the cell. (Press the ESC key to cancel editing.)

TIP
Limitation on data modification

• You can modify or erase data values in cells, but you cannot delete a cell itself to move successive data 
upward.

How to choose a cell
• To select a cell, move the mouse cursor over the desired cell and click on it. Alternatively, you can use the 

cursor keys to move the cursor.

n Overwriting (in a File Reference Window)
l Operation procedure

(1) Display the file reference window you wish to save and click on the Overwriting Save 
command in the File menu.

• This operation can also be conducted by clicking the  button on the toolbar.

(2) The window data is saved to the file without displaying a message.

n New File Save (in a File Reference Window)
l Operation procedure

(1) Display the file reference window you wish to save and click on the Save As command in the 
File menu.

 A dialog box for entering the storage destination appears.

 F5-4-15.ai

(2) Select the drive name and directory name, enter the file name under which you wish to save 
the data in front of the extension, and then click the OK button.

 The data in the window will be written to and saved to the new file.

TIP
Extension

• An extension affixed to a file name upon saving is classified according to the window type as shown below. 
The window types can be identified by these extensions.

  Latest analysis results: .ana
  Concentration analysis history: .cnc
  Retention time history: .rtm
  Laboratory analysis results: .lab
  Calibration coefficient history: .cef

File format
• The format of a file to save is a text file (separated by commas (,)). This file can be read by general 

applications as well as from a file reference window within the Analysis Results window.

9th Edition : Nov. 04, 2014-00



  <5.  Display and Operations while Connected to GC1000 Mark II> 5-50

IM 11B06C01-01E

5.4.6 Plotting History Data on a Graph
Using the data of a history window (Concentration Analysis History, Retention Time History, 
Calibration coefficient History File Concentration Analysis History, File Retention Time Analysis 
History or File Calibration coefficient History), a graph can be created. Unnecessary graphs can 
be closed.

CAUTION
Data from windows other than the history windows (Latest Analysis Results, Laboratory Analysis 
Results, File Analysis Results, and File Laboratory Analysis Results) cannot be used to create 
graphs.

n Drawing a Graph

l Operation procedure
(1) With a history window (one of the noted six windows) displayed, click the Create command 

in the Graph menu.
• This operation can also be conducted by clicking the  button on the toolbar.

 A dialog box for setting up a graph appears.

F5-4-16.ai

9th Edition : Nov. 04, 2014-00



  <5.  Display and Operations while Connected to GC1000 Mark II> 5-51

IM 11B06C01-01E

(2) Select the peak name to be indicated on the graph from the list box at the lower right of the 
dialog box as follows:

 Continuous peak names: Drag from the first peak name to the last peak name.
 Discontinuous peak names: a) Click on the first peak name or the start of a peak range.
  b) With the CTRL key held down, click on the next peak name 

or the end of the range.
  c) Repeat step b) to select the necessary peak names.
 The selected peak names will be inverse video displayed.

• Up to six peak names can be selected at a time.
• If a wrong peak range has been selected, make a new selection.

(3) Set up a scale for the ordinate (a concentration scale for concentration analysis history , a 
retention time scale for retention time history or calibration coefficient sale for calibration 
coefficient history).

a) Select linear or logarithmic representation.
b) Select Auto/Manual mode for scale setup. With Auto selected, the scale suitable for a 

selected range is automatically set. When Manual is selected, you need to further enter 
the maximum and minimum values of the axis.

• In logarithmic representation, the zero or negative values cannot be represented properly. 
If the values include the zero or a negative value, be sure to select linear representation.

(4) Set up the time axis range.
 Choose Auto or Manual. With Auto selected, the entire time range displayed in the history 

window is turned into a graph. When Manual is selected, you should choose the start time 
and end time from the list boxes of the drop-down format. In this case, only data in the 
selected range is plotted into a graph.
• A start time must be selected prior to the end time.

(5) As the form for peak name representation, choose either “Stream# - Peak# - Peak Name 
(unit)”, or “Peak Name (unit).”

(6) Check that all settings have been specified, and then click the OK button.
 A graph window is then displayed.

 F5-4-17.ai
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TIP
• A graph window is always displayed concurrently with the history window, or the data source of the graph 

window.
• To modify a drawn graph, execute the Create command in the Graph menu and change the settings in the 

dialog box displayed. (The commands of either the history window or the graph window are available.)
• Graph windows cannot be saved. If necessary, save the relevant history window then draw the graph again.

n Closing Graph Windows
If a graph window is no longer required, close it as follows:

l Operation procedure
In the graph window you wish to close, click on the Close command in the Close menu.
The graph window is then closed.

n Printing a Graph Window

l Operation procedure
In the graph window you wish to print out, click on the Print command in the Graph menu. The 
graph window is then printed.
You can also print it by clicking the  button on the toolbar in the graph window.
The Page Setup command in the Graph menu allows you to set the direction of the printing paper 
(Portrait/Landscape).

 F5-4-18.ai

9th Edition : Nov. 04, 2014-00



  <6.  Display and Operations of Windows while Connected to ASIU> 6-1

IM 11B06C01-01E

6. Display and Operations of Windows 
while Connected to ASIU

This chapter describes the display and operations of the Overview window, Short-term 
Trend window, and ASIU Operation window when ASIU is connected to ASET using the 
Overview window.

The display and operations of the Alarm window are the same regardless of the analyzer 
type. See Chapter 7.

Some of the windows available while connected to ASIU have the same window names 
as those available while connected to GC1000 Mark II; however, their functions differ 
somewhat. The following shows the general outline of the windows available for this 
connection.

Overview window: Displays the statuses of 16 contact inputs and outputs.
Short-term Trend window: Displays changes in the instantaneous values within the 

average cycles of analog inputs as a chromatogram. This 
window is basically the same as the Chromatogram window 
for GC1000s.

ASIU Operation window: Facilitates operation of the statuses of 16 contact outputs and 
the status modes.

Related windows

F6-0.ai

Start Exit

ASIU Operation command
ASIU Operation
Window Display button

Exit command

Short-term Trend command
Short-term Trend
Window Display button

Close command

(Program manager)

Engineering 
Terminal Group 

window

Overview window ASIU Operation 
window

Short-term Trend 
window
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6.1 Overview Window
6.1.1 ASIU Analyzer Status Window

l	 Window	configuration
The following table shows the elements of the AISU Analyzer Status window.

F6-1-1.ai

ASIU ID/tag

Alarm Status Contact Output Status

Contact Input Status

l Functions and Display Contents of Elements
Button/Display Function and Display Contents

Analyzer ID Indicates the analyzer ID of the displayed analyzer.
Tag No. Indicates the analyzer tag number of the displayed data. If no tag number 

has been set to the analyzer, the area is left blank.
(Enable)/DISABLE Indicates the current connection status of the displayed analyzer ID with 

respect to the analyzer server. “DISABLE” is indicated if connection is not 
possible; otherwise, the area is left blank.

Alarm Status Indicates the current alarm status as follows. Moreover, double clicking on 
the alarm status indication causes the Alarm Status window of that analyzer 
to appear.
Illuminated in green: No alarm
Illuminated in yellow: Level-2 alarm occurred.
Illuminated in red: Level-1 alarm occurred.

Contact Input Status Displays the ON/OFF statuses of the contact inputs (DI1 to DI16). By 
default, ON is indicated in green, while OFF is shown in gray. The display 
colors can be changed in the Builder Panel Setting dialog box of PSAS. 
Right clicking on this area causes a list of DI tag numbers/signals to appear.

Contact Output Status Displays the ON/OFF statuses of the contact outputs (DO1 to DO16). By 
default, ON is indicated in green, while OFF is shown in gray. The display 
colors can be changed in the Builder Panel of PSAS.
Right clicking on this area causes a list of DO tag numbers and signals to 
appear.
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6.1.2 Tag List Window
The Tag List window displays the tag numbers and signals of DI’s or DO’s. These display items 
can be edited in the ASIU Operation window.

F6-1-2.ai

6.2 Short-term Trend Window
The Short-term Trend window displays the trend of instantaneous values of the selected AI’s (1 to 
16) of ASIU. The basic functions are the same as those of the Chromatogram window.
To reference short-term trend information, read “chromatogram” in the help of the Chromatogram 
window as “trend”, unless otherwise stated. The Short-term Trend window can display the latest 
trend, previous trend, and trend data stored in the analyzer server, and trend data that has been 
saved to a file. Moreover, currently displayed trend data can be saved in a file.
Note that a trend does not have peak information, gate information, temperature data, or 
pressure data. Thus, the Set Mark command in the Graph menu and the Temperature/Pressure 
Display command in the Graph menu are invalid.
The trend data that is displayed by default upon opening the Short-term Trend window are latest 
trend 1 and previous trend 1.
The display and operations of the Short-term Trend window are basically the same as those of 
the Chromatogram window available while connected to GC1000 Mark II. This section describes 
portions of the display or operations of the window that differ from those when connected to 
GC1000. For other portions, see subsection 4.3, “Chromatogram Window,” in Chapter 4, “Display 
and Operations during Connection to GC1000 Mark II.”

6.2.1 Trend Display
The Short-term Trend window can display eight trend graphs.

n Trend Display
Trend graphs that can be displayed are as follows:

Chromatogram Type Description
Latest trend This is the trend currently being measured.
Previous trend This is the trend measured previously, which is updated periodically.
File trend This is trend that has been saved to a file.
Differential trend This is the result of differences determined by comparing two trends that 

are displayed.
History trend This is a previous trend that has been stored in the analyzer server.

9th Edition : Nov. 04, 2014-00



  <6.  Display and Operations of Windows while Connected to ASIU> 6-4

IM 11B06C01-01E

l For the latest trend and previous trend
(1) Click on the Set Pen command in the Graph menu.
 The Set Pen dialog box appears.
 This dialog box can also be called up by clicking the  button on the toolbar.

 
F6-2-1.ai

(2) From the combo box corresponding to the display colors used for display, choose either 
“Latest trend” or “Previous trend.”

 The Select AI Number dialog box appears.

 F6-2-2.ai

(3) Select an AI number and click the OK button. This returns you to the Set Pen dialog box.
 In this case, the combo box selected in step (1) shows the selected trend name.
(4) Click the OK button. The trend of the selected AI appears.

l History trend
(1) Click on the Set Pen command in the Graph menu.
 The Set Pen dialog box appears.
 This dialog box can also be called up by clicking the  button on the toolbar.
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(2) From the combo box corresponding to the display colors used for display, choose “History 
trend”.

 The Select AI Number dialog box appears.

 F6-2-3.ai

(3) Select an AI number and click the OK button. The Select History Trend dialog box appears.

 F6-2-4.ai

(4) Select the time frame in which the history trend you wish to display is included, and click the 
OK button. A list of trend start times appears.

 F6-2-5.ai
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(5) Choose the start time and click the OK button. This returns you to the Set Pen dialog box.
 In this case, the combo box selected in step (1) shows the following trend start time and AI 

number:
  12/08 16:09 H3
  Month  Day  Hr  Min  History trend’s  AI No.

 F6-2-6.ai

TIP
If a time earlier than 24 hours prior is specified in step (4), processing may take some time, depending on the 
amount of data.

l File trend and differential trend
These are the same as the file and differential chromatograms available while connected to 
GC1000. See subsection 5.3.4, “Displaying Chromatogram and Temperature Data.”

n Setting Marks and Displaying Temperature Data
Short-term trend data does not contain mark information or temperature and pressure data; 
these items cannot be displayed in the window.

6.3 Contact Output Operation Window
The Contact Output Operation window displays the statuses of ASIU contact outputs as ON/OFF. 
From this window, the ON/OFF status of the contact outputs can be operated.

6.3.1 Displaying and Exiting the ASIU Operation Window
This section describes how to display and exit the ASIU Operation window.

CAUTION
Only one ASIU Operation window can be displayed at a time.
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n Displaying
Specify the analyzer ID of ASIU in the Overview window, and then open the ASIU Operation 
window.

SEE ALSO
For specifying an analyzer ID, see section 3.6, “Selecting Analyzer.”

l Operation procedure
Click on the ASIU Operation command in the Window menu.
The ASIU Operation window is then displayed.
This operation can also be conducted by clicking the (  ) button on the toolbar.

 F6-3-1.ai

n Exiting
Click on the Close command in the System menu while the ASIU Operation window is in an 
active state.
The ASIU Operation window is closed.
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6.3.2	 Window	Configuration
The ASIU Operation window is intended to display and operate the contact output statuses.

n Element Names and Functions

F6-3-2.ai

Tag No.: Used to identify the contact outputs. Tag numbers are set in the DO 
Setting dialog box.

Signal: This is additional information for the contact outputs. Settings are made in 
the DO Setting dialog box.

Contact Output button: Displays the contact output statuses (ON/OFF). You can change the 
contact output statuses. (This requires user level “B” or “C.”)

6.3.3 Contact Output Operation
The ASIU Operation window allows you to operate the contact outputs.

n Operating Contact Outputs
(1) Double click on the contact output button at which you wish to make change. Then, a 

message box appears confirming that you want to change the DO setting.
(2) Click the OK button to change the contact output status.
 (The output status operates by changing to ON, OFF, ON, and so on, like a toggle switch.)
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7. Alarm Windows
The alarm windows display alarm information that is generated in the analyzer. There are 
three	types	of	windows,	classified	by	the	display	contents:	Alarm	Status	window,	Alarm	
History window, and Detailed Alarm Description window.

This	chapter	describes	the	types	and	configuration	of	the	alarm	windows,	how	to	display	
and exit them, erasing alarm history, and the creation of a user alarm.

Related windows

F7-0.ai

Close
command

Alarm Status
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Alarm History
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PCAS Alarm History

command
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n Displaying Each Alarm Window from the Overview Window
There are three ways to display an alarm window from the Overview window:
(1) Click on the Alarm command in the Window menu.
(2) Click the Alarm button on the toolbar.
(3) Double clicking on the relevant alarm lamp in the Analyzer Status window of the analyzer of 

which you wish to display the alarms.
Note that opening an alarm window using method (1) or (2), requires that you pre-select the 
analyzer of which you wish to display alarms.

SEE ALSO
Subsection 3.6, “Selecting Analyzer” for how to select the analyzer

If you open an alarm window from the Overview window, the Alarm Status window appears.

TIP
Only one alarm window can be displayed at a time.
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n Exiting
While an alarm window is in active state, click on the Close command in the Control menu.
The alarm window is closed.

7.1 Alarm Status Window
The Alarm Status Window is a window displaying the statuses of alarms that have occurred in the 
analyzers.
The Alarm Status window displays alarm messages with the latest alarm at the top. The display 
items are the occurrence date and time, a flag, alarm numbers, an alarm description, and related 
data (1, 2). If there is data hidden from view in the window, you can scroll through it to display 
hidden portions. The flag is always “1” (occurred).
Right clicking on an alarm number display area allows you to display the Detailed Alarm 
Description window of that alarm number.

If you select the [ALL] tab, it displays the statuses of all alarms that have occurred in the GC8000.
If you select the [GCM] tab, it displays the alarm status of the selected GCM and the equipment 
overall.

7.2 Alarm History Window
The Alarm History Window is a window displaying the histories of alarms that have occurred in 
the analyzers.
The Alarm History window reads analyzer based alarm histories stored in the analyzer server, 
and displays the latest 300 alarms.
The display items are the occurrence date and time, a flag, alarm numbers, an alarm description, 
and related data (1, 2). If there is data hidden from view in the window, you can scroll through it 
to display hidden portions. The flag, if it is “1”, indicates the occurrence of an alarm, or if it is “0,” 
indicates recovery from it.
Right clicking on an alarm number display area allows you to display the Detailed Alarm 
Description window of that alarm number.
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If you select the [ALL] tab, it displays the histories of all alarms that have occurred in the GC8000.
If you select the [GCM] tab, it displays the alarm histories of the selected GCM and the equipment 
overall.
A maximum of 600 alarm histories will be displayed.

7.3 PCAS Alarm History Window
The PCAS Alarm History window reads an alarm log file stored in the analyzer server and 
displays the latest 300 alarms. If a PCAS alarm occurs while this window is being displayed, you 
should re-read the alarm log file from the analyzer server to update the display.
The display items are the occurrence date and time, a flag, alarm numbers, alarm description, 
and related data (1, 2). If there is data hidden from view in the window, you can scroll through it 
to display hidden portions. The flag, if it is “1”, indicates the occurrence of an alarm, or if it is “0” it 
indicates recovery from it.
Right clicking on an alarm number display area allows you to display the Detailed Alarm 
Description window of that alarm number.

F7-1-3.ai

Scroll bar
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7.4 Detailed Alarm Description Window
The Detailed Alarm Description window displays a detailed description of an alarm of a specified 
number.

l Displaying the Detailed Alarm Description window
(1) While the Analyzer Operation window is displayed, click on the Alarm Details command in 

the Display menu. A dialog box for specifying an alarm number appears.

 F7-1-6.ai

(2) Enter the alarm number and click the Execute button.
 The Detailed Alarm Description window of the specified alarm then appears.

If an alarm window is displaying the alarms of GC8000, the Detailed Alarm Description window 
displays a detailed description of the specified alarm of GC8000.
If an alarm window is displaying the alarms of GC1000 Mark II, the Detailed Alarm Description 
window displays a detailed description of the specified alarm of GC1000 Mark II.
If the alarm window is displaying ASIU alarms, the Detailed Alarm Description window displays a 
detailed description of the specified ASIU alarm.
If the alarm window displays PCAS alarms, the Detailed Alarm Description window displays a 
detailed description of the specified PCAS alarm.

F7-1-4.ai  

HELP !
 If you specify an unregistered number, an “Undefined alarm” message will be indicated in 

the window. In this case, close the Detailed Alarm Description window and re-specify the 
correct alarm number.
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l Display contents
The following shows the display contents of each item:

Item Display Contents
Alarm No. This is the alarm number specified upon opening. If an unregistered 

number is specified, the message “Undefined alarm” appears here.
Message This shows the alarm message displayed in the Analyzer LCD panel.
Associated Data 1/2 For alarms with associated data, the meaning of the data and its scale are 

indicated.
Alarm Status Indicates alarm detection criteria and limit value.
Possible Cause Indicates the possible cause(s) of the generated alarm.
Countermeasure Indicates the countermeasures and immediate remedies that can be taken 

against the possible cause.

TIP
While the Alarm Status window or Alarm History window is displayed, you can right click on the alarm number 
area of a displayed alarm to display the Detailed Alarm Description window of that alarm.

7.5 Clear Alarm Status/History
The alarm history information stored in the analyzer server can be cleared to start saving new 
alarm history.
If the analyzer alarm history is being displayed, the following procedure clears the alarm history 
of the displayed analyzer. If PCAS alarm history is being displayed, this procedure clears the 
PCAS alarm history.

CAUTION
Only users of the user level C or more can erase the display contents of the Alarm History 
window.

Click the Clear History command in the Display menu of the Alarm Status or Alarm History 
window.
This erases the display contents of the Alarm History window.
Only users of the user level C+ can erase the display contents of the Alarm Status window of 
GC8000.
The Alarm Status of GC1000 MarkII can not be erased.
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8. ASET for ARCNET
The New ARCNET-based bus system enables connection between an ARCNET system 
and an Ethernet system. This realizes addition of Ethernet analyzers to existing ARCNET 
systems.

8.1	 System	Configuration
ASET-G software which is ARCNET supported version must be installed to corresponde with the 
ARCNET system.
A typical network configuration of analyzer bus is shown in Figure 8.1.
The network consists of analyzers (Gas chromatograph etc.) and "Analyzer bus systems for 
ARCNET". This "Analyzer bus systems for ARCNET" consist of “Gateway unit”, ”analyzer server” 
and “ARCNET / Ethernet Converter”.
Each software (PCAS, ASET) for “Analyzer server” and “Analyzer Server Engineering Terminal” 
should be used “/ARC: ARCNET supported version”.
The communication to the analyzer connected to Ethernet is also enabled.

• "Analyzer bus systems for ARCNET" should be used so that DCS communicates with 
analyzer connected to ARCNET.

• Redundancy for ARCNET is enabled. Redundancy for Ethernet can be done by using 
double "Analyzer bus systems for ARCNET".

• One "Analyzer bus systems for ARCNET" can communicate with up to 30 sets of analyzers 
connected to ARCNET. In case of communicating with more than 31 sets, plural number of 
"Analyzer bus systems for ARCNET" should be used.

F8-0.ai

DCS
DI/O

RS-232C

LAN (Ethernet)

Analyzer bus system
for ARCNET

ARCNET

PC
[PCAS/ARC]

PC
[ASET/ARC]

STARDOM FCJ
[ASGW]

ASIU

GCIU

GC1000 MarkII

GC1000 GC1000

[   ]:Software

ARCNET/Ethernet
Converter

GC1000 MarkII

GCIU

Analyzer
pH analyzer, 

Oxygen analyzer, etc.

Network monitoring,
Automatic data storage Gateway

Operation and display of
Gas Chromatograph

Figure	8.1	 Typical	System	configuration
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8.2 Installing ASET for ARCNET
8.2.1 Installing “Microsoft Visual C++ 2008 Redistributable 

Package”
Install the “Microsoft Visual C++ 2008 Redistributable Package” Before installing ASET-G.
This package is also included in the PCAS Install Disk. If you already installed this Package into 
the computer while the PCAS installing, you can skip this procedure.

n Installation Procedure
(1) Insert the install disc into the CD drive. The following dialog box appears Click “Open folder 

to view files”.

(2) Select the folder “Microsoft Visual C++ 2008 Redistributable Package (x86)”->” for_English”
(3) Click “vcredist_x86.exe”, then the installer will start.
(4) Install the software according to the screen.

8.2.2 Installing ASET-G
Install the ASET-G according to “Installing the Engineering Terminal”.
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8.2.3 Check the ASET-G communication with the PCAS-G
(1) Start the ASET-G, and a dialog box to set the IP address of the PCAS-G appears.

(2) Enter Server ID and IP address, and click ‘connect’ button. Check if the Overview Window of 
the ASET-G appears.

(3) Overview Window shows each of the analyzer’s operation status.
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8.2.4 Check the EtherLCD-G communication
(1) Start the ASET-G, and a dialog box to set the IP address of the PCAS-G appears.

(2) Enter Server ID and IP address, and click ‘connect’ button. Then if the EtherLCD-G 
communicates with the PCAS-G successfully, “Select Analyzer” dialog box appears. The 
dialog box shows analyzer list registered in the PCAS-G.
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(3) Select analyzer and click , and click ‘connect’ button. Check if the analyzer’s Ether LCD-G 
Emulator appears.

8.2.5 PCAS Data Storage check
After finishing the all of installation, check the PCAS data storage.

(1) Display Analysis result.

(2) Display historical chromatogram.

For detailed procedures, refer to “4.3 Chromatogram Window” and “4.4 Analysis Results 
Windows.”
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Appendix A List of Menus
This Appendix contains a general outline of the functions available in the Engineering Terminal.
The displayed menu depends on the analyzer to be connected.

n Ethernet LCD Emulator Window

T01A.ai

Connect

 Japanese
v English
 Chinese

Help

HelpConnect
Disconnect
Forced Connect
Select Analyzer
Displ. Reset

Comm. Log
Language

Exit Alt + F4

Menu Name Command Name Function
Connect Connect Connects communication with an analyzer.

Disconnect Disconnects communication with an analyzer.
Forced Connect
Select Analyzer
Disp. Reset Erases LCD display and displays the Analyzer Status window 

anew.
Comm. Log
Language
Exit Exits the LCD emulator.

Help Help Displays Help of the LCD emulator.
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n Overview Window

T02A.ai

System

 Japanese
v English
  Chinese v Enable

 Disable

v All Alarm
 Level 1, 2
 Level 1
 No Display

 Display Level
 Popup Recover events

v User Level  A
 User Level  B
 User Level  C
 User Level  C+

Window

 Alarm Popup

 Analyzer Overview
 Alarm

Display Help
 Help
 About

 Connect
 Disconnect

 Analyzer ID
 Page Select
 Page Set Up

 User Level 
 Forced Connect 
 Select Server
 Comm. Manage.
 Language 
 Exit Alt + F4

In case of GC1000 MarkII

T03A.ai

System

 Japanese
v English
  Chinese v Enable

 Disable

v All Alarm
 Level 1, 2
 Level 1
 No Display

 Display Level
 Popup Recover events

 Upload to PC
 Download to GC

v User Level  A
 User Level  B
 User Level  C
 User Level  C+

Window

 Latest Analysis
 Alarm Popup

v Analyzer Operation
v Analysis Results
 Chromatogram
 Alarm

Measure.  Status 
Stream Sequence 
Stream Select (Continuous)
Stream Select (One cycle)
Calibration/Validation

Operation Mode

Display Option Help

Operation mode Change

 Help
 About

Calibration/Validation Start
Calibration/Validation Stop
Select Cancel

 Connect
 Disconnect

 Analyzer ID
 Page Select
 Page Set Up

Parameters Transfer
Analyzer Reset

 User Level 
 Forced Connect 
 Select Server
 Comm. Manage.
 Language 
 Exit Alt + F4

Menu Name Command Name Function
System Connect Connects communication with an analyzer.

Disconnect Disconnects communication with an analyzer.
User Level Sets the user level (A to C).
Forced Connect Make a force connect to an analyzer server.
Select Analyzer Select an analyzer server connected.
Comm. Manage. Change a setting related to the communication log.
Language Change the language (Japanese/English/Chinese) used.
Exit Exits the Engineering Terminal.

Window Analyzer Operation Displays the Analyzer Operation window.
Analyzer Results Displays the Analysis Results window.
Chromatogram Displays the Chromatogram window.
Alarm Displays the Alarm window.
Latest Analysis Results Displays the latest analysis result window.
Alarm Popup Selection of the display/nondisplay of Pop up alarm window.

Operation Mode Change Operation Mode Changes the analyzer operation mode.
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Menu Name Command Name Function
Measurement 
Status

Stream Sequence Command the Stream sequence
Stream (Continuous) Command the Stream (continuous)
Stream (One cycle) Command the Stream (One cycle)
Calibration (Validation) Command the Calibration/Validation.
Start Calibration 
(Validation)

Command the Calibration/Validation start.

End Calibration 
(Validation)

Command the Calibration/Validation end.

Cancel Specification
Display Setting Analyzer ID Sets the analyzer ID of the analyzer to operate.

Select Page Selects the page to display in the Analyzer Status window.
Set Page Sets up the analyzer to display in the Analyzer Status window 

page.
Option Transfer Parameters 

- Upload Parameters
Uploads set parameters from the analyzer to the Engineering 
Terminal and saves them to the hard disk..

Transfer Parameters 
- Download Parameters

Downloads set parameters from the Engineering Terminal to the 
analyzer.

Reset Analyzer Resets the analyzer.
Help Help Displays Help of the ASET.

About Displays the version information of the Overview window.

n Analyzer Overview Window

T17A.ai

System

 Main Upload
 Oven1 Upload
 Oven2 Upload
 Oven3 Upload
 User Program Upload
 COM Upload
 GC-HMI Upload

 Main Download
 Oven1 Download
 Oven2 Download
 Oven3 Download
 User Program Download
 COM Download
 GC-HMI Download

Window

 Latest Analysis
 GCM No.

 Analyzer Operation
 Analysis Results
 Chromatogram
 Alarm
 Anaraizer Configuration

Operation Mode Help
Operation mode Change  Help Reload Initial Database

 Upload Parameter
 Download Parameter
 Upload User Script
 Download User Script
 Upload Software
 Download Software
 Memory Dump
 Analyser Reset

Change All Operation Mode
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n Analyzer Operation Window

T04A.ai

GC State

Set Up Help
 Help

v Process
 Manual

SYS
 SYS1
 SYS2
 SYS3
 SYS4
 SYS5
 SYS6

 Stream VLV
 Atm
 Valve
 Peak

Ope. Mode
v Run
 Pause
 Stop
 Force Stop
 Command Cancel

Measure. State
 Stream Sequence
 Stream (Continuously)
 Calibration/Validation

 Calibration/Validation Start
 Calibration/Validation Stop
 Selection Cancel
 Calibration/Validation Method
 Auto Cal Status

Manual/Range

Stream VLV
Atm
Oven1
Oven2
Oven3

Atm1-1
Atm1-2
Atm2-1
Atm2-2
Atm3-1
Atm3-2

VLV
DET
HL
Heater1
Press1

VLV1-1
VLV1-2
VLV1-3
VLV1-4
VLV1-5
VLV1-6
VLV1-7

DET1-1
DET1-2

HL1

 Start
v Stop

 Manual
 Range Select

 Peak Tracking
 Stream Sequence

 Selection Cancel

 Exit

In case of GC1000 MarkII

T05A.ai

GC State

Set Up Help
 Help

v Process
 Manual
 Lab

 Valve
 Peak

Ope. Mode
v Run
 Pause
 Stop

Measure. State
 Stream Sequence
 Stream Select (Continuous)
 Stream Select (One cycle)
 Calibration/Validation
 Calibration/Validation Start
 Calibration/Validation Stop
 Selection Cancel
 Calibration/Validation Method

Manual/Range

Name
Gate Std/ON/OFF Time
Result Unit/Measuring Range
Ref Stream Number/Ref Peak 
Number
Gate Cut Method/Integ Method
Std Conc/Std Area/Calib Factor

Stream VLV
VLV1
VLV2
VLV3
VLV4
VLV5
VLV6
VLV7
VLV8
DET1
DET2
Herater
Pressure

 Manual
 Range Select

Menu Name Command Name Function
GC State Process Changes the operation mode to Process.

Manual Changes the operation mode to Manual.
Lab Changes the operation mode to Laboratory.

Operation Mode Run Changes the operation mode to Run.
Pause Changes the operation mode to Pause.
Stop Changes the operation mode to Stop.
Command cancel Cancels the Pause mode or the status of a mode change being 

reserved.

9th Edition : Nov. 04, 2014-00



  <Appendix A  List of Menus> A-5

IM 11B06C01-01E

Menu Name Command Name Function
Measurement 
State

Stream Sequence Set Stream Sequence. 4 Pattern can be selected.
Stream Select 
(Continuous)

Set Stream Number to analyze continuously.

Stream Select (One 
cycle)

Set Stream Number to analyze one cycle.

Calibration/Validation Set Calibration or Validation stream.
Calibration/Validation 
Start

Start Calibration or Validation stream.

Calibration/Validation 
Stop

Stop Calibration or Validation stream.

Selection Cancel Cancel the above Measurement state which has been set.
Calibration/Validation 
Method

Set the Method number of Calibration or Validation.

Manual/Range Manual-Stream VLV Switches the Stream switching valve in Manual mode.
Manual-VLV1 Switches the valve1 in Manual mode
Manual-VLV2 Switches the valve2 in Manual mode
Manual-VLV3 Switches the valve3 in Manual mode
Manual-VLV4 Switches the valve4 in Manual mode
Manual-VLV5 Switches the valve5 in Manual mode
Manual-VLV6 Switches the valve6 in Manual mode
Manual-VLV7 Switches the valve7 in Manual mode
Manual-VLV8 Switches the valve8 in Manual mode
Manual - #1 DET1 Switches ON/OFF of Detector 1 in Manual mode.
Manual - #2 DET2 Switches ON/OFF of Detector 2 in Manual mode.
Manual-Heater Switches ON/OFF of the heater.
Manual-Pressure Switches ON/OFF of EPC.
Range Select Change the range by setting the range number.

Set UP Valve Set/Change the valve ON/OFF time.
Peak-Name Set/Change the peak time.
Peak-Gate Std/ON/OFF 
Time

Set/Change the gate ON/OFF and std time.

Peak-Result Unit/
Measuring Range

Set/Change the measuring range and/or its unit.

Peak-Ref Stream 
Number/Ref Peak 
Number

Set/Change the Reference Stream number and/or Reference
Peak number.

Peak-Gate Cut Method/ 
Integ Method

Set/Change the Gate Cut Method and/or the Integration
Method.

Peak-Std Conc/Std 
Area/Calib Factor

Set/Change the standard concentration, standard area and/or
Calibration Coefficient.

Help Contents Displays the contents of Help of the Analyzer Operation
window.

Help Search Displays Help on the basis of the keyword entered.
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n Chromatogram Window

T06A.ai

File Scale

 Zoom In
 Zoom Out
 Part Zoom
 Full Display
v Auto Scale

Graph

 Pen Select
 Timing Mark
 Temp./Press.Disp.

 ON
v OFF  ON

v OFF
 Clear

v Main Cycle
 SYS Display

 Save Chrom.
 Save/Delete
 Backup Analysis Result
 Restore Analysis Result
 Print
 Exit  Auto Gain

Ee-integration

 Display Re-integration Area
 Re-integration
 Update
 Send Peak Application
 Transfer Result
 Cancel
 Re-integration Multi Chromatograms

 Multi Chromatogram Display
 Shift Display

Options

 Grid
 Snap Shot 
 Additional Info. Display Position

v ON
 OFF

 Snap 1
 Snap 2
 Clear

v On the chromatogram 
 Under the chromatogram

Help

 Help

In case of GC1000 MarkII

T07A.ai

File Scale

Zoom In
Zoom Out
Part Zoom
Enlargement
Full Display
Auto-scale

Graph

Pen Select
Timing Mark
Temp/Pressure 
Display

Option

 Grid
 Snapshot 
v Cursor Pos. 
 Peak Display 

v ON
 OFF

 Snap 1
 Snap 2
 Clear

v On the
 chromatogram 
 Under the
 chromatogram

Help

Contents
Help Search

Save Chrom

Exit Alt + F4
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Menu Name Command Name Function
File Save Chrom. Saves the chromatogram displayed in the window to the hard 

disk or a floppy disk.
Exit Exits the Chromatogram window.

Scale Zoom In Enlarges chromatogram display.
Zoom Out Reduces chromatogram display.
Part Enlargement Specifies a range of chromatogram display and enlarges it.
Full Disp Displays the entire chromatogram.
Auto Scale Switches ON/OFF of auto-scale.

Graph Pen Select Sets up a chromatogram to display.
Timing mark Switches visible/invisible status of mark information.
Temp/Pressure Display Displays temperature data of a chromatogram.

Option Grid
Snap Shot - Snap 1 Stores a currently displayed window in memory or displays 

window data stored in memory.
Snap Shot - Snap 2 Stores a currently displayed window in memory or displays 

window data stored in memory.
Snap Shot - Clear Erases the contents of the window stored using the Snap 1 or 

Snap 2 command.
Cursor Pos. Switches visible/invisible status of the time and voltage value of 

the mouse cursor position on a graph.
Peak Display On the 
chromatogram

Indicates mark information for peak display above the peak 
position.

Peak Display Under the 
chromatogram

Indicates mark information for peak display below the peak 
position.

Help Contents Displays the contents of Help of the Chromatogram window.
Help Search Displays Help on the basis of the keyword entered.

n	 Analyzer	Configuration	Windows

T16A.ai

System

 Exit

Help

 help
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n Alarm (Common to Alarm Status and Alarm History Windows)

T09A.ai

View Detail Help

v Alarm Status
 Alarm History
 PCAS Alarm History
 GCM
 Clear Status
 Clear History
 Exit

 View
 Making External DI alarm description

 Help

 ALL(A)
v GCM1(1)
 GCM2(2)
 GCM3(3)
 GCM4(4)
 GCM5(5)
 GCM6(6)

Menu Name Command Name Function
Display Alarm Status Displays the Alarm Status window.

Alarm History Displays the Alarm History window.
PCAS Alarm History Displays the PCAS’s Alarm History window.
Select GCM Allows you to select THE GCM whose alarms are displayed. If 

ALL is selected, all alarms that have occurred in the GCM are 
displayed. 

Clear Status Clears the alarm statuses of the analyzer.
If ALL is selected in THE GCM selection, all alarm statuses of the 
GCM will be cleared. If any of CGM1 to GCM6 is selected, the 
alarm statuses of the GCM concerned will be cleared. 

Clear History Clears the alarm history of analyzer.
If ALL is selected in THE GCM selection, all alarm histories 
provided for the GCM will be cleared. If any of CGM1 to GCM6 
is selected, the alarm histories of the GCM concerned will be 
cleared. 

Close Closes the Alarm Window.
Detailed Display Displays the Alarm Detail description dialog. On this dialog, 

entering an alarm number and clicking the Execute button 
causes the Alarm Detail Window to appear. 

Making External DI 
alarm description

Displays the Making External DI alarm description dialog. On this 
dialog, you can create a message or detailed alarm description 
to be displayed if an external DI alarm occurs.

Help Help Displays the ASET Instruction Manual. 

n Analysis Results

T10A.ai

File

 Open History Ctrl + O
 Open History (Analyzer)
 Close History Ctrl + W

Window

v Latest Analysis Results
 Concentration Analysis History
 Retention Time History
 Lab Analysis History
 Calibration Coefficient History
 File Analysis Results
 File Concentration Analysis History
 File Retention Time History
 File Lab Analysis Results
 File Calibration Coefficient History

Display Item

 Select Display Item
 Select SYS

Graph

 GraphA 
 GraphB 
 GraphC 

User Level

v User Level A
 User Level B
 User Level C
 User Level C+

Help 

 Help

 Save As Ctrl + S
 Setting the Number of History Data

 Auto Update

 Exit Alt + F4

File

 Open Ctrl + O
 Close Ctrl + W
 Save As
 Save Ctrl + S
 Exit Alt + F4

or

v GCM
 SYS1
 SYS2
 SYS3
 SYS4
 SYS5
 SYS6

9th Edition : Nov. 04, 2014-00



  <Appendix A  List of Menus> A-9

IM 11B06C01-01E

In case of GC1000 MarkII

T11A.ai

File

 Open History Ctrl + O
 Close History Ctrl + W

Window

v Latest Analysis Results
 Concentration Analysis History
 Retention Time History
 Lab Analysis History
 Calibration Coefficient History
 File Analysis Results
 File Concentration Analysis History
 File Retention Time History
 File Lab Analysis Results
 File Calibration Coefficient History

Display Item

 Select Display Item

Graph

 GraphA 
 GraphB 
 GraphC 

User Level

v User Level A
 User Level B
 User Level C
 User Level C+

Help 

 Help

 Save As Ctrl + S
 Auto Update

 Exit Alt + F4

File

 Open Ctrl + O
 Close Ctrl + W
 Save As
 Save Ctrl + S
 Exit Alt + F4

or

* Menu commands that are displayed vary depending on the current window type. The menu commands shown above are a 
summary of all the commands.

Menu Name Command Name Function
File Open Opens a saved file in a file reference window.

Close Closes a file currently opened in a file reference window.
Overwriting Save Saves a file currently opened in a file reference window under 

the same file name.
Save As Saves a file currently opened in a file reference window under a 

different file name.
Open History Loads history data from the analyzer server in a history window.
Close History Closes the history data display in a history window.
Save Saves analysis results acquisition window data to a file.
Auto Update
Exit Exits the Analysis Results window.

Window Latest Analysis Results Displays the Latest Analysis Results window.
Concentration Analysis 
History

Displays the Concentration Analysis History window.

Retention Time History Displays the Retention Time History window.
Lab Analysis History Displays the Laboratory Analysis History window.
Calibration Coefficient 
History

Displays the Calibration Coefficient History window.

File Analysis Results Displays the File Analysis Results window.
File Concentration 
Analysis History

Displays the File Concentration Analysis History window.

File Retention Time 
History

Displays the File Retention Time History window.

File Lab Analysis
Results

Displays the File Laboratory Analysis Results window.

File Calibration
Coefficient History

Displays the File Calibration Coefficient History window.

Graph Exit
Create A
Create B
Create C

Plots concentration analysis history, Retention time history, file 
concentration analysis history, or file Retention time history into 
a graph.

Help Contents Displays the contents of Help of the Analysis Result window.
Help Search Displays Help on the Analysis Result window on the basis of the 

keyword entered.
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n Graph

T13A.ai

Fail
Close

Graph
Make 

End Print 

Help
Help

Menu Name Command Name Function
Close Close Closes a graph window.
End End End a graph window.
Graph Make Plots concentration analysis history, Retention time history, file 

concentration analysis history, or file Retention time history into 
a graph.

Print Print Print the graph
Help Help Displays Help of the ASET.

n ASIU Operation Window

T15A.ai

System
Close

DO Set
DO01 (1)
DO02 (2)
DO03 (3)
DO04 (4)
DO05 (5)
DO06 (6)
DO07 (7)
DO08 (8)
DO09 (9)
DO10 (A)
DO11 (B)
DO12 (C)
DO13 (D)
DO14 (E)
DO15 (F)
DO16 (G)

Help
Help

Menu Name Command Name Function
System Close Close ASIU operation window.
DO Set DO01

     ¦
DO16

ON/OFF DO01 (to DO16).
Note: [DOxx] is displayed as [TAG#] when Tag# is set, as 

[TAG#/Signal] when Tag# and Signal are set.
Help Help Displays Help of the ASET.
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Appendix B List of Messages
This Appendix contains a list of error messages displayed during Engineering Terminal 
operations and the countermeasures to be taken.

n Ethernet LCD Emulator Window
Message Meaning Countermeasures

St
ar

t EtherLCD cannot execute 
more than 5 on a PC.

More than 5 EtherLCDs are 
operated on a PC at a same time.

4 is Maximum number of 
EtherLCD to be connected at a 
same time.

C
on

ne
ct

io
n

Other EtherLCD connects 
with the analyzer 
(xxx.xxx.xxx.xxx).

The appointed IP address of the 
analyzer is now connecting with 
(xxx.xxx.xxx.xxx) of the EtherLCD.

An analyzer cannot communicate 
with the multiple EtherLCD at a 
same time. Execute the command 
again after disconnecting the 
current connection.

The communication has 
failed, because the Analyer is 
local mode.

The communication cannot be 
started because the analyzer is 
under local mode.

Change from local mode to 
remote mode at the anlyzer, then 
command again.

Cannot open communication 
device.

The communication cannot be 
started due to a communication 
device problem.

Check the Ethernet card, setting 
of TCP/IP and Operation status of 
the analyzer.

Fo
rc

e 
co

nn
ec

t Password is incorrect.
Force connection is not 
possible.

The entered password is invalid at 
the force connection.

Enter the correct password.

O
n-

Li
ne

Communication with Analyzer 
xxx has been cut.

The communication has failed 
between the PC and the analyzer.

Check the network between the 
PC and the analyzer, then try to 
connect again.

Other PC starts the force 
connection. 
xxx.xxx.xxx.xxx.

The communication has failed 
due to the force connection by 
EtherLCD of IP address xxx.xxx.
xxx.xxx.

After ending the communication 
with IP address xxx.xxx.xxx.xxx, 
make the connection again.

An
al

yz
er

 s
el

ec
t 

di
al

og

This IP address is incorrect. Invalid IP address is entered. Enter the correct IP address.
This IP address overlaps with 
analyzer xxx.xxx.xxx. xxx.

The entered IP address is 
duplicated the analyzer xxx.xxx.
xxx.xxx.

Set the different IP address.

The analyzer ID is out of 
range.

Invalid Analyzer ID is entered. Set the valid analyzer ID. The 
range is 1 to 240.
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n Overview Window
Message Meaning Countermeasures

R
un

ni
ng

 
AS

ET

Engineering Terminal is 
already running.

An attempt was made to run the 
multiple ASET.

An ASET is run on a PC.

It is necessary to close 
Analysis results. Please close 
and restart Analysis Results.

An attempt was made to run a 
ASET during running Analysis 
Results Window.

Re-run ASET after closing 
Analysis Results Window.

[C
on

ne
ct

]

Other PC connect with the 
analyzer.

A PC can not run ASET because 
4 sets of PC has already 
communicated with a PCAS.

Execute the connection command 
from ASET after closing a ASET 
which communicate with PCAS.

Cannot open communication 
device.

The communication can not be 
started dues to the problem of a 
communication device.

Check the operation status of 
Ethernet card and TCP/IP setting.

[F
or

ce
d 

C
on

ne
ct

] Password is incorrect. Forced 
connection is not possible.

The password entered at Forced 
connection is invalid.

Enter the valid password.

O
n 

co
m

m
un

ic
at

io
n

The communication has 
disconnected between the 
Analyzer and PCAS.

The communication has 
disconnected between the 
Analyzer and PCAS.

Check the cable between PCAS 
and the Analyzers, and execute 
the conncetion command from 
ASET again.

Periodic communication has 
disconnected between the 
Analyzer and PCAS.

 PCAS failed to receive the 
periodic communication from a 
analyzer connected.

Check the cable between PCAS 
and the Analyzers, and execute 
the conncetion command from 
ASET again.

Other PC starts the forced 
communication. ASET (XXX.
XXX.XXX.XXX)

A PC which IP address 
XX.XXX.XXX.XXX has cut 
the communication by Forced 
connection.

Execute “connect” command after 
closing ASET connected to PCAS.

PCAS(XXX.XXX.XXX.XXX) 
requests to disconnect the 
communication.

The communication is 
disconnected by a forced 
connection from a PC which has 
IP address XXX.XXX.XXX.XXX.

Execute “connect” command 
from ASET after checking 
communication status of PCAS.

[O
pe

ra
tio

n 
M

od
e]

Password is invalid. Please 
try again.

Password entered is invalid. Enter the valid password.

[D
is

pl
ay

Se
tti

ng
] A maximum of 16 ID’s is 

allowed.¥nIf you add another 
ID, you must delete ID in 
advance.

An attempt is being made to 
register 17th analyzer on the 
overview window.

Max. analyzers entered is 16. It is 
needed to delete one analyzer if 
the other one is added.

se
rv

er
 s

el
ec

t d
ia

lo
g] This IP Address is incorrect. Invalid IP address is entered. Enter the valid IP address.

This IP address overlaps with
Server XXX.

The IP address entered is same 
as one of a Server XXX.

The IP address which has already 
registered can not be set. Specify 
the other IP address.

The server ID is out of range. The server ID which can not be 
used has been entered. The 
available server ID is from 241 to 
254.

Specify the server ID from 241 to 
254.

[T
ra

ns
fe

r 
Pa

ra
m

et
er

s]

File operation is available in 
only Process/Lab - Stop.

An attempt was made to upload/
download the setting parameter 
except Process/Lab -Stop mode.

The upload/download of the 
setting parameter is available on 
Process/Lab - Stop mode.

The selected file is not a 
parameter file.

An attempt is being made to 
download the file which is not for 
the setting parameter.

Select the correct parameter file.

[R
es

et
 

An
al

yz
er

] Analyzer reset is available in 
only Process/Lab - Stop.

An attempt is being made to 
command “Reset Analyzer” except 
Process/Lab - Stop mode.

“Reset Analyzer” command is 
available on only Process/Lab 
- Stop mode.
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n Analyzer Operation
Message Meaning Countermeasures

[O
pe

ra
tio

n 
M

od
e]

Operation command was not 
accepted by the analyzer.

An unauthorized level user is 
attempting to change the operation 
mode or operate a valve.

Only level C users can change the 
operation mode or operate valves.

Valves can only be operated 
in Manual mode.

An attempt is being made to 
operate a valve in a mode other 
than the Manual mode.

To operate a valve, choose the 
Manual mode. Note that only 
level C users can carry out this 
operation.

Detectors can be operated 
only in Manual mode.

An attempt is being made to 
operate a detector in a mode other 
than the Manual mode.

To operate a detector, choose 
the Manual mode. Note that only 
level C users can carry out this 
operation.

Operation pattern, valve, or 
detector cannot be operated 
because the user level is 
inappropriate.

An unauthorized level user is 
attempting to change the operation 
pattern or operate a valve.

Only level B or C users can 
change the operation pattern.
Valves can only be operated by 
level C users.

[S
et

 U
p]

The entered data is out of 
range.

An invalid value has been entered 
on Valve/Peak setting dialog box.

Enter the correct value.

The entered data is the same 
as the current data.

“Send” button has been clicked 
when the data is not changed on 
the Valve/Peak setting dialog box.

Click the “Send” button after 
changing the data.

Sending data to analyzer 
failed.

The data transmission has failed 
on the Valve/Peak setting dialog 
box.

Try again after checking the 
operation status of PCAS and 
Analyzers, and connection status 
of the cables.

Please change the LCD mode 
on the GC1000 to remote 
mode.

The Valve/Peak setting is not 
available when the analyzer is 
under “local mode”.

Try again after changing to 
“remote mode” at the analyzer.

A user has changed 
a parameter in the 
GC1000.¥nPlease restart 
Analyzer Operation Window 
by the [Display][Analyzer 
ID] command of Overview 
window.

Due to the parameter change by 
LCD panel at the analyzer, there 
is a descrenpacy of the setting 
parameter information on ASET.
The Valve/Peak setting from ASET 
is not available.

Re-load the initial database 
from the analyzer, then setting is 
available.

n Chromatogram
Message Meaning Countermeasures

[T
im

e/
Pr

es
su

re
 

D
is

pl
ay

]

Please check Temp. or Press. 
box.

Temperature/Pressure is not 
selected on the Temp/Pressure 
dialog box.

Select at least Temperature or 
Pressure.

Pe
n 

se
le

ct

Select two graphs. 2 graphs are not selected at 
Differential chromatogram display.

Select 2 graphs.

Illegal file type An attempt was made to open a 
file other than a chromatogram file.

Select the correct file.

Already opened The selected differential 
chromatogram has already been 
opened by another pen.

Select another differential 
chromatogram or erase the 
opened differential chromatogram.

n Alarm
Message Meaning Countermeasures

H
is

to
ry

 
er

as
in

g Alarm history cannot be reset 
by a level-A user.

An unauthorized level user is 
attempting to reset the alarm 
history.

Only level B or C users can reset 
the alarm history.
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n Analysis Results
Message Meaning Countermeasures

O
n 

st
ar

t-u
p Analysis Results has already 

been opened.
An attempt is being made to start 
multiple Analysis Result Display.

The multiple display is not 
available.

M
em

or
y Memory allocation error

Insufficient memory space
Memory space is insufficient. Check if adequate memory space 

required to carry out the operation 
has been secured.

[F
ile

]

Illegal file name
This file is not XXX file.

An attempt was made to open a 
file not having data corresponding 
to the current window.

Only open files relevant to the 
current window.

Reading error
Data is illegal.
An error occurred in reading 
the file.

The contents of the file attempting 
to be opened were incorrect; the 
file could not be opened.

Only open files with correct 
contents.

An error occurred while writing 
to a file.

Data was not saved to the 
file.

An error occurred while saving 
data. Data could not be saved.

Eliminate the cause of the error 
and try to save the file again.

Data has been modified. Do 
you want to save?

Window data has been modified. Click “Yes” if the data needs to be 
saved and then close the window.

File cannot be saved.
No data available.

The file can not be saved because 
the data is not indicated on the 
display.

Save the file after getting the data 
on the display.

[G
ra

ph
]

No peak is selected.
¥r¥nPlease select at least 
one peak.

No peak is selected. Select at least one peak.

Max. value should be larger 
than min. value.

The max. value at Y-axis of the 
graph is less than min. value.

Set the larger value than the min. 
value at Y-axis of the graph.

O
n 

co
m

m
un

ic
at

io
n Communication error while 

receiving data from Analyzer.
Failure of the data retrieve such 
as analyzer setting and analysis 
history.

Re-start the Analysis Result 
Window after checking the 
operation status of PCAS and 
Analyzers, and connection status 
of the cables.

D
at

a 
ed

iti
ng Wrong input value

Only numeric value can be 
entered here.

An attempt was made to enter 
data other than numeric values.

Re-enter numeric data.
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Message Meaning Countermeasures

G
ra

ph
 p

lo
tti

ng

Graph cannot be plotted. 
Because of no data

A graph cannot be plotted because 
the currently displayed window 
contains no data.

Perform graph plotting only when 
data is available in the window.

Graph cannot be plotted.
Illegal data

No graph was plotted because 
the graph range to plot contained 
inappropriate data.
This message also appears if 
there is no data in the graph range.

Check if data in the set graph 
range is appropriate.
Also check if there is data in the 
graph range.

Selection error
Data required is not 
selected.

Some of the data required to plot 
the graph have not been selected.

Check that the complete data 
required to plot the graph has 
been provided.

Selection error
The maximum number of 
peaks that can be selected 
at one time is 6.

More than 6 peaks have been 
selected.

The maximum number of peaks 
that can be displayed on a graph 
at one time is 6.
Select six or less peaks.

Selection error
Start time was set to a time 
later than the end time.

The start time was set to a time 
later than the end time when 
setting up the time axis (in Manual 
mode).

Set the start time to a time earlier 
than the end time.

Graph cannot be created / 
plotted.

For logarithmic graphs, 
axes can not be set at zero 
or negative values.

Zero or negative values were 
set as the minimum or maximum 
values when setting up logarithmic 
axes (in Manual mode).

Logarithmic axes cannot display 
zero or negative values. When 
setting the maximum and 
minimum values for the logarithmic 
axes, set values greater than zero.

n ASIU
Message Meaning Countermeasures

[D
O

 
O

pe
ra

tio
n] ASIU operation is not 

available in User level A.
An attempt is being made to 
operate ON/OFF of DOs by an 
inappropriate user level.

User level B or C can operate the 
ON/OFF of DOs.

n File extensions
In each file reference window, only files having the following extensions can be opened:

File analysis results: .ana (latest analysis results)
 .nar (latest analysis results)
File concentration analysis history: .cnc (concentration analysis history)
 .nar (latest analysis results)
 .dat (ASIU average value)
File Retention time history: .rtm (Retention time history)
 .nar (latest analysis results)
File laboratory analysis results: .lab (laboratory analysis results)
 .dat/old (laboratory analysis results)
File calibration coefficient history: .cef (calibration coefficient history)
 .dat/old (calibration coefficient history)
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